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How to Use This Manual

 

IMPORTANT This manual replaces your previous Model 373 User’s Manual. Transfer 
all User Bulletins, the Safety Summary, and personal notations to this 

 

manual before discarding the old manual.

 

ABI P

 

RISM

 

 373 DNA Sequencer with XL Upgrade Manual Sets

 

The ABI P

 

RISM

 

 373 DNA Sequencer with XL Upgrade manual set varies with the 
configuration of the instrument. The following table shows the manuals you 
should receive for the different configurations (this manual is listed in boldface 
type).

 

Table 1-1.  ABI P

 

RISM

 

 373 DNA Sequencer with XL Upgrade Reference Manuals

 

For Sequencing Analysis For GeneScan Analysis Manual Describes:

 

ABI P

 

RISM

 

 373 DNA 
Sequencer with XL 
Upgrade User’s Manual

ABI P

 

RISM

 

 373 DNA 
Sequencer with XL 
Upgrade User’s Manual

 

Preparing gels 
Running samples
Data collection software
Instrument hardware
Macintosh maintenance

ABI P

 

RISM

 

 DNA 
Sequencing Analysis 
Software User’s Manual

ABI P

 

RISM

 

 GeneScan

 

®

 

 
Analysis Software User’s 
Manual

Software that analyzes data 
collected from the instrument

DNA Sequencing 
Chemistry Guide

672 GeneScan User’s 
Manual

Chemistry protocols for 
sample preparation 
(Protocols that are supplied 
with Sequencing chemistry 
kits are not included)
Safety information
Troubleshooting information
User Bulletins
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Information Provided in This Manual

 

Overview

 

This manual describes how to prepare gels and run samples. It provides 
information about the data collection software and the instrument and computer 
hardware. The manual is equipped with an extensive index and tables of contents 
to help you find information quickly. Even if you do not normally read manuals, 
these features should help you use it as a reference.

To get started quickly, see 

 

How to Get Started Quickly

 

 on page 1-8 and refer as 
recommended to the appropriate 

 

ABI P

 

RISM

 

 DNA Sequencing Chemistry Guide

 

 and 
Sections 2 and 3 of this manual. Appendix B, 

 

Quick Reference

 

, contains copies of 
useful tables outlining the process of pouring gels and performing runs.

To learn about the instrument and the collection software, read Sections 5 
through 7. These sections describe the hardware and software in more depth.

The appendixes contain specialized information, such as the instrument 
warranty, a consumables parts list, and details regarding matrices and data files.

This manual is written with the assumption that you have previously used a 
Macintosh computer and know how to use the mouse and select items from 
menus. If you are new to the Macintosh computer, refer to the 

 

Macintosh System 7 
Reference 

 

manual for information about using it.

 

Model-Specific Notation

 

This manual applies to three configurations of Model 373 DNA Sequencers:

 

• Classic.

 

 This configuration includes 370s with Macintosh upgrade and the 
373A. Classic models have electrophoresis chambers which support 24-cm 
WTR distances.

 

• Leon. 

 

This configuration has an electrophoresis chamber which supports 
6-, 12-, and 24-cm WTR distances.

 

• Stretch. 

 

This configuration supports 6-, 12-, 24-, 34-, and 48-cm well-to-read 
(WTR) distances and is easily identified by its extended door. 

 

Note All three instrument configurations must have the five-filter wheel 

 

capability.
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Most of the information in this manual applies to all three configurations, 
however, some sections of the manual apply only to one or two of these 
configurations. These sections are preceded by the name of the configuration 
(Classic, Leon, or Stretch) to which they apply.

 

Special Text Usage

 

User Attention Words

 

The text of this manual includes four user attention words to draw your attention 
to safety issues or issues relative to proper operation of the instrument. Each 
represents a certain level of attention or action, as described here.

 

Note Calls attention to information.

 

IMPORTANT Indicates information that is necessary for proper instrument operation 

 

or for effective chemistry.

 

Caution Indicates that damage to the instrument could result if you do not 

 

comply with this information.

 

WARNING Indicates that physical injury to the user or other persons could 

 

result if these precautions are not implemented.
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Safety Information

 

Refer to your original Safety Summary for information about operating the ABI 
P

 

RISM

 

 373XL safely. The Safety Summary also contains Material Safety Data Sheets 
(MSDSs) for chemicals that are commonly used with the instrument. Always keep 
the Safety Summary available for reference.

Safety warnings appear throughout the manual at relevant locations. These 
warnings address chemical, high voltage, and laser safety and appear in the format 
shown below. Please heed the following general warnings:

 

WARNING ELECTRICAL SHOCK HAZARD. The ABI P

 

RISM

 

 373 DNA 
Sequencer with XL Upgrade contains a high voltage power supply. 
Although the instrument has been designed with safety features in 
the door to disconnect the power supply when the door is open, 
please follow procedures as prescribed. As with any 
electrophoresis apparatus, be careful during instrument operation 

 

and when handling electrodes and liquids.

 

WARNING LASER HAZARD. The ABI P

 

RISM

 

 373 DNA Sequencer with XL 
Upgrade contains a laser. Operating this instrument without due 
regard to the precautions, or in any manner that is not in 
compliance with procedures recommended here, may be unsafe 

 

and can cause physical harm from radiation exposure.

 

WARNING CHEMICAL HAZARD. The acrylamide and bis-acrylamide used to 
prepare sequencing gels for the ABI P

 

RISM

 

 373 DNA Sequencer 
with XL Upgrade are toxic chemicals whose use requires utmost 
attention to safety. Be sure to read the Material Safety Data Sheets 
(MSDSs)for emergency and first-aid procedures. MSDSs are in the 
ABI P

 

RISM

 

 373 DNA Sequencer with XL Upgrade Pre-Installation 
Manual, P/N 901173. Acrylamide is a neurotoxin that can be 
absorbed through the skin. Wear a laboratory coat, eye protection, 
and gloves. The handling and disposal of chemical waste is the 
responsibility of the user, and not the Applied Biosystems service 

 

representative.
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User Bulletins

 

User Bulletins are updates to this manual that provide a quick way to ensure that 
you have current information and new protocols. They contain technical 
information that is essential to ABI P

 

RISM

 

 373 DNA Sequencer with XL Upgrade 
operation and related laboratory techniques. 
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How to Get Started Quickly

 

Be sure your ABI P

 

RISM

 

 373 DNA Sequencer with XL Upgrade is completely 
installed before you begin preparing for a run. After it is installed:

• Refer to the 

 

ABI P

 

RISM

 

 DNA Sequencing Chemistry Guide

 

 or the 

 

672 GeneScan 
User’s Manual

 

 as you prepare your DNA template and choose a method for 
performing the sequencing or labeling reactions. 

• Use the instructions in Section 3 for step-by-step operation of the 
instrument in sequencing mode. Section 3 is extensively cross-referenced 
so you can easily refer to Section 5 for more detailed information on the 
ABI P

 

RISM

 

 373 DNA Sequencer with XL Upgrade collection software.

• Use the instructions in Section 4 for step-by-step operation of the 
instrument in GeneScan mode. Section 4 is extensively cross-referenced so 
you can easily refer to Section 5 for more detailed information on the 
ABI P

 

RISM

 

 373XL collection software.

 

Registering Your Software Programs

 

When you send in the registration cards for your software programs you become 
eligible to receive upgrade notices. Often you also become eligible for technical 
support and to purchase software upgrades at lower prices than it would cost to 
purchase the new upgraded programs. These privileges might vary, depending on 
the company that provides the software.

To register your software, fill out the registration card included in the program 
package and return it to the company, as indicated.
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Description of ABI P

 

RISM

 

 373 DNA Sequencer with 
XL Upgrade 

 

The ABI P

 

RISM

 

 373 DNA Sequencer with XL upgrade is a high-throughput, 
automated instrument system (see Figure 1-1) that is capable of determining base 
sequence, fragment size, or relative quantity of fluorescent dye-labeled nucleotide 
fragments. It consists of an electrophoresis instrument, a Power Macintosh 
Computer that includes software for data collection and data analysis, a 
Translation Interface Processor, and an optional printer. Accessories for standard 
runs such as combs and spacers are included.

 

Figure 1-1.  The ABI P

 

RISM

 

 373 DNA Sequencer with XL upgrade

 

Two software applications are available for analyzing the raw data produced by the 
instrument. With the Sequencing Analysis software you can analyze DNA 
sequence data. The GeneScan

 

®

 

 Analysis software allows you to size and quantitate 




MacintoshCentris 650

ABI PRISM 373A

Translation 
Interface 
processor

Power Macintosh
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DNA fragments. Either or both of these programs is shipped with the instrument, 
depending on your order. 

 

Note This manual describes only how to collect raw data on the instrument. 
For information about Sequencing Analysis or GeneScan Analysis 
applications, refer to the 

 

Sequencing Analysis Software User’s Manual 

 

or the 

 

GeneScan Analysis Software User’s Manual

 

, respectively. 

 

Sequencing and GeneScan Analysis on the ABI P

 

RISM

 

 373 DNA 
Sequencer with XL Upgrade

 

IMPORTANT Analysis of raw data from the ABI P

 

RISM

 

 373 DNA Sequencer with XL 
Upgrade requires version 3 or higher of Sequencing Analysis, or 
version 2.1 or higher of GeneScan Analysis. The correct version of the 
software should be included in your ABI P

 

RISM

 

 373 DNA Sequencer 
with XL Upgrade DNA Sequencer upgrade package.

The ABI PRISM 373 DNA Sequencer with XL Upgrade operates the same way for 
both Sequencing and GeneScan Analysis modes: it performs electrophoretic 
separation and spectral detection of dye-labeled DNA fragments. The difference 
between the two modes is in the preparatory chemistries and in the analysis 
performed on the resulting data.

Sequencing and GeneScan Analysis software programs each analyze the resulting 
data for your application. The analysis software programs are briefly described on 
page 1-16, and more completely described in the separate analysis software user’s 
manuals.

To prepare a DNA template, you can use standard laboratory methods. For 
example, you can use PCR or clone the DNA into a vector such as M13 or pUC, 
amplify the vector, then purify the template by standard methods. To prepare 
samples for running on the ABI PRISM 373 DNA Sequencer with XL Upgrade, you 
must incorporate fluorescent labels. The chemistries for incorporating 
fluorescent labels are different, depending on whether your application is 
Sequencing or GeneScan Analysis.
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The Sequencing Applications
For sequencing applications on the ABI PRISM 373 DNA Sequencer with XL 
Upgrade, the sequencing reaction involves the incorporation of fluorescent 
labels, instead of radioactive isotopes. Four different dyes identify the A, C, G, and 
T extension reactions. You can incorporate the dye labels using either 5'-dye 
labeled primers or 3'-dye labeled dideoxynucleotide terminators. 

You can use standard polymerases, such as AmpliTaq® and Sequenase T7 DNA 
polymerase, for primer extension. Both are available in kits with the dye 
terminator and the dye primer chemistries from Applied Biosystems. The labeling 
method you use depends on the sequencing strategy and on your personal 
preference. Refer to the ABI PRISM DNA Sequencing Chemistry Guide.

The GeneScan Applications
GeneScan analysis of Sample files includes establishing a baseline, adjusting for 
spectral overlap of the dyes, peak detection, and size calling. 

When you use the GeneScan system on the ABI PRISM 373 DNA Sequencer with 
XL Upgrade, you can label DNA fragments with up to three different fluorescent 
dye colors, and then use a fourth dye color to label an internal lane or size 
standard. When you use an internal size standard, the GeneScan software 
performs precise size calling without band-shift artifacts and run-to-run variation, 
problems often encountered using other techniques. GeneScan Analysis software 
can also be used for relative quantitation when a dye-labeled fragment of known 
quantity is included in the same lane as the DNA fragments.

You can display the results of an experiment as electropherograms, tabular data, 
or a combination of both. Electropherograms are a graphical display of peaks 
detected during collection. Each electropherogram represents a single lane for 
ABI PRISM 373 DNA Sequencer with XL Upgrade data. The tabular data provides 
detailed sizing and quantitative information. 

Fluorescent labels are incorporated in the form of 5'-end labeling using 
NHS-esters or phosphoramidites. A second labeling strategy incorporates internal 
dye labels in the form of fluorescent dNTPs
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How the ABI PRISM 373 DNA Sequencer with XL Upgrade 
Works

After your DNA fragments are labeled, the ABI PRISM 373 DNA Sequencer with 
XL Upgrade automatically separates and detects them, providing data for analysis 
by the Sequencing Analysis or GeneScan Analysis software program.

Electrophoresis and Detection
DNA templates labeled with four different fluorescent dyes are combined and 
loaded into one lane on a vertical acrylamide slab gel. You can analyze up to 66 
lanes simultaneously on one gel. 

The dye-labeled DNA fragments electrophorese through the acrylamide gel and 
separate according to size. At the lower portion of the gel they pass through a 
region where a laser beam continuously scans across the gel. The laser excites the 
fluorescent dyes attached to the fragments, and they emit light at a specific 
wavelength for each dye. The data collection software collects the light intensities 
using the 5-filter wheel and stores them as electrical signals for eventual 
processing.

Real-Time Status and Data Observation
The data collection program stores the digitized output signal into files on the 
Macintosh hard disk. The computer screen displays the information received 
from the ABI PRISM 373 DNA Sequencer with XL Upgrade in real time. 

Note Real-time viewing of the first peaks as they pass the laser detection site 
occurs within 90 minutes of loading the samples on the gel during a run 
using 24- or 34-cm separation distance.

You can view instrument status and data in several windows on the computer 
screen by simply choosing the window name from the Window menu.

• The Status window displays current instrument conditions and the set 
values for the electrophoresis power supply.

• The Electrophoresis History window displays the actual values for the 
electrophoresis power supply and gel temperature.
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• The Scan window displays the raw data; it shows the sweeps of the laser 
across the gel with a different colored line representing light emission 
through each filter.

• The Gel window displays a reconstruction of actual data as it would appear 
on an autoradiogram.

Data Analysis
At the end of collection, the computer can automatically analyze the collected 
data and print electropherograms on a color printer. Depending on your 
application, this is performed by either the Sequencing Analysis or the GeneScan 
Analysis software. Both programs are briefly described on page 1-10, and more 
completely described in the separate analysis software user’s manuals.

You can display the raw and analyzed data on the computer screen, or edit and 
print it at any time. 
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ABI PRISM 373 DNA Sequencer with XL Upgrade Throughput

You can use the ABI PRISM 373 DNA Sequencer with XL Upgrade in different ways 
for various combinations of accuracy, read length, and number of channels. 

Table 1-2 summarizes the throughput for typical analysis runs.

Table 1-2.  ABI PRISM 373 DNA Sequencer with XL Upgrade Throughput for 
Sequencing

Instrument
Model

WTR 
Length 
(cm)

Gel 
Concen-
tration

(%)

Gel
Thickness

(mm)

Scan Mode Power 
(W)

Collec-
tion Time 

(hr)

Length of 
Read 

(bases
resolved)

Classic 24 6.0 0.4 XL or Full scan 30 12–14 450

Classic 24 4.75 0.4 BaseSprinter 40 6.5 450

Leon 24 6.0 0.4 XL or Full Scan 30 12–14 450

Leon 24 4.75 0.4 BaseSprinter 40 6.5 450

Stretch 24 6.0 0.4 XL or Full Scan 261 12–14 450

Stretch 24 4.75 0.4 BaseSprinter 35 7 450

Stretch 34 4.75 0.4 XL or Full Scan 321 14–16 550

Stretch 34 4.25 0.4 BaseSprinter 45 8 550

Stretch 48 4.0 0.3 XL or Full Scan 401 17–18 700

1. If necessary, adjust the power to achieve spacing of 9.5 to 12 for analyzed data.
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Table 1-3.  ABI PRISM 373 DNA Sequencer with XL Upgrade Throughput for 
GeneScan

Application Resolution 
(bp)

Size Standard Gel Type 
(Acrylamide)

Gel 
Length
(cm)

Run 
Time 
(hr)

Microsatellite Genotyping 
(Linkage Mapping Set, 
dinucleotide tepeats)

1 GS-350 or 
GS-500

6.0% 
denaturing

24 6

Microsatellite Genotyping
(tri- and tetranucleotides)

1–2 GS-500 6.0% 
denaturing

12 4

VNTRs 1–2 GS-350 or 
GS-500

8.0% 
denaturing

12 4

Large Fragments
(0.5–2.5 kb)

3–4 GS-1000 or 
GS-2500

8.0% 
denaturing

6 2

AFLP™ Plant Mapping Kit 1 GS-500 6.0% 
denaturing

24 11

Stock Marks™ for Cattle 1 GS-350 6.0% 
denaturing

24 6

AmpFlSTR™ 
(tetranucleotides)

1 GS-500 6.5% 
denaturing

24 6
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Software for Data Analysis

Two standard software programs are available to analyze raw data from the 
ABI PRISM 373XL: Sequencing Analysis and GeneScan Analysis.

DNA Sequencing Analysis Software
The Sequencing Analysis software analyzes raw sequencing data collected by the 
data collection program on the ABI PRISM genetic analysis instruments.

The analysis software processes data using a multicomponent analysis, baseline 
subtraction and scaling. After processing, it detects the peaks and determines the 
sequence. The four-dye, one-lane sequencing approach eliminates 
electrophoresis variables and reduces lane-to-lane variations.

You can reanalyze and edit the sequence data in a format called a Sample file. The 
same Sample file can be used by other Applied Biosystems software programs for 
additional data processing. Also, Sample files are in formats that you can export 
to commercially available or user-generated programs on the Macintosh and on 
other compatible computers for further analysis.

The Sequencing Analysis program comes bundled with three other programs, 
GelDocII, DataUtility, and Factura. GelDocII removes tracking data from a Gel file 
and removes and restores the gel image from a Gel file. The DataUtility program 
performs two functions. It makes matrices for use with the ABI PRISM 373 DNA 
Sequencer with XL Upgrade Collection and Sequencing Analysis software, and 
monitors noise levels for troubleshooting by Applied Biosystems technical 
specialists. Factura performs additional processing on Sample files to clarify the 
target DNA sequence.
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GeneScan Analysis Software
The GeneScan® Analysis software enables you to use the automated fluorescence 
detection capabilities of the ABI PRISM genetic analysis instruments to determine 
accurate sizing and relative quantitation of DNA fragments. You can size PCR 
products (STRs, VNTRs, and RAPDs) and perform quantitative gene analysis 
(COP assays, mRNA) faster than with traditional methods, yet with sufficient 
resolution to accurately analyze molecular fragment lengths in the 50–500 
nucleotide size range. The software uses internal lane size standards to reduce 
gel-to-gel and lane-to-lane variation.

The software automates the entire process of separating, quantifying, and sizing 
DNA fragments. The data can be displayed as a gel image, an electropherogram, 
tabular data, or a combination of electropherograms and the corresponding 
tabular data.

Further Analysis of Processed Data

The Inherit Sequence Analysis System
Inherit is a multi-user system used to edit, assemble, and analyze DNA and protein 
sequence data. The Inherit programs are designed to run on the Macintosh 
platform either independently or interactively with a UNIX server. They provide 
a robust set of tools for sequence analysis and allow you to access and store data in 
a common file format.

Inherit has three Macintosh programs:

• Factura prepares sequence data for analysis and alignment. It identifies 
specified vector and ambiguity ranges, restriction sites, and a specified 
confidence range. It also identifies multiple base positions with codes 
described by the International Union of Biochemists (IUB codes), based 
on a user-defined threshold. The program processes sequences in batches, 
speeding the process considerably.

• AutoAssembler™ allows you to quickly and efficiently assemble small 
overlapping pieces of DNA into larger segments of DNA, using ABI PRISM 
373 DNA Sequencer with XL Upgrade data as well as other types of data. It 
provides powerful tools for editing the sequences, including the ability to 
display constantly-spaced electropherograms that are synchronized with 
the assembled sequences. You can build a consensus from the assembled 
sequences and export it for use with other programs.
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• GeneAssist allows you to analyze data from ABI PRISM 373 DNA Sequencer 
with XL Upgrade sequence files, files processed in AutoAssembler, text 
files, or a database. You can use this program to rapidly search biological 
databases for sequence similarity or patterns, and to interactively work with 
the resulting sequence lists. In addition to searching results, the program 
can create dot plots, alignments, and restriction maps of sequence data.

AutoAssembler Sequence Assembly Software
AutoAssembler is available as a separate program from the Inherit system. You can 
purchase it for use with a Macintosh only, and perform the same functions as 
described above, using a local algorithm. Upgrade to the more powerful assembly 
capabilities of the Inherit system by adding the client-server option (which runs 
on a UNIX server). This provides a multi-user environment and allows you to use 
an assembly algorithm that handles repeat sequences and large projects more 
efficiently than the local algorithm.

Sequence Navigator Sequence Comparison Software
Sequence Navigator™ software is specifically designed to address the needs of 
researchers performing comparative sequencing, as it accurately aligns sequences 
to a standard or a population and identifies sequence variants.

Sequence Navigator runs on the Macintosh and can be used for many 
applications, such as mutation identification/heterozygote screening of 
sequences such as p53 and HIV, and mitochondrial DNA. The program 
incorporates five powerful algorithms for pairwise or multiple alignment of DNA 
and protein sequences. It is bundled with the Factura program described above, 
allowing identification of heterozygous base positions and quick cleanup of 
sequences before alignment.

Genotyper Genetic Analysis Software
Genotyper™ is a data analysis and transformation tool that converts data from 
GeneScan into user application results. Genotyper converts data into the format 
required by downstream applications, such as linkage analysis programs, 
databases, or spreadsheets. The Genotyper software thereby helps create seamless 
automation between the ABI PRISM 373 DNA Sequencer with XL Upgrade and the 
final experimental results.

Primer Express Software
Primer Express™ is a primer design program with an easy-to-use interface. The 
software is applications oriented, taking into consideration the most updated 
criteria for primer design.
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EditView Software
EditView is a free, DNA Sequence viewer that allows you to view and print 
sequence data from an ABI PRISM 373 DNA Sequencer with XL Upgrade, an ABI 
PRISM 377 DNA Sequencer, or an ABI PRISM 310 Genetic Analyzer. Using EditView 
on your Macintosh computer, you can open an analyzed sample file and view the 
sequence data either as an electropherogram (traces), or in text format. You can 
then edit individual bases, export the data to a text file, or print. To receive a copy 
of EditView, visit our Web site at www.appliedbiosystems.com/techsupport.
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Differences between the ABI PRISM 373 DNA 
Sequencer with XL Upgrade and the Model 373

Instrument and Accessories

• More samples per instrument run. The Model 373 allows 36 samples to be 
analyzed simultaneously. With the ABI PRISM 373 DNA Sequencer with XL 
Upgrade, you can analyze up to 64 samples at one time. This increased rate 
of throughput is due to the redesign of the rate at which the laser detects 
data.

• Instrument Performance. While more samples can be analyzed 
simultaneously, parameters such as length of sequence detected, peak 
sizing and quantitation, and time allocated to run the instrument is not 
expected to change after the ABI PRISM 373 DNA Sequencer with XL 
Upgrade upgrade is installed.

• New spacers and combs. The XL combs (48- and 64-well sharks-tooth and 50- 
and 66-well square-tooth) are made of a material called Mylar. In addition 
to the combs, glass plate spacers, casting combs, and overlays are also 
available in Mylar. The other combs supplied by Applied Biosystems for use 
on the ABI PRISM 373 DNA Sequencer with XL Upgrade are made of a 
material called Valox.

IMPORTANT Always use combs, glass plate spacers, and casting combs as a 
matched set. Do not mix and match material types or thicknesses within 
a set. Mismatching can cause loose-fitting combs, and can result in 
sample leaking and/or damage to the gel.

• New glass plate spacer design. New glass plate spacers are made of Mylar to be 
compatible with the XL combs. The new spacers are available in only one 
length but are marked to indicate where to cut them in order to fit each 
size of glass plate. Offering spacers in a single length reduces the chances 
of making errors during order entry. It also allows us to offer them at a 
lower price than previous custom-cut spacers.

Notches are cut out of one end of the spacers. When you assemble the 
plates, be sure that the notches are at the top of the plates and facing 
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toward the well. These new spacers help reduce buffer leaks between the 
gel and spacer.

• Power Macintosh control of instrument. The instrument is operated entirely 
from the Power Macintosh computer. While the Model 373 instrument was 
controlled by a combination of the keypad on the front of the instrument 
and the computer, the keypad on the front of the instrument is now used 
only for instrument diagnostics.

• New user’s manual. The new manual is a smaller, more convenient size, and 
contains a glossary, a quick reference procedure, and an expanded index.

• Translation Interface Processor. This hardware acts as a translator and memory 
buffer between the ABI PRISM 373 DNA Sequencer with XL Upgrade and 
the Power Macintosh. This enables the instrument to be controlled by the 
Power Macintosh. In addition, the Translation Interface Processor 
increases the amount of memory buffer available with the Model 373.

Chemistry

• Load less sample. Smaller well size requires less sample. See Table 3-3 on 
page 3-40 for Sequencing sample volumes. See Table 4-2 on page 4-43 for 
GeneScan application load volumes.

Software

• Streamlined data collection software. Input of information and viewing of 
real-time data/instrument status is simplified. All data for a run can be 
viewed in the Gel window during data collection.

• Compatibility with Analysis software. Raw data generated by the ABI PRISM 373 
DNA Sequencer with XL Upgrade can be analyzed using only version 3 or 
higher of Sequencing Analysis software or version 2.1 or higher of 
GeneScan Analysis software.
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Technical Support

Contacting Technical Support

You can contact Applied Biosystems for technical support by telephone or fax, by 
e-mail, or through the Internet. You can order Applied Biosystems user 
documents, MSDSs, certificates of analysis, and other related documents 24 hours 
a day. In addition, you can download documents in PDF format from the Applied 
Biosystems Web site (please see the section “To Obtain Documents on Demand” 
following the telephone information below).

To Contact Technical Support by E-Mail

Contact technical support by e-mail for help in the following product areas:

Product Area E-mail address

Genetic Analysis (DNA Sequencing) galab@appliedbiosystems.com

Sequence Detection Systems and PCR pcrlab@appliedbiosystems.com

Protein Sequencing, 
Peptide and DNA Synthesis

corelab@appliedbiosystems.com

Biochromatography, PerSeptive DNA, 
PNA and Peptide Synthesis systems, 
CytoFluor®, FMAT™, Voyager™, and 
Mariner™ Mass Spectrometers

tsupport@appliedbiosystems.com

LC/MS
(Applied Biosystems/MDS Sciex)

apisupport@sciex.com
or
api3-support@sciex.com

Chemiluminescence (Tropix) tropix@appliedbiosystems.com
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Hours for Telephone Technical Support

In the United States and Canada, technical support is available at the following 
times:

To Contact Technical Support by Telephone or Fax

In North America
To contact Applied Biosystems Technical Support, use the telephone or fax 
numbers given below. (To open a service call for other support needs, or in case 
of an emergency, dial 1-800-831-6844 and press 1.)

Product Hours

Chemiluminescence 8:30 a.m. to 5:30 p.m. Eastern Time

Framingham support 8:00 a.m. to 6:00 p.m. Eastern Time

All Other Products 5:30 a.m. to 5:00 p.m. Pacific Time

Product or
Product Area

Telephone
Dial...

Fax
Dial...

ABI PRISM® 3700 DNA 
Analyzer

1-800-831-6844,
then press 8

1-650-638-5981

DNA Synthesis 1-800-831-6844,
then press 21

1-650-638-5981

Fluorescent DNA Sequencing 1-800-831-6844,
then press 22

1-650-638-5981

Fluorescent Fragment Analysis 
(includes GeneScan® 
applications)

1-800-831-6844,
then press 23

1-650-638-5981

Integrated Thermal Cyclers 
(ABI PRISM® 877 and Catalyst 
800 instruments)

1-800-831-6844,
then press 24

1-650-638-5981

ABI PRISM® 3100 Genetic 
Analyzer

1-800-831-6844,
then press 26

1-650-638-5981

BioInformatics (includes 
BioLIMS, BioMerge™, and 
SQL GT™ applications)

1-800-831-6844,
then press 25

1-505-982-7690
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Peptide Synthesis (433 and 
43X Systems)

1-800-831-6844,
then press 31

1-650-638-5981

Protein Sequencing (Procise 
Protein Sequencing Systems)

1-800-831-6844,
then press 32

1-650-638-5981

PCR and Sequence Detection 1-800-762-4001,
then press 1 for PCR,
2 for the 7700 or 5700,
6 for the 6700
or dial 1-800-831-6844, 
then press 5

1-240-453-4613

Voyager MALDI-TOF 
Biospectrometry and Mariner 
ESI-TOF Mass Spectrometry 
Workstations

1-800-899-5858,
then press 13

1-508-383-7855

Biochromatography (BioCAD 
Workstations and Poros 
Perfusion Chromatography 
Products)

1-800-899-5858,
then press 14

1-508-383-7855

Expedite Nucleic acid 
Synthesis Systems

1-800-899-5858,
then press 15

1-508-383-7855

Peptide Synthesis (Pioneer 
and 9050 Plus Peptide 
Synthesizers)

1-800-899-5858,
then press 15

1-508-383-7855

PNA Custom and Synthesis 1-800-899-5858,
then press 15

1-508-383-7855

FMAT 8100 HTS System and 
Cytofluor 4000 Fluorescence 
Plate Reader

1-800-899-5858,
then press 16

1-508-383-7855

Chemiluminescence (Tropix) 1-800-542-2369 (U.S. 
only),
or 1-781-271-0045

1-781-275-8581

Applied Biosystems/MDS Sciex 1-800-952-4716 1-650-638-6223

Product or
Product Area

Telephone
Dial...

Fax
Dial...
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Outside North America

Region
Telephone
Dial...

Fax
Dial...

Africa and the Middle East

Africa (English Speaking) and 
West Asia (Fairlands, South 
Africa)

27 11 478 0411 27 11 478 0349

South Africa (Johannesburg) 27 11 478 0411 27 11 478 0349

Middle Eastern Countries and 
North Africa (Monza, Italia)

39 (0)39 8389 481 39 (0)39 8389 493

Eastern Asia, China, Oceania

Australia (Scoresby, Victoria) 61 3 9730 8600 61 3 9730 8799

China (Beijing) 86 10 64106608 86 10 64106617

Hong Kong 852 2756 6928 852 2756 6968

Korea (Seoul) 82 2 593 6470/6471 82 2 593 6472

Malaysia (Petaling Jaya) 60 3 758 8268 60 3 754 9043

Singapore 65 896 2168 65 896 2147

Taiwan (Taipei Hsien) 886 2 2358 2838 886 2 2358 2839

Thailand (Bangkok) 66 2 719 6405 66 2 319 9788

Europe

Austria (Wien) 43 (0)1 867 35 75 0 43 (0)1 867 35 75 11

Belgium 32 (0)2 712 5555 32 (0)2 712 5516

Czech Republic and Slovakia 
(Praha)

420 2 61 222 164 420 2 61 222 168

Denmark (Naerum) 45 45 58 60 00 45 45 58 60 01

Finland (Espoo) 358 (0)9 251 24 250 358 (0)9 251 24 243

France (Paris) 33 (0)1 69 59 85 85 33 (0)1 69 59 85 00

Germany (Weiterstadt) 49 (0) 6150 101 0 49 (0) 6150 101 101

Hungary (Budapest) 36 (0)1 270 8398 36 (0)1 270 8288

Italy (Milano) 39 (0)39 83891 39 (0)39 838 9492

Norway (Oslo) 47 23 12 06 05 47 23 12 05 75

Poland, Lithuania, Latvia, and 
Estonia (Warszawa)

48 (22) 866 40 10 48 (22) 866 40 20
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Portugal (Lisboa) 351 (0)22 605 33 14 351 (0)22 605 33 15

Russia (Moskva) 7 095 935 8888 7 095 564 8787

South East Europe (Zagreb, 
Croatia)

385 1 34 91 927 385 1 34 91 840

Spain (Tres Cantos) 34 (0)91 806 1210 34 (0)91 806 1206

Sweden (Stockholm) 46 (0)8 619 4400 46 (0)8 619 4401

Switzerland (Rotkreuz) 41 (0)41 799 7777 41 (0)41 790 0676

The Netherlands (Nieuwerkerk 
a/d IJssel)

31 (0)180 331400 31 (0)180 331409

United Kingdom (Warrington, 
Cheshire)

44 (0)1925 825650 44 (0)1925 282502

All other countries not listed 
(Warrington, UK)

44 (0)1925 282481 44 (0)1925 282509

Japan

Japan (Hacchobori, Chuo-Ku, 
Tokyo)

81 3 5566 6230 81 3 5566 6507

Latin America

Del.A. Obregon, Mexico 305-670-4350 305-670-4349

Region
Telephone
Dial...

Fax
Dial...
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To Reach Technical Support Through the Internet

We strongly encourage you to visit our Web site for answers to frequently asked 
questions and for more information about our products. You can also order 
technical documents or an index of available documents and have them faxed or 
e-mailed to you through our site. The Applied Biosystems Web site address is

http://www.appliedbiosystems.com/techsupp

To submit technical questions from North America or Europe:

Step Action

1 Access the Applied Biosystems Technical Support Web site.

2 Under the Troubleshooting heading, click Support Request Forms, then 
select the relevant support region for the product area of interest.

3 Enter the requested information and your question in the displayed form, 
then click Ask Us RIGHT NOW (blue button with yellow text).

4 Enter the required information in the next form (if you have not already done 
so), then click Ask Us RIGHT NOW.

You will receive an e-mail reply to your question from one of our technical 
experts within 24 to 48 hours.
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To Obtain Documents on Demand

Free, 24-hour access to Applied Biosystems technical documents, including 
MSDSs, is available by fax or e-mail or by download from our Web site.

To order 
documents... Then...

by index number a. Access the Applied Biosystems Technical Support Web site at 
http://www.appliedbiosystems.com/techsupp

b. Click the Index link for the document type you want, then find 
the document you want and record the index number.

c. Use the index number when requesting documents following 
the procedures below.

by phone for fax 
delivery

a. From the U.S. or Canada, call 1-800-487-6809, or
from outside the U.S. and Canada, call 1-858-712-0317.

b. Follow the voice instructions to order the documents you want.

Note There is a limit of five documents per request.

through the 
Internet for fax 
or e-mail 
delivery

a. Access the Applied Biosystems Technical Support Web site at 
http://www.appliedbiosystems.com/techsupp

b. Under Resource Libraries, click the type of document you want.

c. Enter or select the requested information in the displayed form, 
then click Search.

d. In the displayed search results, select a check box for the 
method of delivery for each document that matches your 
criteria, then click Deliver Selected Documents Now (or click the 
PDF icon for the document to download it immediately).

e. Fill in the information form (if you have not previously done so), 
then click Deliver Selected Documents Now to submit your 
order.

Note There is a limit of five documents per request for fax 
delivery but no limit on the number of documents you can order 
for e-mail delivery.
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Polyacrylamide Gels

For sequencing, the polyacrylamide gel is one of the most important variables that 
determines the number of bases you can read. For fragment analysis, the 
polyacrylamide gel is critical for the resolving capabilities. In short, your data is 
only as good as the quality of your gel.

The quality of your gel is even more important with the ABI PRISM 373XL than it 
is with manual sequencing, since much more DNA (over 600 bands) passes 
through a gel in a single loading on the ABI PRISM 373XL. Therefore, it is of 
paramount importance to produce a first-rate gel. Some of the factors that affect 
gel quality are described below.   

Mechanism of Polymerization

Polyacrylamide gels are formed by the copolymerization of acrylamide and 
bis-acrylamide. The process begins when TEMED (tetramethylethylenediamine) 
reacts with APS (ammonium persulfate) to yield a TEMED radical cation, a sulfate 
radical and a sulfate ion. The sulfate radical adds an unpaired electron to the 
acrylamide monomer, converting it to a free radical which then reacts with more 
monomer, causing polymer chain elongation. The polymer chains are randomly 
cross-linked with bis-acrylamide to form the gel matrix.

Effect of Reagent Purity on Gel Quality

It is extremely important that you use pure gel reagents from a reliable source. 
Optimal results depend on gel quality and therefore, on gel reagent quality.

Acrylamide
Impurities in this reagent (or in bis-acrylamide) can cause:

• Irreproducible gel porosity

• Deviant mobility

• Inhibition of polymerization

• Poor resolution

all of which lead to poor results, wasted time, and frustration.
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These problems lead to compromised reproducibility. Some possible 
contaminants that can cause them include the following:

• Acrylic acid - The hydrolysis product of acrylamide. It copolymerizes with 
acrylamide and bis-acrylamide. Its presence causes the DNA to migrate 
slowly, resulting in broad, diffuse bands and consequently, poor resolution. 

• Linear polyacrylamide - Caused by catalytic contaminants in the dry 
acrylamide monomer. It decreases the effective concentration of the 
acrylamide, causing the DNA to migrate faster.

• Ionic contaminants - Mostly metals, such as iron or copper. These can 
inhibit or accelerate polymerization. 

Good quality solid form/dry acrylamide can be stored at room temperature for up 
to one year. You can store a 40% stock solution of acrylamide and bis-acrylamide 
(19:1) at 4 °C for up to one month.

WARNING CHEMICAL HAZARD. Acrylamide and bis-acrylamide are 
neurotoxins. Avoid inhalation and skin contact. Wear gloves at all 
times and work in a fume hood when handling acrylamide 
solutions, and use appropriate precautions to avoid inhalation of 
crystalline acrylamide. Read the MSDS in the Safety Summary 
provided with your original user’s manual.

Bis-acrylamide
Impure bis-acrylamide contains some of the same contaminants as acrylamide. 
Store it dry at room temperature for up to one year. You can store a 40% stock 
solution of acrylamide and bis-acrylamide (19:1) at 4 °C for up to one month.

Note You can either make 40% acrylamide stock solution from solid 
acrylamide and bis-acrylamide, or buy high-quality premixed, 
preweighed powders and dilute them to a 40% solution. Use distilled or 
deionized water only, and store at 4 °C for up to one month. Using the 
pre-made powders saves time and minimizes exposure to the solid 
form of the neurotoxins acrylamide and bis-acrylamide. 
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Ammonium Persulfate (APS)
APS (ammonium persulfate) begins to decompose at once when dissolved in 
water. The result is loss of activity. For reproducible results, therefore, you should 
prepare APS solutions fresh daily. It is vital that this chemical be fresh since it 
affects the rate of polymerization and thus the gel properties. Store solid APS 
tightly sealed, since it is hygroscopic. If tightly sealed, it can be stored at 4 ˚C for 
up to 1 year. 

Note Store solid APS in an airtight container with desiccant, to keep it dry. To 
avoid water condensation problems, let the bottle of APS warm to room 
temperature before opening it.

TEMED
TEMED (N, N, N', N'-tetramethylethylenediamine) is by nature very reactive and 
prone to oxidation. The oxidized form is yellow and less active. Using oxidized 
TEMED slows gel polymerization time, thereby significantly altering the gel 
characteristics. Because it is hygroscopic, this initiator gradually accumulates 
water, which increases the rate of oxidation. Water-free TEMED (>99% pure), 
stored in a tightly sealed container at room temperature, should be good for up 
to six months.

WARNING CHEMICAL AND FIRE HAZARD. TEMED is extremely flammable 
and can be very destructive to the skin, eyes, nose, and 
respiratory system. Keep it in a tightly closed container. Avoid 
inhalation and contact with skin, eyes and clothing. Always work 
under a hood and wear chemical resistant gloves when handling 
TEMED solutions. Read the MSDS in the Safety Summary 
provided with your original user’s manual.
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Urea
Use urea in the crystalline form, and weigh it fresh each time you use it. Old urea 
has breakdown products that affect sample migration.

WARNING CHEMICAL HAZARD. Urea is a potential mutagen. Avoid 
inhalation and contact with skin, eyes and clothing. Read the 
MSDS in the Safety Summary provided with your original user’s 
manual.

Note Do not make up a stock solution containing the urea. Prepare the 
components fresh.

Buffers and Gel Additives
Metals, non-buffer ions, and decomposition products are contaminants 
commonly found in reagents such as Tris, borate and urea. Transition metal ions 
tend to affect the polymerization in various ways, causing run-to-run 
irreproducibility. Non-buffer ions tend to inhibit DNA mobility and also cause 
run-to-run irreproducibility. To help avoid these problems, work only with high 
quality Tris, borate and urea, and use only distilled or deionized water for diluting 
reagents.

Other Factors that Affect Gel Quality

Rate of Polymerization
The properties of the gel depend on the rate of polymerization. The rate of 
polymerization is affected by temperature, initiator concentration, and oxygen. 
Each parameter is discussed in detail in this section for academic reasons only. 
The protocol in this section has already been optimized with regard to 
temperature, initiator concentration and oxygen content, therefore, you do not 
need to experiment with these variables.

Temperature: Controlling the temperature is crucial for achieving reproducible 
gels because it directly affects the polymerization time and thus affects the gel 
properties. A gel formed in a cold environment (at 4 °C) is turbid, porous, and 
inelastic, and the run-to-run reproducibility is greatly compromised. 
Polymerization in a 20–23 °C room (“normal” room temperature) is optimal. It is 
important that the gel solution and glass plates as well as the room temperature 
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be at 20-23 °C. Gels formed at this temperature are transparent, less porous, more 
elastic, and more reproducible. If the temperature is too high, the polymer chains 
are shorter and the resulting gel is inelastic, again resulting in non-reproducibility 
from run to run. 

Initiator Concentration: Increasing the concentration of TEMED or APS 
decreases the average polymer chain length, and increases gel turbidity. 
Decreasing the concentration of TEMED or APS increases the average polymer 
chain length, and decreases gel turbidity.

Decreasing the concentration of initiators has a desirable effect, except that this 
also causes slower polymerization. When polymerization is too slow, oxygen can 
enter the monomer solution during the process and inhibit polymerization. 

If you use degraded TEMED or APS, the concentration of initiators is less than 
that recommended in the protocol.

Oxygen: Oxygen acts as a free radical trap, thereby inhibiting polymerization. The 
result is a porous gel. To prevent the problems caused by oxygen, be careful to 
meet the following conditions.

• Polymerization must be fast enough to prevent too much oxygen from 
dissolving into the gel solution during polymerization. As long as you use 
fresh, high-quality reagents and follow the protocol in this manual, oxygen 
should not cause a problem during polymerization. 

• Minimize the amount of oxygen dissolved in the gel solution prior to 
casting the gel, since it can interfere with the rate of polymerization. Partial 
degassing is accomplished during the vacuum filtration step of this 
protocol. It is important to keep the vacuum strength and time constant 
during this step for run-to-run reproducibility. Since cold solutions have a 
greater capacity for dissolved oxygen, perform vacuum filtering (and gel 
casting) with the solution at room temperature. Also, be gentle during the 
stirring and pouring steps of gel casting so that oxygen is not introduced.    

Air bubbles
Air bubbles can distort the sample path, which affects lane tracking. Pour gels 
carefully and gently so bubbles do not form. If bubbles are trapped between the 
comb and the gel solution, carefully remove and reinsert the comb until no 
bubbles are trapped.
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Using an Old Gel
For consistent results, use gels between two and six hours after casting. Be sure to wait at 
least two hours after casting the gel to ensure complete polymerization, but do not 
wait longer than six hours. After six hours resolution begins to noticeably 
deteriorate. Gels that stand overnight can show significantly slower DNA 
migration, due to the slow hydrolysis of urea to ammonium carbonate. 

Since the amide groups of the polymer slowly hydrolyze into acid groups, gels that 
stand 48 hours can also show significant loss in resolution beyond 350 bases.

WARNING CHEMICAL HAZARD. The acrylamide and bis-acrylamide used to 
prepare sequencing gels for the ABI PRISM 373 DNA Sequencer 
with XL Upgrade are toxic chemicals whose use requires utmost 
attention to safety. Be sure to read the Material Safety Data Sheets 
(MSDSs)for emergency and first-aid procedures. MSDSs are in the 
ABI Prism 373 DNA Sequencer with XL Upgrade Pre-Installation 
Manual, P/N 901173. Acrylamide is a neurotoxin that can be 
absorbed through the skin. Wear a laboratory coat, eye protection, 
and gloves. The handling and disposal of chemical waste is the 
responsibility of the user, and not the Applied Biosystems service 
representative.



Applied Biosystems

March 2001 2  Preparing Gels 2-9

Preparing Acrylamide Denaturing Gels

This protocol for the preparation of acrylamide gels follows generally accepted 
procedures; however, there are some important distinctions to remember 
throughout the process. The ABI PRISM 373XL DNA Sequencer is a real-time 
electrophoresis detector. A laser scans across a region of the gel during the 
electrophoretic process, detecting the fluorescently labeled DNA passing through 
that region. The glass and the gel must be non-fluorescent. Be especially careful 
to:

• Eliminate any particulate or fluorescent matter from the acrylamide gel 
solutions. 

• Keep the glass plates extremely clean and free of dust. 

• Always use ultra-pure reagents and high-grade, distilled, deionized water to 
prepare solutions

• Wear clean laboratory gloves. 

• Filter all solutions to remove any particulate matter that may fluoresce or 
scatter light.

To maximize gel resolution, high quality acrylamide gels are essential, particularly 
when you are sequencing templates of greater than 350 bases in length. If you 
prepare acrylamide solutions with low-quality starting materials or heat them 
excessively, breakdown products might detract from the quality of the run. Using 
a deionizing resin and preparing carefully helps to avoid problems caused by such 
breakdown activity.

WARNING CHEMICAL HAZARD. Acrylamide and bis-acrylamide are 
neurotoxins. Avoid inhalation and skin contact. Wear gloves at all 
times and work in a fume hood when handling acrylamide 
solutions, and use appropriate precautions to avoid inhalation of 
crystalline acrylamide.
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Reagents and Supplies for Stock Solutions

You can either make 40% acrylamide stock solution from solid acrylamide and 
bis-acrylamide, or buy high-quality premixed, preweighed powders and dilute 
them to a 40% solution. To dilute them use distilled or deionized water only. 
Using the pre-made powders saves time and minimizes exposure to the solid form 
of the neurotoxins acrylamide and bis-acrylamide. You can also purchase 
ready-made stock solutions of the 10X TBE buffer. The concentration must be 
0.89 M Tris-base, 0.89 M Borate, 0.02 M EDTA, pH 8.3 ± 0.2.

If you prefer to prepare your own stock solutions, the recipes follow. Be careful to 
use ultra-pure reagents and high-grade, distilled, deionized water to prepare the 
solutions.

10X TBE Stock Solution
Per liter:

• Tris base 108.0 g

• Boric Acid  55.0 g

• Na2EDTA • 2H2O 8.3 g

Working solution (1X) is 89 mM Tris-base, 89 mM Boric acid, 2 mM EDTA; 
pH≈ 8.3 at ambient temperatures. 

IMPORTANT Discard the working solution if the pH is not 8.3 (± 0.2), and make a 
fresh solution. Do not attempt to adjust the pH.

To prepare the 1X TBE working solution (Classic and Leon):

1. Add 150 mL 10X TBE stock solution to a large graduated cylinder.

2. Dilute with dH2O to a total volume of 1500 mL.

To prepare the 1X TBE working solution (Stretch):

1. Add 200 mL 10X TBE stock solution to a large graduated cylinder.

2. Dilute with dH2O to a total volume of 2000 mL.
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40% (19:1) Acrylamide Stock Solution
Per 100 mL:

• Acrylamide 38.0 g

• Bis-Acrylamide  2.0 g

To prepare the acrylamide solution:

1. Dissolve the crystalline acrylamide and bis-acrylamide in enough dH2O to 
bring the total volume up to 90 mL.

2. Add 10 g of mixed-bed, ion-exchange resin. 

3. Stir at room temperature until all crystals dissolve, then continue to stir for 
an additional 5-10 minutes. 

4. Filter through a 0.2-µm cellulose nitrate cup filter assembly. 

5. Transfer to a 100-mL graduated cylinder and adjust volume to 100 mL with 
dH2O. 

The finished solution will be 19:1, acrylamide:bis-acrylamide. Solutions are stable 
for approximately 1 month when refrigerated at 4 °C.

Reagents and Supplies for Gels

WARNING CHEMICAL HAZARDS. Urea is a potential mutagen. TEMED is 
extremely flammable and can be very destructive to the skin, eyes, 
nose, and respiratory system. Do not store, handle, or work with 
any chemicals or hazardous materials unless you have received 
appropriate safety training and have read and understood all 
related Material Safety Data Sheets. Comply with all federal, state, 
and local laws related to chemical storage, handling, and disposal.

Ensure that you have each item on the following list ready before beginning to 
mix a sequencing gel.

• Urea

• TEMED



Applied Biosystems

2-12 2  Preparing Gels March 2001

• 10% Ammonium persulfate (w/v) in dH2O

Prepare fresh stocks daily, and store refrigerated.

• Volumetric pipets and tips

• 0.2-µm cellulose nitrate cup filters

• Plates, spacers, and combs

Optically clear glass plates, spacers, and combs are available from Applied 
Biosystems. 

• Alconox detergent

• Mixed bed, ion-exchange resin

• Level gauge and a level working surface
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Preparing the Plates (all sizes except 48 cm)

To prepare 48-cm plates, see page 2-22.

Cleaning the Plates

Rinse both sides of the glass plates with warm water, then wash with a detergent 
such as Alconox that will not leave a residue. Be careful not to scratch or abrade 
the glass surfaces. 

Caution Avoid contacting the glass plates with metal. Scratches caused by 
metal objects, such as drying racks or spatulas weaken the glass 
and reduce its usable life.

Rinse the plates well with warm water followed by distilled, deionized water. Stand 
the plates up and allow them to air dry.

Note If you are in a hurry, dry the plates gently with lint free towels rather than 
with an organic solvent which might contain fluorescent residues. 
Fluorescent residues tend to cause a green haze on your gel image.

Figure 2-1.  Glass plates for casting gel

Spacers

Notched 
plate

Plain plate
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Note Do not touch the cleaned surfaces of the glass plates and wear gloves 
to handle the plates. 

Each time you use the glass plates, use them with the same side of each plate on 
the inside. After the first use, the front plate has a hydrophobic area where the 
buffer chamber gasket made contact with the plate. You must use the front plate 
in the same configuration each time to avoid difficulty pouring the gel. You may 
mark the outside of each plate the first time you use it. Mark the plates with a tiny 
scratch at the top that doesn’t interfere with the read region or the upper buffer 
chamber seal.

To clean plates that have been previously used:

This cleaning is usually done immediately after the previous run is complete. 
Refer to page 3-47 for instructions.

Applying the Bind-Silane Compound

Note Bind-Silane use is optional with any of the sharks-tooth combs. 
However, it must be used with all square-tooth combs with more than 
36 wells.

Silating the unnotched glass plate in the well area (upper 3.5 cm) with a solution 
like Pharmacia’s Bind-Silane compound helps eliminate deformed wells. Follow 
the instructions below for performing the silation. This must be repeated every 
time a new gel is poured. Remove the old gel from the silated area with 0.1 N HCl 
or NaOH, or scrape off gently.

To apply the Bind-Silane compound:

1. Wash the unnotched glass plate with Alconox detergent, rinse well with 
distilled water, and leave to dry.

2. Adjust 200 mL H2O to pH 3.5 with acetic acid. Add 800 µL Bind-Silane and 
stir until clear, approximately 15 minutes.

3. Set the unnotched plate in a tub with the Bind-Silane solution covering the 
top 3.5 cm of the glass. Leave immersed at room temperature for 
10–60 minutes.
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IMPORTANT Do not get Bind-Silane on the laser-scanning region of the gel; it will 
fluoresce.

4. Rinse the glass plate with warm water, and then with dH2O, and let dry.

Assembling the Plates

To use your time efficiently, you might want to mix the acrylamide-urea gel 
solution and, while it is being stirred, clean and prepare the plates. To mix the 
acrylamide-urea solution, refer to page 2-18.

To assemble the plates:

1. Clean the plates, as described on page 2-13. 

2. Clean the 0.4-mm gel spacers in a similar manner, and make sure they are 
the proper length for the glass plates.

If the spacers are longer than the full length of the glass plates, clip them 
to the proper size. A paper cutter works well for trimming spacers. The 
XL spacers are marked with lines to make cutting easier.

IMPORTANT Because of tolerance issues, verify the combs, spacers, and casting 
comb you are using are compatible (made of the same material) and 
are the same thickness.

3. Place the plain plate on a protected bench top.

4. Place the gel spacers on the plain plate with the notches at the top of the 
plate and facing in.

You may use a pipet to apply small water droplets to the edge of the plate 
at several spots along the length so the water flows between the spacers and 
the glass to keep the spacers in position. 



Applied Biosystems

2-16 2  Preparing Gels March 2001

Figure 2-2.  Securing spacers on glass plates (top view)

5. Align the notched plate (inside down) on top of the spacers. The edges of 
the glass plates should be flush.

Again, be sure the inside of the plate is free of any particles that might 
fluoresce.

6. Temporarily clamp one side of the plates.

Figure 2-3.  Plates aligned 

7. Apply 1.5-inch wide tape tightly along the edge opposite the clamp. Wrap 
tape around both the top and bottom corners.

8. Remove the clamp and apply tape along the second long edge. Wrap tape 
around both the top and bottom corners.

9. Apply tape along the bottom edge of the plates, wrapping around both 
corners.

Place water droplets here 
to hold spacers in position

Spacers

Plain plate

Spacers 
notched 
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Notched 
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10. Eliminate any air pockets under the tape and reinforce points of assembly 
that are likely to leak acrylamide solution.

Note Using a commercially available gel pouring device can simplify gel 
casting by eliminating the need to tape the glass plates.
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Preparing the Gel (all sizes except 48 cm)

Preparing Acrylamide-Urea Gel Solutions

The ABI PRISM 373XL DNA Sequencer gels are very thin. Use only high purity 
reagents to prepare them. You can scale the recipe for double or half the amount 
as necessary. The recipes can be used for both Sequencing and GeneScan gels.

WARNING CHEMICAL HAZARD. Urea causes eye, skin, and respiratory 
irritation. Lab experiments have shown mutagenic effects. Avoid 
contact. Wear chemical resistant gloves, safety goggles, and 
other protective clothing.

WARNING CHEMICAL HAZARD. Acrylamide and bis-acrylamide are 
neurotoxins. Avoid inhalation and skin contact. Wear gloves at all 
times and work in a fume hood when handling acrylamide 
solutions, and use appropriate precautions to avoid inhalation of 
crystalline acrylamide.

Preparing 4.25%, 4.75%, or 6% Acrylamide-urea Gel Solutions

Use the following three recipes for all gels except 48 cm gels (for 48-cm gels see 
Preparing the Plates (48 cm only) on page 2-22). The volume of 40% acrylamide stock 
solution varies between the different gel recipes, and the resulting water needed 
to adjust to the total volume differ; everything else remains the same. 

1. Combine the following components in a 150-mL beaker to prepare a final 
volume of 80 mL of one of the three gel solutions:

• 40 g urea

• 27 mL dH2O 

• 1 g (less for smaller volumes) mixed-bed, ion-exchange resin
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2. Customize the gel solution by adding the appropriate amount of 40% 
acrylamide stock, as follows:

• For a 4.25% acrylamide, 8.3 M urea, 1X TBE (34 cm BaseSprinter) add 
8.5 mL 40% acrylamide stock solution.

• For a 4.75% acrylamide, 8.3 M urea, 1X TBE (24 cm BaseSprinter or 
34 cm Full or XL Scan) add 9.5 mL 40% acrylamide stock solution.

• For a 6% acrylamide, 8.3 M urea, 1X TBE (12 cm and 24 cm Full or 
XL Scan) add 12 mL 40% acrylamide stock solution.

3. Stir the solution while gently warming it until the urea crystals begin to 
dissolve and the flask is slightly warm to the touch. Continue to stir the 
solution with no additional heating for 5-10 minutes longer, or until all the 
urea crystals have dissolved.

While the solution is being stirred, you can prepare the plates, if you have 
not already done so.

4. Filter the acrylamide solution through a 0.2 µm cellulose nitrate filter, 
de-gas for 5 minutes, and transfer to a 100-mL graduated cylinder.

Note The degas time should be constant for all gels, to ensure a reproducible 
polymerization rate for all runs.

5. Add 8 mL filtered 10X TBE buffer and adjust the volume to 80 mL with 
dH2O, if necessary.

IMPORTANT Never add the TBE buffer before removing the mixed bed, 
ion-exchange resin by filtration.
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Casting the Gel (all sizes except 48 cm)

To cast 48-cm gels, see page 2-26.

1. Gently pour the acrylamide solution into a 150 mL beaker.

2. Add 400 µL 10% ammonium persulfate (freshly made) and gently swirl. 
Avoid adding air bubbles.

3. Add 45 µL TEMED and gently swirl. Avoid adding air bubbles.

4. Immediately and carefully cast the gel by holding the plates at an angle to 
the bench top, and resting the lip of the solution vessel against the edge of 
the notched plate. Pour the solution between the plates and fill to about 
3–5 cm from the top edge of the notched plate (the level of gel solution 
must be high enough so that the “ears” of the plates are filled when the 
plates are laying flat). The solution can also be dispensed using a 60 mL 
plastic disposable syringe. 

5. Allow all air bubbles to rise. Gently tap the plates to help trapped bubbles 
rise to the surface. 

6. For sharks-tooth combs: Insert the gel casting comb. Wet the gel casting comb 
with the acrylamide solution. Be sure there are no bubbles trapped at the 
gel solution/casting comb interface.

For square-tooth combs: Insert the square-tooth comb. Be sure there are no 
bubbles trapped at the gel solution/comb interface.

IMPORTANT Because of tolerance issues, verify the combs, spacers, and casting 
comb you are using are compatible (made of the same material) and 
are the same thickness.

Note Ensure that the casting comb is completely dry before wetting it with 
acrylamide. Using a wet casting comb can make the surface of the 
acrylamide wavy, which can change the way samples migrate through 
the gel. 
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IMPORTANT Be sure there are no air bubbles trapped at the gel solution/comb 
interface after the comb is inserted. Bubbles result in depressions on 
the well surface, leading to sample leakage (for sharks-tooth combs) 
and/or decreased resolution in affected lanes.

7. Lay the plates in the horizontal position and secure the casting or 
square-tooth comb with three large binder clamps. Place the clamps 
directly over the region of the gel casting comb that is sandwiched between 
the glass plates.

IMPORTANT Use a level gauge to ensure that the plates are on a level surface while 
the gel is polymerizing.

8. Wait at least two hours to ensure complete polymerization prior to using 
the gel.

For sequencing and GeneScan runs, refer to Section 3 and Section 4, 
respectively, the Step-by-Step procedure, for details on how to prepare and 
place the gel and glass plates on the instrument.
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Preparing the Plates (48 cm only)

The 48 cm run uses a different gel recipe and set up procedures than any of the 
other runs. The following section provides the necessary information for 
preparing the gel solution, preparing and setting up the glass plates, and pouring 
the gel.

Preparing Gel Casting Equipment for a 48 cm Run

Rinse both sides of the notched and plain glass plates with warm water. Then wash 
the plates with a detergent such as Alconox that will not leave a residue and warm 
water. Take care not to scratch or abrade the glass surfaces.

Caution Avoid contacting the glass plates with metal. Scratches caused by 
metal objects, such as clamps, drying racks, or spatulas cannot 
be detected by eye and will weaken the glass and reduce its 
usable life.

Rinse the plates well with warm water followed by distilled, deionized water. Stand 
the plates up and allow them to air dry. 

Note Do not touch the cleaned surfaces of the glass plates and wear gloves 
to handle the plates. Always try to use the glass plates with the same 
side of each plate on the inside.

Preparing Glass Plates for 48 cm Gels

To achieve the high resolution of a 48 cm run, a very flat well surface is required. 
This is more difficult with a 4.0% acrylamide gel, which is less rigid than gels with 
higher percentages. Silating the unnotched glass plate in the well area (upper 
3.5 cm) with a solution like Pharmacia’s Bind-Silane compound will help to 
ensure a flat well surface. Follow the instructions below for performing the 
silation. This must be repeated every time a new gel is poured. Remove the old gel 
from the silated area with 0.1 N HCl or NaOH, or scrape off gently.



Applied Biosystems

March 2001 2  Preparing Gels 2-23

Applying the Bind-Silane Compound

1. Wash the unnotched glass plate in detergent, rinse well with distilled water, 
and leave to dry.

2. Adjust 200 mL H2O to pH 3.5 with acetic acid. Add 800-µL Bind-Silane and 
stir until clear, approximately 15 minutes.

3. Set the unnotched plate in a tub with the Bind-Silane solution covering the 
top 3.5 cm of the glass. Leave immersed at room temperature for 
10–60 minutes.

4. Rinse the glass plate with warm water, and then with dH2O, and let dry.

IMPORTANT Do not get Bind-Silane on the laser-scanning region of the gel; it will 
fluoresce.

Assembling the Glass Plates for a 48 cm Run

1. Make sure to use the gel spacers and gel casting comb labeled 0.3 mm. 
Wash the comb and spacers with warm water, and then with dH2O, and 
then with reagent quality ethanol, and let dry.

IMPORTANT The spacers used for 48-cm WTR gels have notches cut out of one end. 
When assembling the plates, ensure that the notches are at the top of 
the plates, and facing in, towards the well.

2. Place the unnotched plate on a protected benchtop and arrange the 
spacers on the outer edges of the plate. Lay the notched plate on top of the 
unnotched plate and spacers. Align the plates and spacers and clamp one 
side to temporarily hold plates in position. 

3. Apply 1.5-inch wide tape tightly along the edge opposite the clamp. Wrap 
tape around both the top and bottom corners.

4. Remove the clamp and apply tape along the second long edge. Wrap tape 
around both the top and bottom corners.
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5. Apply tape along the bottom edge of the plates, wrapping around both 
corners.

Note Using a commercially available gel pouring device can simplify gel 
casting by eliminating the need to tape the glass plates.

6. Eliminate any air pockets under the tape and reinforce points of assembly 
that are likely to leak acrylamide solution.

7. Place three binder clips over each spacer (on top of the tape), spaced 
evenly between the top and bottom of the plates. Be careful to keep the 
clips over the spacer and not in the region where the acrylamide will be 
poured. Although using binder clips is not recommended with the shorter 
gel plates, it does help keep the gel thickness uniform with the longer glass 
plates.
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Preparing the Gel (48 cm only)

Preparing 4% Acrylamide-urea Gel Solutions

The 48-cm plates hold a larger volume than the other plates. Therefore, this 
recipe is for 100 mL and the volume of TBE, APS, and TEMED are greater than 
for the other gels also.

To prepare 4% gel solutions:

1. Combine the following components in a 150 mL beaker to prepare a final 
volume of 100 mL of a 4.0% acrylamide, 8.3 M urea, 1X TBE:

• 50 g urea

• 37 mL dH2O

• 10 mL 40% acrylamide stock solution

• 1 g mixed bed, ion-exchange resin

2. Stir the solution while gently warming it until the urea crystals begin to 
dissolve and the flask is slightly warm to the touch. Continue to stir the 
solution with no additional heating for 5-10 minutes longer, or until all of 
the urea crystals have dissolved.

3. Filter the acrylamide solution through a 0.2 µm cellulose nitrate filter, 
de-gas for 5 minutes, and transfer to a 100-mL graduated cylinder.

Note The degas time should be constant for all gels, to ensure a reproducible 
polymerization rate for all runs.

4. Add 10 mL 10X TBE, and bring to 100 mL with dH2O, if necessary.

IMPORTANT Never add the TBE buffer before removing the mixed bed, 
ion-exchange resin by filtration.



Applied Biosystems

2-26 2  Preparing Gels March 2001

Casting the 48-cm Gel 

To cast the 48-cm gel:

1. Gently pour the acrylamide solution into a 250-mL beaker.

2. Add 500 µL 10% ammonium persulfate (freshly made) and gently swirl. 
Avoid adding air bubbles.

3. Add 50 µL TEMED and gently swirl. Avoid adding air bubbles.

Note Adjust the volume of TEMED as needed to ensure complete 
polymerization in 5 to 10 minutes.

4. Holding the plates at an angle, immediately and carefully pour the 
solution between the plates and fill to about 3–5 cm from the top edge of 
the notched plate. 

The level of gel solution must be high enough so that the “ears” of the 
plates are filled when the plates are laying flat. You can also use a plastic 
disposable syringe to dispense the solution. 

IMPORTANT Pour the solution very carefully. It is difficult to remove air bubbles out 
from between the longer plates, and any air bubbles can significantly 
reduce resolution. Small air bubbles are difficult to see.

5. Allow all air bubbles to rise. Gently tap the plates to help trapped bubbles 
rise to the surface. 

Avoid tapping plates in the laser scan region with a hard object. Scratches 
or nicks on the plate surface can interfere with data collection.

6. Wet the 0.3-mm gel casting comb with the acrylamide solution and insert 
it between the two glass plates. 

Note Ensure that the casting comb is completely dry before wetting it with 
acrylamide. Using a wet casting comb can make the surface of the 
acrylamide wavy and change the way samples migrate through the gel. 
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IMPORTANT Be sure there are no air bubbles between the glass plates and the 
acrylic casting comb after the casting comb has been inserted into the 
gel. Bubbles will be wicked into the acrylamide and result in 
depressions on the well surface, leading to decreased resolution in 
affected lanes.

7. Lay the plates in the horizontal position and secure the comb with three 
large binder clamps. Place the clamps directly over the region of the gel 
casting comb that is sandwiched between the glass plates.

IMPORTANT Use a level gauge to ensure that the plates are on a level surface while 
the gel is polymerizing.
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Figure 3-1.  Flow chart for electrophoresing/collecting data on ABI PRISM 373 DNA 
Sequencer with XL Upgrade
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Introduction

This section guides you through the process of electrophoresing your DNA 
samples and collecting the resulting sequence data on the ABI PRISM 373XL DNA 
Sequencer. Figure 3-1 shows the recommended flow of the process.

Although this section is detailed, it does not provide complete details for each 
procedure. Use it as a guide, and refer as necessary to the cross-referenced pages 
for more detail.

Note Even if you have previous experience using the Model 373, you should 
read through these steps. The data collection software has been 
streamlined. You no longer need to enter any commands on the 
instrument itself.

The information in this section applies to Sequencing applications. Instrument 
setup consists of the same steps for either Sequencing or GeneScan applications. 
The only differences are in completing the Sample Sheet and Run file. 

For further information about the analysis performed for each application, refer 
to the Sequencing and GeneScan analysis software manuals.
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Before You Set Up the Instrument

Preparing Samples

Make sure you have prepared your samples as described in the ABI PRISM DNA 
Sequencing Chemistry Guide, or in the appropriate kit protocol. Before you set up 
your instrument, perform the following procedures: 

• Purify and quantitate the template DNA.

• Complete the appropriate sequencing reactions with dye primer or dye 
terminator chemistry.

• Prepare a polyacrylamide gel.

It is very important that you purify the DNA thoroughly and have a sufficient 
quantity of DNA to get the best results. Optimal quantities for single-stranded and 
double-stranded templates are shown in the chemistry guides and protocol 
manuals for appropriate kits.

Setting up the Software

While the gel is polymerizing, you can set up the Sample Sheet and Run file for 
the data collection software. Refer to Setting Up the Software on page 3-16.

If you want automatic analysis after data collection, set up the conditions that 
control data analysis before you start a run. To do so, refer to the user’s manual 
provided with your analysis software.

IMPORTANT If you choose automatic analysis and want the Sequencing Analysis 
software to use a setting other than the default, customize the analysis 
preferences before you start data collection. 

If you specify automatic analysis in the data collection program, the analysis 
program starts automatically at the end of the run to process the collected data. 
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Setting Up the Instrument

Pour your gel as described in Section 2, and allow it to polymerize for two hours 
before proceeding with this section. 

IMPORTANT Make sure to use the appropriate gel concentration for the gel length 
and run type. 

Preparing the Gel for Loading

Note Wear clean laboratory gloves throughout this procedure both for your 
protection, and to avoid transferring fluorescent contaminants from 
your hands to the glass plates. 

Reagents and supplies needed for preparing the glass plates
• A single-edged razor blade or a second casting comb

• 1.5 L 1X Tris Borate EDTA buffer (2 L for 34-cm gels), pH 8.3 (from 10X 
TBE stock solution, Section 2)

• A clean, 10–50 mL syringe and 22 G needle
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To prepare the plates for loading on the instrument:

Figure 3-2.  Casting comb

1. Remove the clamps on the gel casting (single-well) comb, and the tape 
from the edges of the plates. 

2. Carefully remove the gel casting comb from between the plates. Remove 
any acrylamide in the well region with the razor blade. 

Note To avoid cutting the comb, do not use the razor blade while the casting 
comb is in place.

3. Rinse the glass plates with cold water. 

a. Rinse both sides and edges of the glass plates thoroughly with cold tap 
water to remove dried acrylamide and urea. 

b. Rinse the well and plates with dH20 and allow the plates to air dry.

Note Wash the gel casting comb and allow it to air dry, so it will be ready 
when you pour the next gel.
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Preparing the Electrophoresis Chamber

WARNING ELECTRICAL SHOCK HAZARD. The Model 373 contains a high 
voltage power supply. This instrument has been designed with 
safety features in the door to disconnect the power supply when 
the door is open. Although it is designed for safe operation, please 
follow procedures as prescribed. As with any electrophoresis 
apparatus, care should be taken during instrument operation and 
when handling electrodes and liquids.

WARNING ELECTRICAL SHOCK HAZARD. Wait at least 5 seconds after 
opening the door before touching the electrodes in the 
electrophoresis chamber. Capacitors hold an electrical charge 
even after the power supply is disconnected.

Model-Specific Notation
This manual applies to three configurations of Model 373 DNA Sequencers:

• Classic. This configuration includes 370s with Macintosh upgrade and the 
373A. Classic models have electrophoresis chambers which support 24-cm 
WTR distances.

• Leon. This configuration has an electrophoresis chamber which supports 
6-, 12-, and 24-cm WTR distances.

• Stretch. This configuration supports 6-, 12-, 24-, 34-, and 48-cm WTR 
distances and is easily identified by its extended door. 

Note All three instrument configurations must have five-filter wheel 
capability.

Most of the information in this manual applies to all three configurations, 
however, some sections of the manual apply to only one or two of these 
configurations. These sections are preceded by the name of the configuration 
(Classic, Leon, or Stretch) to which they apply.
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To prepare the electrophoresis chamber:

1. Open the door to the Model 373 and make sure the heating plate is dry.

2. Place the lower buffer chamber in the bottom of the electrophoresis 
chamber with the electrode to the front. The upper chamber will not be 
needed until later.

Figure 3-3.  Placement of the Buffer Chambers, glass plates, and beam-stop 
bar in the electrophoresis chamber of the Model 373 (Classic)

3. Pull the black beam-stop bar in the electrophoresis chamber toward you 
until it stops (Figure 3-3). Rest the bottom edge of the plates on the 
notched supports in the bottom of the lower buffer chamber, with the 
notched plate facing away from you. Stand the plates in a vertical position. 
Press them firmly against the heating plate, and then push the beam-stop 
bar up against the plates. Center the plates in relation to the beam-stop bar, 
and then lock the beam stop bar in place by sliding the latches down along 
the outer edges.

IMPORTANT Center the plates to ensure that each sample migrates within the read 
region of the laser.

Note You can remove the beam-stop bar. In normal operation you do not 
need to remove it. To re-install the beam-stop bar, line up the alignment 
pins in the alignment grooves and slide the beam-stop bar into place.

Classic

Upper buffer 
chamber

Model 373 (Classic), 
side view

Glass plates

Beam-stop bar

Lower buffer 
chamber
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To prepare the electrophoresis chamber:

1. Open the door to the Model 373.

Figure 3-4.  Model 373 (Leon) Electrophoresis Chamber

2. Place the lower buffer chamber in the bottom of the electrophoresis 
chamber with the electrode to the front. The upper chamber will not be 
needed until later.

Leon

Upper buffer chamber 
support

Heat plate reset

Beam-stop 
swivel clamps

Glass plate support

Lower buffer chamber

Beam-stop bar
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3. Adjust the upper buffer chamber supports to 24 cm. Loosen the screws and 
slide the brackets to the correct position as indicated by the well-to-read 
length printed on the supports, and then tighten the screws. 

Note You must use an acrylamide gel with a 24-cm well-to-read distance for 
sequencing on the Model 373.

4. Place the glass plates into the instrument as follows:

a. Pull the black beam-stop bar in the electrophoresis chamber towards 
you until it stops (Figure 3-4 on page 3-10). 

b. Rest the bottom edge of the plates on the notched supports in the 
bottom of the lower buffer chamber, with the notched plate facing 
away from you. 

c. Stand the plates up in the vertical position. Press them firmly against 
the back of the chamber (avoid touching the laser read region, and 
then push the beam-stop bar up against the plates. 

d. Center the plates with relation to the beam-stop bar and then latch 
the bar in place.
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To Set Up the Electrophoresis Chamber:

1. Open the door to the Model 373. The electrophoresis chamber is shown in 
Figure 3-5.

Figure 3-5.  Model 373 (Stretch) Electrophoresis Chamber

2. For 24- or 34-cm gel: place the straight white upper buffer chamber shelf on 
the appropriate support on the inside of the electrophoresis chamber (see 
Figure 3-5).
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For 48-cm gel: Place the straight white plastic upper chamber shelf on the 
34-cm support. Place the 48-cm WTR extension shelf on top of the straight 
shelf. The upper buffer chamber is placed on this shelf.

3. Slide the heat plate into place, as follows:

a. Choose the correct heat plate for the glass plates you are using.

b. Make sure the electrical wires for the temperature sensor are at the 
top, with the plate clamps toward the front. Align the grooves on 
either side of the heat plate with the heat plate guides on the 
chamber.

c. Slide the heat plate down until it rests on the bottom of the chamber.

d. Plug the temperature sensor on the heat plate into the socket at the 
top left of the chamber.

e. Plug the heat plate ground into the socket at the top right of the 
chamber.

IMPORTANT Make sure the heat plate ground is connected before continuing.

4. Adjust the gel plate rests in the lower buffer chamber, if necessary (see 
Figure 3-6). The gel plates rests are located in the bottom of the buffer 
chamber and serve to elevate the glass plates. The 34-cm plates must sit 
higher in the buffer chamber to rest in the correct position. All other 
plates rest in the lower position.

Each gel plate rest consists of several parts, a large ABS block on the 
bottom, a shorter ABS block on top of it, and an adjustable thumb screw. 
When the thumb screw is loose, the small block can be moved forward and 
back, so that the plates rest either on one block, or on two blocks (see 
Figure 3-6). 

a. Loosen the thumb screws.

b. Slide the blocks toward the back of the chamber if you are using 
34-cm plates, so the plates rest in the high position. Slide the blocks 
toward the front of the chamber for all other gel lengths so the plates 
rest in the low position.

c. Tighten the thumb screws.
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Figure 3-6.  Adjustable gel plate rests

5. Place the lower buffer chamber in the bottom of the electrophoresis 
chamber with the electrode to the front. The upper chamber will not be 
needed until later.

6. Unfasten the latches on either side of the beam-stop bar and swing the 
beam-stop bar forward, toward you.

7. Place the glass plates in the electrophoresis chamber in front of the heat 
plate and read window, with the bottom of the plates resting on the gel 
plate rests. 

Glass plates rest here

Thumb screw

a. For all run lengths except 34 cm. With 
the movable blocks toward the front of the 
electrophoresis chamber, the glass plates rest 
lower in the buffer chamber. 

b.  For 34-cm runs only. With the movable 
blocks toward the back of the electrophoresis 
chamber, the glass plates rest higher in the 
buffer chamber.

Front of electrophoresis chamber

Front of electrophoresis chamber

Thumb screw
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a. Center the glass plates carefully, or the beam-stop bar will not fasten.

b. Press the glass plates against the heat plate and close the beam-stop 
bar.

c. Fasten the latches at either side of the beam-stop bar.

IMPORTANT Do not touch the gel plates within the read region.

Automatic Analysis

If you want automatic analysis after data collection, set up the conditions that 
control data analysis before you start a run. To do so, refer to the user’s manual 
provided with your analysis software.

IMPORTANT If you choose Automatic Analysis and want the Sequencing Analysis 
software to use settings other than the default, customize the analysis 
preferences before you start data collection. Define all preferences 
from the Edit pulldown menu.

If you specify automatic analysis in the data collection program, the analysis 
program starts automatically at the end of the run to process the collected data. 
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Setting Up the Software 

Before starting electrophoresis, ensure there is sufficient space on the hard disk 
and restart the Macintosh. After deleting files, you must restart the Macintosh. 
You must also set up certain files in the data collection software:

• Set preferences

• Record sample information in the Sequence Sample Sheet

• Create a Sequence Run file

Note These tasks can be performed while you are waiting for the gel to 
polymerize.

You can simplify creation of the files by setting preferences for certain parameters 
in each file. 

The procedures described here do not include detailed descriptions of the data 
collection software. They are intended to give you a guide for steps you perform 
and the order in which to perform them. For specific information about the 
software and how to complete specific fields, refer to Section 5. 

You may not need to change these default parameters for future runs, if you always 
run the same or similar parameters. However, it is important to verify these 
defaults, since they determine the names and locations of your data.

For more detail, refer to the specific pages in Section 5.

Setting up the Analysis Software

If you want automatic analysis after data collection, set up the conditions that 
control data analysis before you start a run. To do so, refer to the User’s Manual 
provided with your analysis software.

IMPORTANT The default Base Caller used by the Sequencing Analysis software is 
SemiAdaptive. If you want to use the ABI BaseCallers or Adaptive Base 
Caller, change the analysis preferences before you start data 
collection.
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Starting the Data Collection Software

1. Choose Restart from the Special menu in the Finder to restart your 
Macintosh.

2. The data collection software should automatically open upon restarting 
the Macintosh. If it does not open, double-click the icon to open the 
program. Refer to To make the data collection program open at startup: on page 
5-13 for instructions to open the collection program at startup.

Note When you start the ABI PRISM 373 DNA Sequencer with XL Upgrade 
data collection program, the program searches for the current version 
of firmware on the Translation Interface Processor (TIP). If none is 
found, the program automatically copies the firmware image file (stored 
on the Macintosh) to the TIP. If the TIP’s version of firmware is different  
from the collection software version, a dialog box appears, allowing you 
to continue or send a new firmware to the TIP. Click Send New 
Firmware to update your firmware version.

Creating User-Specific Module Files

The ABI PRISM 373 DNA Sequencer with XL Upgrade is shipped with module file 
templates for plate check, prerun, sequencing, and GeneScan runs. Table 3-1 
shows the default parameters for the module file templates.

IMPORTANT The parameters in Table 3-1 apply only to 24-cm WTR Classic or Leon 
6% acrylamide gels.

Table 3-1.   Module File Default Parameters

Module
Field

(Volts)
Power
(Watts)

Current
(mAmps)

Laser Power
(mWatts)

Run Time
(Hours)

Plate Check -- -- -- 40 0.50
Pre Run 2500 30 40 40 0.33
Seq Run 2500 30 40 40 12
GS Run 2500 30 40 40 12
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You must create user-specific module files the first time the instrument is used and 
for each different run condition. Once you modify a module file template, you 
can save it and use it each time a similar run is performed. Refer to Table 1-2 on 
page 1-14 and Appendix B for suggested module file and Run parameters.

To modify a module file template:

1. Choose New from the File menu.

2. Click the Sequence Run or GeneScan icon in the window that appears.

3. Choose the module file you wish to modify from the Run Module pop-up 
menu.

Note You do not need to complete the other information in the Run window 
to modify a module file.

4. Click the small document icon next to the Run module pop-up menu.

Figure 3-7.  Module settings dialog box

5. Type a new number in the applicable entry fields. Refer to Table 1-2 on 
page 1-14 for recommended run parameters.

6. Save the changes.

• Save as Default: To save the changed parameters as defaults for the 
module without changing the module name, click Save as Default. The 
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new settings are permanently saved and the name of the module file 
remains unchanged.

• Save Copy in…: To save the changed parameters as defaults, click Save 
Copy in. Type in a new name for the module file and save the file in the 
Modules Folder. The new settings are permanently saved and the name 
of the module file is changed.

Note You will not be able to select your new module file in the pop-up menu 
until you save and close the Run window, then reopen the saved Run 
file or create a new Run file. 

• Save: To use the changes as a one-time override for the current run, 
click Save.

Note Custom module files are stored on your hard disk and can be used for 
any subsequent run. If you reload your collection software, however, 
you must re-create your custom modules.

Setting Default Parameters (Preferences)

You might only need to set default parameters prior to the first run. However, if 
more than one person uses the instrument, we recommend you set or verify all 
preferences before starting the run. If you are satisfied with the defaults stored in 
the instrument, skip to page 3-21 to create a Sample Sheet and a Run file.

You can set several types of preferred defaults:

• Folder locations: The ABI PRISM 373XL data collection software uses 
specified folders for data storage. This option allows you to specify the 
folders it uses. For information about changing folder locations, refer to To 
change one of the data storage folders: on page 5-17.

• Default File names: The data collection program automatically names new 
files and folders created during a run. You can specify the prefix and suffix 
of each type of file (see Setting File Name Preferences on page 5-18).

• Sequence Sample Sheet defaults: You can set defaults for certain parameters on 
the Sample Sheet. Since the Sample Sheets differ for Sequence Analysis 
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and GeneScan (fragment) Analysis, the parameters for which you can set 
defaults also differ. To set defaults for the sequence Sample Sheet, refer to 
To set Sample Sheet defaults for Sequencing Analysis applications: on page 5-21 .

• Sequence Run defaults: You can also set defaults for certain parameters in the 
Run file. As with the Sample Sheet defaults, separate defaults apply for 
sequence runs and GeneScan analysis runs. To set defaults for sequence 
Run files, refer to Setting Defaults for Sequencing Analysis Applications on page 
5-21.

• General settings: The ABI PRISM 373XL instrument is normally attached to 
the Modem port of the Macintosh computer. If you need to change the 
connection, you can specify the change using this preference choice. Also 
use this choice to reset the global serial number (refer to General Settings on 
page 5-27). To change general settings, refer to To change the general settings: 
on page 5-28.

• Dye indicators: Each of the four dyes used during a run has a preset code and 
color. You can change the color assigned to each dye, and change the color 
that appears in the plot when it is printed. To do so, refer to To set dye 
indicator preferences for the analysis applications: on page 5-29.

To set preferences:

1. Choose Preferences from the Window menu and choose the appropriate 
option from the submenu that appears.

Figure 3-8.  Preferences submenu
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2. Enter or change the defaults, as described on the pages noted above.

3. Click OK to accept the changes.

Creating the Sample Sheet

Before starting a run you must record sample information in the Sequence 
Sample Sheet and the Sequence Run file. Once you have set up the Sample Sheet, 
you can automatically  import the Sample Sheet information into the Run file, 
which associates sample information (name and type of analysis) with each lane 
position in the gel.

Separate Sample Sheets exist for sequencing and GeneScan analysis applications 
(see Figure 3-9). Be sure to choose Sequence Sample Sheet.

If a Sample Sheet containing the correct information already exists, you can use 
it. In most cases, you need to create a new Sample Sheet for each run. You can 
enter the information directly or export information from a database in 
tab-delimited format and import it into the Sample Sheet. 

To create a Sample Sheet:

IMPORTANT Although the Sample Sheet has 72 lanes available, fill in the sample 
information only for the number of lanes you are using.

1. Choose New (z-N) from the File menu.

2. Click the Sequence Sample Sheet icon in the window that appears.

IMPORTANT Do not mix sequence analysis and GeneScan analysis samples on the 
same Sample Sheet or the same Run.

The Sample Sheet is similar to a spreadsheet or ledger. It accepts more text 
than fits in the visible fields and automatically scrolls as you type your entry. 
To view the beginning of a long entry, use the keyboard arrow keys. Many 
of the cells have default values that are automatically filled in for each 
sample.
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3. Enter the necessary information. For details about completing the Sample 
Sheets (including information about importing from a database), refer to 
Creating and Editing a Sample Sheet on page 5-32.

4. When you are finished, choose Save from the File menu.

The dialog box that appears shows the default file name and storage 
location as defined in the File Names and Folders locations preferences, 
respectively. You can change the file name if you wish.

5. Click Save.

6. Choose Close from the File menu, or click the close box.

Figure 3-9.  Blank Sequence Sample Sheet

Creating a Run File

In the Run file, you specify the lanes in which the samples will run and parameters 
to be used for both the pre-run and the run. If a Run file exists that contains the 
proper parameters, you can copy it to a new folder and use it. In most cases you 
need to create a Run file for each new run.

Separate Run windows exist for sequencing and GeneScan analysis applications. 
They are very similar; the GeneScan analysis version has an additional (Analysis 
Settings) column. Be sure to choose the correct type for your application.

When you set defaults for mobility and matrix files, the columns are filled in automatically

Click an arrow to display a pop-up menu of options
Click a title 
to select the 
entire column

Enter Sample 
name here.
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To create a Run file:

1. Choose New from the File menu.

2. Click the sequence Run icon in the window that appears.

Figure 3-10.  Sequence Run window

3. Choose the parameters for the run from the pop-up menus.

Note Any changes made in your preferences will not take effect until you 
open a new Run file.

a. Choose modules to be used for the plate check, the pre-run and the 
run in the Module pop-up menus. 

b. Choose the Sample Sheet from the Sample Sheet pop-up menu.

When you choose the Sample Sheet, the information about the lanes 
in which the samples are to run is imported automatically. 

Run control 
buttons

Pop-up menus in 
these panels allow 
you to choose the 
modules 
(parameters), the 
associated 
Sample Sheet, the 
number of lanes, 
the separation 
distance (WTR), 
and the 
instrument file for 
the run

Small document icons open the selected module or 
Sample Sheet for review

Lane numbers cannot be edited

Specify length of run

Select filter set
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IMPORTANT If you select number of lanes less than the number of lanes you filled 
out in the in your Sample Sheet, the information will be truncated. To 
fix this: 
1. Select correct number of lanes and Run mode.
2. Select <none> on the Sample Sheet pop-up menu and reselect

the Sample Sheet you want to use.

c. Choose an instrument file from the Instrument File pop-up menu.

Appendix C describes Sequencing Instrument Files.

d. Choose the number of lanes and the separation distance from the 
lanes pop-up menu and the WTR pop-up menu, respectively. 

e. Choose XL Scan, Full Scan, or BaseSprinter in the Run Mode pop-up 
menu. Use the table below to determine the appropriate run mode 
for the lane configuration you are using.

Note If you select a run mode which is incompatible with the number of lanes 
selected in Step d, the lane pop-up menu will display <none>.

Lanes Comb Run Mode
18 Sharks-tooth BaseSprinter
24 Sharks-tooth Full Scan
32 Sharks-tooth Full Scan
36 Sharks-tooth Full Scan
48 Sharks-tooth XL Scan
64 Sharks-tooth XL Scan
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4. Enter the length of the run in the Collect Time entry field. Following are 
some suggested run times.

5. Enter your name in the Operator entry field.

As noted, the sample information for each lane is entered automatically in 
the grid at the bottom of the Run window when you choose a Sample 
Sheet. 

Note You cannot edit the Sample Sheet information in the Run window. 
Make any changes in the Sample Sheet, save the changes, select 
<none> and then select the Sample Sheet again in the Run window to 
make the changes effective.

6. Choose the appropriate filter set:

For Sequenase T7 Terminator chemistry: Select filter set B. 

For all other sequencing chemistries: Select filter set A.

IMPORTANT Failure to select the correct filter set will result in the loss of data.

7. Select the Auto Analyze and Auto Print checkboxes if you want the analysis 
program to analyze and print the data.

When you finish completing the information in the Run file, do not close the Run 
file window. You can use it to perform a plate check, as described in the next 
section.

The options available to you at this time are:

• Save the file for future use, then click the close box to close it.

Plate Length
(cm)

Type of Run Typical Collection Time 
(hr)

24 XLScan or Full Scan 12
24 BaseSprinter 6.5
34 XLScan or Full Scan 12
34 BaseSprinter 7
48 XLScan or Full Scan 16
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• Start a plate check by clicking the Plate Check button.

To save the file, choose Save from the File menu. To perform a plate check, see 
page 3-27.

For more information about creating the Run file, refer to page 5-40. 



Applied Biosystems

March 2001 3  Using the Instrument in Sequencing Mode 3-27

Checking the Plates

Scan the gel and plates before adding buffer and loading samples, to ensure that 
no peaks are produced by fluorescent particles on the glass plates or in the gel.

Figure 3-11.  Completed Sequencing Run window

To check the plates:

1. Click Plate Check in the Run window.

Note If a dialog box appears indicating you do not have enough room on your 
hard disk to save the files created by a run, delete files (particularly Gel 
files) to create enough space, making sure to back them up on a floppy 
disk or other storage device first, then click Plate Check again.

The laser scans the plates without electrophoresis to detect any unwanted 
fluorescent material in the read region.

2. Observe the Scan window that appears.

Click Plate 
Check after you 
choose the Plate 
Check module
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The Scan window should show a relatively flat line across the screen in each 
of the four colors. Typically the lowest line is blue, followed by the green, 
yellow (black), and red lines. If the scan line is flat, then the plates are 
clean. Proceed to Check the PMT Gain Setting on page 3-32.

If you see peaks in the Scan window, clean the glass plates again, as 
described below. 

WARNING LASER HAZARD. Do not look directly into the laser beam or allow 
a reflection of the beam to enter your eyes. Exposure to direct or 
reflected laser light at 40 mW for 0.1 seconds can burn the retina 
of the eye and leave a permanent blind spot. 

Cleaning the Plates or Skipping Lanes
Peaks in the scan lines could indicate dirt on the glass or contaminating 
fluorescence in the gel. To eliminate dirt on the glass, clean the plates and scan 
them again. If peaks still appear and you wish to use the gel, avoid loading samples 
in the lanes where the peaks appear.

To clean the plates and re-scan:

1. Click Pause to pause the plate check.

2. Open the door of the instrument and unlatch the beam stop bar and 
remove the plates.

3. Carefully re-clean both sides of the glass in the laser read region with dH2O 
and a lint-free tissue or ultra-pure pressurized air.

4. Replace the plates, center, and latch the beam stop bar in the 
electrophoresis chamber.

5. Click Resume and check the plates again.

If the peaks do not disappear after cleaning the glass, the gel mixture or buffer 
might contain particles. If you wish to use the gel, avoid loading samples in the 
lanes where the peaks appear.
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Note Occasionally, peaks in the scan window are caused by a dirty beam 
stop bar, rather than by dust or particulates in the gel. Clean the beam 
stop bar with dH2O and (optionally) a thin layer of oil, if the peaks do not 

disappear after cleaning the glass.

Skipping Lanes
If, even after cleaning, a plate check shows peaks in some lanes of a gel, use Table 
3-2 to determine which lanes are contaminated. Do not load samples in those 
lanes. 

Table 3-2 shows scan numbers that correspond to the center of each lane for five 
different sharks-tooth combs. The exact positions of the channels may vary slightly 
from instrument to instrument, and with each comb placement. 

If the contaminant peaks are close to the edge of a lane, you may wish to skip two 
lanes to ensure that there is no contamination in the lanes you load.

Note Table 3-2 is based on the premise that all lanes run straight and do not 
deviate from the “expected” path, so channel/lane center may be an 
approximation, depending on the quality of your gel.

Table 3-2.  Channel Numbers at Center of Each Lane for Sharks-tooth Combs  

24-well comb 32-well comb 36-well comb 48-well comb 64-well comb
Lane Channel Lane Channel Lane Channel Lane Channel Lane Channel
1 7 1 5 1 4 1 7 1 5
2 15 2 11 2 9 2 15 2 11
3 23 3 17 3 14 3 23 3 17
4 30 4 23 4 20 4 30 4 23
5 38 5 29 5 25 5 38 5 25
6 46 6 35 6 30 6 46 6 35
7 54 7 41 7 36 7 54 7 41
8 62 8 47 8 41 8 62 8 47
9 69 9 53 9 46 9 69 9 53
10 77 10 58 10 52 10 77 10 58
11 85 11 64 11 57 11 85 11 64
12 93 12 70 12 62 12 93 12 70
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13 101 13 76 13 68 13 101 13 76
14 107 14 82 14 73 14 107 14 82
15 116 15 88 15 78 15 116 15 88
16 124 16 94 16 84 16 124 16 94
17 132 17 100 17 89 17 132 17 100
18 140 18 106 18 94 18 140 18 106
19 148 19 112 19 100 19 148 19 112
20 155 20 117 20 105 20 155 20 117
21 163 21 123 21 110 21 163 21 123
22 171 22 129 22 116 22 171 22 129
23 179 23 135 23 121 23 179 23 135
24 187 24 141 24 126 24 187 24 141

25 147 25 132 25 195 25 147
26 153 26 137 26 203 26 153
27 159 27 142 27 211 27 159
28 165 28 148 28 218 28 165
29 171 29 153 29 226 29 171
30 177 30 158 30 234 30 177
31 183 31 164 31 242 31 183
32 189 32 169 32 250 32 189

33 174 33 257 33 194
34 180 34 265 34 200
35 185 35 273 35 206
36 190 36 281 36 212

37 289 37 218
38 297 38 224
39 306 39 230
40 314 40 236
41 322 41 242
42 330 42 248
43 338 43 258
44 345 44 264
45 353 45 264

Table 3-2.  Channel Numbers at Center of Each Lane for Sharks-tooth Combs 
(continued) 

24-well comb 32-well comb 36-well comb 48-well comb 64-well comb
Lane Channel Lane Channel Lane Channel Lane Channel Lane Channel
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46 361 46 270
47 369 47 276
48 377 48 282

49 288
50 294
51 300
52 305
53 311
54 317
55 323
56 329
57 335
58 341
59 347
60 353
61 359
62 365
63 371
64 377

Table 3-2.  Channel Numbers at Center of Each Lane for Sharks-tooth Combs 
(continued) 

24-well comb 32-well comb 36-well comb 48-well comb 64-well comb
Lane Channel Lane Channel Lane Channel Lane Channel Lane Channel
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Check the PMT Gain Setting

Verify Run Mode
The PMT gain setting differs for each of the run modes (XL Scan, Full Scan, and 
BaseSprinter). Verify that you have selected the correct run mode in the Run 
window before checking the PMT gain setting.

First Time Run
The PMT gain settings are stored in a Calibration file. If this is the first time the 
instrument is being used, you should make and send a Calibration file. Refer to 
Section 5 for instructions on how to make and send a Calibration file.

Recommended PMT Gain

The PMT gain should be set such that the lowest scan line (usually the blue line) 
is positioned at approximately 900 on the y-axis in the Scan window. For 
subsequent runs, the PMT gain will need to be adjusted only if the y-axis value is 
out of the range of 800–1000 on the y-axis. Different PMT gains are required for 
the three run modes (XL Scan, Full Scan, and BaseSprinter).

To check the PMT gain:

1. While the Plate Check is running, view the four base lines (each line 
represents one of the four filters) in the Scan window of the 373XL 
collection program.

2. Position the cursor so the tip of the arrow just touches a flat section of the 
lowest scan line (usually the blue line), as in Figure 3-12.

Figure 3-12.  Cursor positioned correctly to measure PMT gain

Read y-axis value here
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3. Read the y-axis value displayed in the upper-left hand corner of the scan 
window.

• If the lowest scan line is positioned between 800–1000 on the y-axis, 
cancel the Plate Check, and then proceed to Inserting the Sharks-tooth 
Comb.

• If the lowest scan line is outside the recommended range, adjust the 
PMT gain.

To adjust the PMT gain:

1. While the Plate Check is running, choose Manual Control from the 
Window menu.

2. Adjust the size and position of the Scan and Manual Control windows so 
you can see both windows without any overlap.

3. In the Manual Control window, choose PMT Gain from the Fxn Name 
pop-up menu.

4. Type a new value, then click Execute.

Note If you enter a larger number than the one displayed, the lines in the 
Scan window will shift up; a smaller number causes them to shift down.

5. Check the y-axis value in the Scan window. (First click on the Scan window 
to make it active.)

6. Repeat steps 3–5 until the PMT gain is within the recommended range.

7. Close the Manual Control window.

8. Cancel the Plate Check in the Run window.

Note If you select a different run mode, you must change the PMT gain.
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Inserting the Sharks-tooth Comb

IMPORTANT Because of tolerance issues, be sure that the combs, spacers, and 
casting comb you are using are compatible (made of the same material) 
and are the same thickness.

1. Insert the sharks-tooth comb (see Figure 3-13).

a. Center the sharks-tooth comb in the glass notch and carefully slide it 
between the glass plates. Make sure all of the points on the comb 
enter the space between the plates at the same time to avoid bending 
or breaking the teeth. Carefully align the center registration line with 
the registration mark on the plates.

b. Slide the comb down until the tips of all the teeth just touch or slightly 
depress the surface of the gel. Do not deform the wells. Make sure the 
teeth just barely indent the well surface. All of the teeth must touch 
the surface of the gel. If the surface of the gel is not completely flat in 
the loading region, some of the teeth may have to be inserted below 
the surface of the gel (up to 0.5 mm) so all of the teeth touch the gel 
surface. If a tooth has penetrated the gel surface, do not attempt to 
withdraw the comb or sample will leak into adjacent wells.

Figure 3-13.  Sharks-tooth comb just touching the gel
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Completing Instrument Setup

1. After performing a plate check, place the upper buffer chamber at the top 
of the gel plates by placing it on the upper shelf (Figure 3-3 on page 3-9) 
and sliding the front brackets of the chamber over the glass plates. The 
brackets should sit over the spacers on the outside edges of the plate.

2. Clamp the glass plates to the upper buffer chamber by placing the 
sharks-tooth alignment brace (the rectangular acrylic brace) against the 
front of the glass plates and inside the brackets of the buffer chamber.

3. Tighten the screws on each end of the alignment brace equally on both 
sides to maintain even pressure and to ensure that the brace does not slip 
up at one end. Turn the screws until you see the gasket compress 
completely against the glass. Finger-tighten only—do not overtighten. You 
may need to apply light pressure on the top of the brace to prevent it from 
moving during tightening.

Note The main function of the alignment brace is to maintain a firm, even 
pressure on the sharks-tooth comb with the glass plates, to prevent 
leakage of the sample around the teeth.

4. Fill the upper buffer chamber with the 1X TBE buffer prepared earlier to 
at least half-way up the notched part of the plate (~ 1.3 cm). Check for 
leaks. Close the lid of the buffer chamber.

Note If there is a leak, tighten the brackets slightly. If the leak continues, 
siphon the upper buffer, then clean the gasket area on the chamber and 
the area of the plate that contacts the gasket. Reassemble as before.

5. Carefully fill the lower buffer chamber with 1X TBE buffer to about 
two-thirds full. 

Note Avoid splashing buffer against the back of the chamber since it will spill 
over into the liner. Remove any bubbles that are under the bottom edge 
of the gel plates using a clean needle and syringe. Bend the needle at 
an angle to guide the bubbles out.

Classic
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6. Attach the top and bottom electrode leads located on the left side of the 
electrophoresis chamber and close the door gently.

1. After performing a plate check, slide the heat plate into place against the 
glass plates, as follows (see Figure 3-4 on page 3-10):

a. Rest the lower edge of the heat plate (the edge with the supports 
protruding on both sides) on the upper inside ledge of the beam-stop 
bar where it meets the glass plate. The supports rest in the notches.

b. Stand the heat plate vertically against the glass plates.

c. Secure the beam-stop swivel clamps.

2. Place the upper buffer chamber at the top of the gel plates, on the 
supports. Slide the clamps over the plates.

3. Put the alignment brace in place against the front of the glass plates, inside 
the brackets of the buffer chamber, and resting on top of the heat plate. 

The alignment brace is made of highly polished acrylic so the numbers and 
the comb are readily visible through the plastic. Do not mark the 
alignment brace with felt-tipped pens, as the use of most organic solvents 
to remove the ink will dull the surface of the brace and reduce its clarity. 
Some ink may also fluoresce. 

4. Tighten the screws on both ends of the upper buffer chamber equally to 
maintain even pressure across the alignment brace, and to ensure that the 
brace does not slip up at one end. Turn the screws just until you see the 
gasket compress completely against the glass—do not overtighten. You may 
need to apply light pressure on the top of the brace to prevent it from 
moving during tightening.

The main function of the alignment brace is to maintain a firm, even 
pressure on the sharks-tooth comb with the glass plates to prevent leakage 
of the sample around the teeth.

5. Fill the upper buffer chamber with the 1X TBE buffer prepared earlier to 
at least 2/3 up the notched part of the plate (greater than 1.3 cm). Check 
for leaks. Close the lid of the buffer chamber.

Leon
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If there is a leak, slightly tighten the brackets. If the leak continues, siphon 
the buffer out of the upper buffer chamber and clean the gasket area on 
the chamber. Also, clean the area of the plate that contacts the gasket. 
Reassemble as before.

6. Carefully fill the lower buffer chamber with 1X TBE buffer to about 
two-thirds full. Avoid splashing buffer against the back of the chamber 
because it will spill over into the liner. Bubbles should be removed if they 
are under the bottom edge of the gel plates. This can be done with a clean 
needle and syringe, with the needle bent at an angle to guide the bubbles 
out. 

7. Attach the top and bottom electrode leads located on the left side of the 
electrophoresis chamber and gently close the door.

1. After performing a plate check, place the upper buffer chamber at the top 
of the gel plates, on the white plastic shelf. Slide the clamps over the plates 
but do not tighten the clamps. To ensure a tight seal between the buffer 
chamber and the glass plates, make sure the gasket on the upper buffer 
chamber is dry.

IMPORTANT If you have two different upper buffer chambers, use the larger of the 
two for 34-cm and 48-cm runs. Use the small upper buffer chamber for 
24-cm runs.

2. Slide the plain acrylic alignment brace over the comb (the one without the 
temperature sensor), between the upper buffer chamber clamps and the 
glass plates. Finger-tighten the clamps; be careful not to overtighten.

The alignment brace is made of highly polished plastic so the numbers and 
the comb are readily visible through the clear plastic. Do not mark the 
alignment brace or glass plates with felt-tipped pens, as the use of most 
organic solvents to remove the ink will dull the surface reduce its clarity. 
Some ink may also fluoresce. 

3. Plug the electrode lead on the upper buffer chamber into one of the two 
jacks. For 34-cm and 48-cm gels, use the top (rear) socket, and for all other 
gels, use the lower (front) socket.

Stretch 



Applied Biosystems

3-38 3  Using the Instrument in Sequencing Mode March 2001

4. Fill the upper buffer chamber to at least two-thirds up the notched part of 
the plate (greater than 1.3 cm). Check for leaks. Close the lid of the buffer 
chamber.

If there is a leak, slightly tighten the brackets. If the leak continues, siphon 
the buffer out of the upper buffer chamber and clean the gasket area on 
the chamber. Also, clean the area of the plate that contacts the gasket. 
Reassemble as before.

5. Carefully fill the lower buffer chamber with 1X TBE buffer to about 
two-thirds full. For 34-cm runs, fill the lower buffer chamber until the 
bottom of the glass plates is covered. Avoid splashing buffer against the 
back of the chamber because it will spill over into the liner. Bubbles should 
be removed if they are under the bottom edge of the gel plates. This can 
be done with a clean needle and syringe, with the needle bent at an angle 
to guide the bubbles out. 

IMPORTANT The buffer must completely cover the bottom of the gel plates. You will 
need to prepare 2 L of buffer for 34-cm and 48-cm gels. For all other 
lengths, the standard volume of 1.5 L is sufficient.

6. Attach bottom electrode lead located on the left side of the electrophoresis 
chamber.
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Preparing and Loading Samples

Pre-running the Gel

Pre-run the gel for 5 minutes to make sure all connections and components of the 
electrophoresis system are working properly. 

While the pre-run is in progress, resuspend the DNA in preparation for loading.

To pre-run the gel:

1. Flush all of the wells with running buffer. Direct the 22 G needle of a 
syringe filled with running buffer at the space between adjacent comb 
teeth, and gently flush the well.

Remove any bubbles under the bottom edge of the gel plates in the lower 
buffer chamber. Use a clean needle and syringe, with the needle bent at an 
angle to guide the bubbles out. 

2. If you have not done so, choose the PreRun module from the PreRun 
pop-up menu.

3. Click the PreRun button in the Run window.

The instrument performs electrophoresis without collecting data during a 
pre-run. 

4. Pre-run the gel for 5 minutes.

5. Click Cancel in the Run window.
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Resuspending the DNA

Resuspend the DNA in loading buffer, as described below. After the pre-run 
(about 5 minutes), load the sample and start the run. When using 48- and 64-well 
combs, you can obtain optimum accuracy by loading 1/4 to 1/8 of the total 
resuspension volume, e.g., resuspend your dry sample in 8–12 µL loading buffer 
and load only 1.5 µL. 

IMPORTANT Do not overload your lanes. Both volume and quantity excess lead to a 
decrease in base calling accuracy. Best results are obtained when the 
average signal strengths for G, A, T, and C are all below 500 
fluorescent units/base. More signal is no guarantee of better results; 
with 48 and 64 wells, it actually translates to less accuracy. You may 
need to optimize what volume in this range is best for you.

WARNING CHEMICAL HAZARD. Formamide is a known teratogen (can cause 
birth defects). Before using formamide, read the MSDS found in 
the Safety Summary provided previously. Wear protective 
eyewear, gloves, and safety clothing when working with 
formamide. Wash thoroughly after handling formamide.

To resuspend the DNA:

1. Resuspend your DNA in loading buffer (5:1 deionized formamide: 
25–50 mM EDTA with 25–50 mg/mL Blue Dextran). 

Use the following table to determine the appropriate resuspension and 
loading volumes for the comb you are using.

Table 3-3.  Sequencing Resuspension and Loading Volumes

2. Vortex the samples and centrifuge briefly. 

Comb Configuration (number of wells)
18 24 32/36 48 64

Resuspension volume 4 µL 4–6 µL 4 µL 8–10 µL 8–12 µL
Loading volume 4 µL 4–6 µL 4 µL 1.5–2 µL 1–1.5 µL
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3. Heat samples at 90 °C for two minutes.

4. Immediately place samples on ice until ready to load. 

5. Resuspend samples within 2 hours of loading.

Loading the Samples and Starting the Run

IMPORTANT Be sure you load samples in the lanes specified in the Run window. The 
tracker refers to the sample information to perform accurate lane 
tracking. The sample information in the Run window when you start the 
run is stored in the Gel file. Changes you make in the Run window after 
you start the run are not implemented.

When you are loading many samples using a sharks-tooth comb and need to run 
them in adjacent lanes, it is important that you load samples in alternate wells and 
electrophorese the gel for 2 minutes, then rinse all the wells (step 1 on page 3-39) 
and load the rest of the samples in the remaining unused wells. The automatic 
lane tracker in the analysis software needs to have discrete spaces between the 
samples to identify the lanes properly. Loading samples in adjacent lanes can blur 
the definition between the lanes. Be sure to load strong (control) samples in the 
outside (left-most and right-most) lanes to  orient the tracker during analysis. For 
best results, follow the procedure described below.

Note In the following procedures, each button in the Run window has a 
corresponding menu choice in the Instrument menu. You can either 
click the button in the Run window or choose the command from the 
Instrument menu.

For 48- and 64-well gels, make sure to deliver the samples to the bottom of the 
wells. Use either a single- or multi-channel pipettor/syringe equipped with a flat 
tip less than 0.3 mm in diameter (we recommend 0.17 to 0.20 mm). Do not 
overload the lanes. Follow the recommendations in Table 3-3 for the allowable 
loading volumes. If you use too much sample volume or quantity, you will 
experience poor resolution.
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To load samples:

1. If you are pre-running the gel, click Cancel in the Run window. 

2. Carefully flush all of the wells with running buffer.

Tip Place formamide or loading buffer in the well to the left of your first 
sample lane, and in the well to the right of your last sample lane (the 
comb creates wells to either side of the numbered wells). The 
formamide in the buffer helps focus the bands in the first and last lanes.

3. Immediately load the odd-numbered samples into each of the 
odd-numbered wells. 

If you are loading fewer than half the samples allowed by the comb, skip 
steps 6–10 and proceed to step 11. If you are loading a square-tooth comb, 
you can load the wells consecutively and skip steps 6–10 and proceed to 
step 11. 

IMPORTANT Be sure to load strong (control) samples in the outside (left-most and 
right-most) lanes. Avoid skipping more than one lane between samples. 
It is better to leave extra empty lanes at the right end of the gel. The lane 
tracker may not work properly if there are many empty lanes between 
samples.

4. Click Run in the Run window to start the run.

A dialog box appears, allowing you to change the name and location of the 
gel file created by the run.

5. Click OK when you are satisfied with the name and location for the gel file.

Note If a dialog box appears indicating you do not have enough room on your 
hard disk to save the data generated by a run, delete files (particularly 
Gel files) to create enough space, making sure to back them up on a 
floppy disk or other storage device first, then click Run again.

6. Electrophorese for two minutes so the entire sample enters the gel.
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7. Click Pause in the Run window.

8. Carefully flush all of the wells with running buffer to remove any residual 
formamide from the previously loaded wells.

9. Immediately load the even-numbered wells.

10. Click Resume in the Run window.

11. Choose Status from the Window menu to verify that electrophoresis and 
scanning resume (refer to The Status Window on page 5-50).

If either electrophoresis or scanning does not resume, cancel the run and 
restart it. 

Figure 3-14 summarizes the buttons you click in the Run window for a typical run. 
They are listed from top to bottom in the order you use them. 

Note The tasks described in Figure 3-14 are detailed in the preceding pages.
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Figure 3-14.  Run window buttons used during a typical run

Button to click Module in effect Task to perform

Plate Check module Check plates and gel for 
fluorescence

n/a
(Stops plate check scan)
Add buffer and check for leaks
Mount front heat-transfer 
plate—Leon only

Pre-run module (Electrophorese gel without 
data collection to equilibrate 
temperature) 

Pre-run module Load first set of samples during 
pause

Pre-run module (Electrophorese samples into 
gel without data collection)

Pre-run module Load second set of samples 
during pause

n/a (Stops pre-run)

Run module (Starts electrophoresis and data 
collection)
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Observing Instrument Status and Data

After you begin electrophoresis and data collection, data appears on the 
computer screen as it is collected. You can open up to four windows to view the 
data and the instrument status. Only one window can be active at any given time, 
but status windows still update when they are not active. 

Note If they are displayed, status windows continually update during a run. 
They do so even when another application is running.

Open the data collection and status windows by choosing the name of the window 
of interest from the Window menu.

Data Collection Status Windows

To observe instrument status, choose one of the following commands from the 
Window menu. The page reference next to a window name indicates where you 
can find detailed information about that window.

• Status (refer to page 5-50)

• Electrophoresis History (refer to page 5-57)

• Log (refer to page 5-51)

Note After the run is completed, you can choose Log from the Window menu 
to display a comprehensive record of all error and status messages 
generated during the run.

Real-time Data Windows

The data displayed in the real-time data windows (the Scan window and the Gel 
window) represents light intensities collected by the data collection software from 
the filter wheel and the PMT (photomultiplier tube) in the instrument. The 
colors in the raw data windows represent the wavelengths of the dyes being 
detected, rather than the bases being detected. This is explained in Filters and Color 
of Data Display on page 5-52.
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To observe the data as it is being generated, choose one of the following from the 
Window menu:

• Scan (refer to page 5-55)

• Gel (refer to page 5-56)
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Cleaning Up After the Run

After your run is complete, perform the following general cleanup steps:

• Remove the gel from the instrument.

• Clean the plates, comb, and spacers.

Removing the Gel from the Instrument

1. Disconnect the electrode leads from both buffer chambers.

2. Unlatch the beam-stop bar and pull it forward.

3. Carefully remove the upper buffer chamber, glass plates, and heat plate 
(Leon only) as one unit. Discard the buffer. 

You can also set up a siphon system to drain the upper and lower buffer 
chambers before removing them.

4. Remove the lower buffer chamber and discard the buffer.

5. Clean up any liquid left in the electrophoresis chamber.

6. Unclamp the plates from the upper buffer chamber.

7. Rinse the buffer chambers with dH2O and allow them to air dry.

1. Disconnect the electrode leads from both buffer chambers.

2. Unlatch the beam-stop bar and pull it forward.

3. Carefully remove the upper buffer chamber and glass plates as one unit. 
Discard the buffer.

4. Remove some of the buffer from the lower buffer chamber before 
removing it.

This is especially important for 34-cm runs, as the buffer level is very high. 
You can also set up a siphon system to drain the upper and lower buffer 
chambers before removing them.

5. Remove the lower buffer chamber and discard any remaining buffer.

Classic
and

Leon

Stretch
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6. Clean up any liquid left in the electrophoresis chamber.

7. If you plan to change plate length next time, unplug the temperature 
sensor, and then remove the heat plate, otherwise leave both in place.

8. Unclamp the plates from the upper buffer chamber.

Note If the unnotched plate has been silated with a bind-silane compound, 
use 0.1 N HCl or NaOH to remove the gel from the silated area, or 
scrape it off gently.

9. Rinse the buffer chambers with dH2O and allow them to air dry.

Cleaning the Plates, Comb, and Spacers

Caution Avoid contacting the glass plates with metal. Scratches caused by 
metal objects, such as drying racks or spatulas, weaken the glass 
and reduce its usable life.

1. Gently push a plastic wedge almost all the way in at the bottom of the plates 
(avoid the top notches) and pry the plates apart. Do not use too much 
force or the plates might chip. Remove the sharks-tooth comb and gel 
spacers.

2. Lay a large Kimwipe on the gel and roll it up, lifting the gel off the plate, 
and discard appropriately. 

3. Rinse the plates with water. Rub with a gloved hand to dislodge remaining 
gel bits, then rinse again with water. 

4. Wash with a detergent such as Alconox that will not leave a residue, rinse 
with dH2O, and allow to dry. 

5. Clean the comb and spacers and store them.
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Note Do not expose combs or spacers to moisture any longer than is 
necessary to clean them. Store combs and spacers carefully to avoid 
adding blemishes. Even very small bumps or bends can ruin the combs 
and spacers.

6. Wipe any spilled buffer off the heat plate.
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Analyzing the Data

If you choose Auto Analyze for your samples in the Sequence Run window, the 
data collected on the ABI PRISM 373XL is automatically analyzed by the 
Sequencing Analysis program. For complete instructions on using the analysis 
program, refer to the ABI PRISM DNA Sequencing Analysis Software User’s Manual that 
came with the software.

Automatic data analysis occurs approximately 6.5 to 16 hours after you start data 
collection (the amount of time depends on the module you chose). The analysis 
software prints electropherograms (if you selected AutoPrint in the Sample 
Sheet) and displays the gel image on the computer screen. 

Color of Data Display and Output

The colors in the raw data windows represent the wavelengths of the dyes being 
detected, rather than the bases being detected (see Filters and Color of Data Display 
on page 5-52).

The analysis program converts the information collected by the data collection 
program so that after analysis the colors are the same for each base. The colors on 
all displays of analyzed data, including printed electropherograms, are as follows:

C = Blue A = Green G = Yellow T = Red

Note When printed and when shown against white on the screen, G is black, 
so it is easier to see.
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Reading an Electropherogram

• You can view the electropherograms in the analysis program as Raw or 
Analyzed data (data is also printed in these formats). Raw and analyzed 
data in a Sample file correspond to data/scan points collected. 

• Information from the Sample Sheet appears at the top of printed 
electropherograms. 

• The colors of the peaks and the letters above the peaks correspond to the 
appropriate bases.

• An N above a peak means that the software could not confirm the identity 
of that base. 

• In the analyzed data, the numbers above the colored peaks indicate 
analyzed base positions, counted from the first analyzed data point.
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Archiving the Data 

For best performance, keep as few files as possible on your hard disk. Do not 
archive gel files and run folders on your hard disk. It is important that you copy 
all files you want to save onto a backup medium before beginning another 
sequencing run, both to preserve the files and to free disk space.

Files Created During a Run

When you set up a run, the data collection software creates a Run folder and a Run 
file. During the run, the program automatically creates and saves two files: the Gel 
file and the Run Log file. After the run, the analysis program creates Sample and 
sequence (.Seq) files.

Run Files
Each Run file stores information associating specific samples with specific lane 
positions. It also stores information about the Sample Sheet and module 
associated with the run. Run files are small enough to store on a disk. 

Gel Files
Gel files contain the raw data acquired by the data collection program and 
typically take up 10–55MB of disk space. A separate Gel file is created in the Run 
folder each time you perform a run. Because Gel files take a substantial amount 
of space, you should delete them from your hard disk after you have obtained 
satisfactory Sample files. You do not usually need to keep gel files once the lane 
tracking is verified and sample files are created. 

Use magnetic tapes, removable cartridge drives, or optical drives to archive gel 
files. Gel files are too large to fit on floppy disks.

IMPORTANT Do not discard any gel file until you have verified the tracking and taken 
corrective action if necessary.

Run Log Files
Run logs provide a good record of your runs. Individually, Run Log files are small 
enough to archive on floppy disks. 
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Sample files
Use disks, a magnetic tape drive, a removable cartridge drive, or an optical drive 
to archive sample files. A 1.4 MB, high-density disk holds about six files. A Sample 
file is 150–200KB in size, depending on the length of the sequencing run; 
however, Sample files for 388 runs are twice as large. Save a Sample file when you 
feel confident that the channel selections (tracking) are correct for the sample.

.Seq files

.Seq files show the base letter sequence only (or might contain a header, 
depending on the format you choose). You can open .Seq files from word 
processing programs and print them. The Preferences dialog box in the 
Sequencing analysis program allows you to choose the file format before analysis.

Other Files

Other files provide information for a run that you might have customized and 
should therefore save. These include the Sample Sheet, analysis settings, or matrix 
files you create.

Sample Sheet Files
You can reuse the Sample Sheet, and it is a good reference after data collection. 
Individually, Sample Sheet files are small enough to archive on disks.

Custom Analysis Settings and Instrument Files
If you have created customized files, you should keep backup copies of the files on 
a separate medium. Each of these types of files alone is small enough to store on 
a disk.
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Figure 4-1.  Flow chart for electrophoresing/collecting data on ABI PRISM 373 DNA 
Sequencer with XL Upgrade
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Introduction

This section guides you through the process of electrophoresing your DNA 
samples and collecting the resulting GeneScan data on the ABI PRISM 373XL 
DNA Sequencer. Figure 4-1 shows the recommended flow of the process. 

Although this section is detailed, it does not provide complete details for each 
procedure. Use it as a guide and refer, as necessary, to the cross-referenced pages 
for more detail.

Note If you have previous experience using the Model 373, you should read 
through these steps. Data collection software has been streamlined. 
You no longer need to enter any commands on the instrument itself.

The information in this section applies to GeneScan applications. Instrument 
setup consists of similar steps for both Sequencing and GeneScan applications. 
The main differences are in completing the Sample Sheet and the Run file. 

For further information about the analysis performed for each application, refer 
to the GeneScan Analysis software manual.

To read details about the data collection software and the instrument hardware 
refer to Sections 5, 6, and 7. 
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Before You Set Up the Instrument

Preparing Samples

Make sure you have prepared your samples as described in the GeneScan 672 User’s 
Manual, or in the appropriate kit protocol. Before you set up your instrument, 
perform the following procedures: 

• Purify and quantitate DNA samples.

• Label DNA fragments with fluorescent dyes.

• Prepare the appropriate gel.

Experimental Design Considerations

Fluorescent labeling enables you to analyze many independent fragments in the 
same lane using either color or fragment length to distinguish between fragments.

Some factors to consider when you design your experiments are:

• Working with overlapping allele size ranges

• Multiplexing the Polymerase Chain Reaction (PCR)

• Optimizing salt concentrations

• Sizing and quantifying sample fragments
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Working with Overlapping Allele Size Ranges
If the expected size ranges of PCR products from different primer pairs overlap, 
you can do one of the following to differentiate between them:

• Label primer pairs with different dye colors

• Choose new primer sites to alter PCR product fragment lengths

• Load overlapping products in different gel lanes

For more information on labeling techniques, see the GeneScan 672 Software User’s 
Manual.

Multiplexing the Polymerase Chain Reaction
You can multiplex the Polymerase Chain Reaction (PCR) by adding more than 
one pair of primers into the same reaction tube, and then performing the PCR. If 
you multiplex, you should first check primers for compatibility considerations, 
such as excessive regions of complementarity, or similar melting temperatures.

Once you have chosen compatible primer pairs, you should then test the pairs for 
successful co-amplification. Multiplexing often requires that you optimize 
reaction conditions, and sometimes requires that you redesign primers. For more 
information, refer to Appendix E, Optimizing PCR.

Optimizing Salt Concentrations
Multiplexing by co-loading several PCR products in a single lane improves 
throughput, but can also increase the salt concentration in your samples. High salt 
concentration in your samples can inhibit complete denaturation of 
double-stranded DNA. As a result, the ABI PRISM 373 DNA Sequencer with XL 
Upgrade detects less DNA, weakening the signal. To prevent high salt 
concentrations from negatively impacting your run, make sure you use at least 
equal volumes of formamide and PCR solution in each of your samples.

To increase the signal intensity, do one of the following:

• Combine the samples, precipitate the product, and resuspend the samples 

• Use a spin column

• Add 1 or 2 extra PCR cycles in your protocol to produce more product per 
µL of PCR reaction

Merely evaporating your samples increases the concentration of salt, which makes 
it more difficult to denature the DNA in subsequent steps.
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Multiplexing Samples in a Single Lane
In addition to multiplexing the PCR, you can multiplex samples on the ABI PRISM 
373 DNA Sequencer with XL Upgrade by performing multiple PCRs in separate 
reaction tubes, pooling the PCR products together, and co-loading multiple 
samples in a single lane of the gel.

If you multiplex samples, consider the following when designing your 
experiment:

• Use different colored ABI PRISM dyes for labeling each sample you co-load 
in a single lane, if they overlap in size.

• Because each dye has a different absorption maximum, the intensity of 
fluorescent signal emitted differs for each dye:

When labeling fragments, use a greater concentration of dye for dyes of lower 
intensity. For example, you would need to use approximately eight times as much 
ROX dye as 6-FAM or TET dye to generate signals of equal intensity. Also, when 
choosing combinations of dyes for sample labeling, choose dyes that can be 
detected by the same filter set: A or B. 

Sizing and Quantifying Sample Fragments
When preparing samples, consider how choice of dye labels and size standard 
affects analysis of fragment size and quantity. For the same study, use the same size 
standard and dye label for all samples.

When analyzing your results, compare only peak heights, peak sizes, or peak areas 
of fragments labeled with the same dye label. For example, compare HEX-labeled 
fragments only to other HEX-labeled fragments.

Filter Set A Filter Set B
ROX (lowest signal intensity) TAMRA (lowest signal intensity)
TAMRA HEX
JOE TET
5-FAM (highest signal intensity) 6-FAM (highest signal intensity)
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Setting Up the Software

While the gel is polymerizing, you can set up the Sample Sheet and the Run file 
for the data collection software. Refer to Setting Up the Software on page 4-19.

If you are running GeneScan applications or wish to use custom analysis settings, 
you should also set up the conditions that control data analysis before you start a 
run. To do so, refer to the user’s manual provided with your GeneScan analysis 
software.

IMPORTANT If you choose automatic analysis and want the GeneScan Analysis 
software to use settings other than the default, customize the analysis 
settings before you start data collection.

If you specify automatic analysis in the data collection program, the GeneScan 
Analysis program starts automatically at the end of the run to process the collected 
data. 



Applied Biosystems

March 2001 4  Using the Instrument in GeneScan Mode 4-9

Setting Up the Instrument

Pour your gel as described in Section 2, and allow it to polymerize for two hours 
before proceeding with this section. 

IMPORTANT Make sure to use the appropriate gel concentration for the gel length 
and run type. 

Preparing the Gel for Loading

Note Wear clean laboratory gloves throughout this procedure, both for your 
protection and to avoid transferring fluorescent contaminants from your 
hands to the glass plates. 

Reagents and Supplies Needed For Preparing the Glass Plates
• A single-edged razor blade or a second casting comb

• 1.5-L, 1X Tris Borate EDTA buffer (2 L for 34-cm gels), pH 8.3 (refer to 
10X TBE Stock Solution on page 2-10)

• A clean, 10–50 mL syringe and a 22 G needle
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To clean the plates:

1. Remove the clamps on the gel casting (single-well) comb or square-tooth 
comb, and the tape from the edges of the plates.

2. Rinse the glass plates with cold water. 

a. Rinse rinse both sides and edges of the glass plates thoroughly with 
cold tap water to remove dried acrylamide and urea. 

b. Rinse the well and plates with dH20 and allow the plates to air dry.

To remove the square-tooth comb:

1. Before you remove the square-tooth comb (Figure 4-2), lay the appropriate 
plastic overlay strip on the clean glass. Align the well outlines on the overlay 
strip with the white teeth of the comb.

Figure 4-2.  Square-tooth comb

2. Carefully lift the edge of the square-tooth comb. 

To avoid suction, pry gently with a razor blade or plastic wedge, or squirt 
deionized water over and around the comb.

3. Using both hands, apply gentle, even pressure and slowly pull out the 
comb.

4. Clean the comb area with deionized water and Kimwipes.

Note If you are using the Sharks-tooth comb: refer to To prepare the plates 
for loading on the instrument: on page 3-7 for removing the casting 
comb; refer to Inserting the Sharks-tooth Comb on page 3-34.
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Preparing the Electrophoresis Chamber

WARNING ELECTRICAL SHOCK HAZARD. The Model 373 contains a high 
voltage power supply. This instrument has been designed with 
safety features in the door to disconnect the power supply when 
the door is open. Although it is designed for safe operation, please 
follow procedures as prescribed. As with any electrophoresis 
apparatus, care should be taken during instrument operation and 
when handling electrodes and liquids.

WARNING ELECTRICAL SHOCK HAZARD. Wait at least 5 seconds after 
opening the door before touching the electrodes in the 
electrophoresis chamber. Capacitors hold an electrical charge 
even after the power supply is disconnected.

Model-Specific Notation
This manual applies to three configurations of Model 373 DNA Sequencers: 
Classic, Leon, and Stretch.

• Classic. This configuration includes 370s with Macintosh upgrade and the 
373A. Classic models have electrophoresis chambers which support 24-cm 
WTR distances.

• Leon. This configuration has an electrophoresis chamber which supports 
6-, 12-, and 24-cm WTR distances.

• Stretch. This configuration supports 6-, 12-, 24-, 34-, and 48-cm WTR 
distances and is easily identified by its extended door. 

Note All three instrument configurations must have the five-filter wheel 
capability.

Most of the information in this manual applies to all three configurations, 
however, some sections of the manual apply to only one or two of these 
configurations. Those sections are preceded by the name of the configuration 
(Classic, Leon, or Stretch) to which they apply.
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To prepare the electrophoresis chamber:

1. Open the door to the Model 373 and make sure the heating plate is dry.

2. Place the lower buffer chamber in the bottom of the electrophoresis 
chamber with the electrode to the front. The upper chamber will not be 
needed until later.

Figure 4-3.  Placement of the Buffer Chambers, glass plates, and beam-stop 
bar in the electrophoresis chamber of the Model 373 (Classic)

3. Pull the black beam-stop bar in the electrophoresis chamber toward you 
until it stops (Figure 4-3). Rest the bottom edge of the plates on the 
notched supports in the bottom of the lower buffer chamber, with the 
notched plate facing away from you. Stand the plates in a vertical position. 
Press them firmly against the heating plate, and then push the beam-stop 
bar up against the plates. Center the plates in relation to the beam-stop bar, 
and then lock the beam stop bar in place by sliding the latches down along 
the outer edges.

IMPORTANT It is very important to center the plates. Centering the plates ensures 
that each sample migrates within the read region of the laser.

Classic

Upper buffer chamber

Model 373A, 
side view

Glass plates

Beam-stop bar

Lower buffer 
chamber
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Note The beam-stop bar is removable. In normal operation you should not 
need to remove it. To install the beam-stop bar if it is removed, line up 
the alignment pins in the alignment grooves and slide the beam-stop 
bar into place.

1. Open the door to the Model 373.

Figure 4-4.  Model 373 (Leon) Electrophoresis Chamber

Leon

Upper buffer chamber 
support

Beam-stop 
swivel clamps

Glass plate support

Lower buffer chamber

Beam-stop bar

24 cm

6 cm

12 cm
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2. Place the lower buffer chamber in the bottom of the electrophoresis 
chamber with the electrode to the front. The upper chamber will not be 
needed until later.

3. Adjust the upper buffer chamber supports to accommodate the different 
plate lengths (6, 12, and 24 cm) (refer to Figure 4-4 on page 4-13. Loosen 
the screws and slide the brackets to the correct position as indicated by the 
well-to-read length printed on the supports, and then tighten the screws.

4. Place the glass plates into the instrument as follows:

a. Pull the black beam-stop bar in the electrophoresis chamber towards 
you until it stops (Figure 4-4 on page 4-13). 

b. Rest the bottom edge of the plates on the notched supports in the 
bottom of the lower buffer chamber, with the notched plate facing 
away from you. 

c. Stand the plates up in the vertical position. Press them firmly against 
the back of the chamber (avoid touching the laser read region, and 
then push the beam-stop bar up against the plates. 

d. Center the plates with relation to the beam-stop bar and then latch 
the bar in place.
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1. Open the door to the Model 373. The electrophoresis chamber looks like 
the one shown in Figure 4-5.

Figure 4-5.  Model 373 (Stretch) Electrophoresis Chamber

2. If you are running a 24- or 34-cm gel, place the white plastic upper buffer 
chamber shelf on the appropriate support on the inside of the 
electrophoresis chamber (see Figure 4-5).

If you are running a 12-cm gel, place two white plastic upper buffer 
chamber shelves on the support.

Stretch

Lower buffer chamber

Upper buffer chamber 
supports and shelf

Beam-stop bar

6-cm W
TR

12-cm WTR

24-cm WTR

34-cm WTR

Gel plate rests 
(ABS blocks)
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If you are running a 6-cm gel, then no shelves are required.

3. For 34- and 24-cm gels, slide the heat plate into place, as follows:

a. Choose the correct heat plate for the glass plates you are using.

b. Make sure the electrical wires for the temperature sensor are at the 
top, with the plate clamps toward the front. Align the grooves on 
either side of the heat plate with the heat plate guides on the 
chamber.

c. Slide the heat plate down until it rests on the bottom of the chamber.

d. Plug the temperature sensor on the heat plate into the socket at the 
top left of the chamber.

e. Plug the heat plate ground into the socket at the top right of the 
chamber.

For 6 and 12 cm WTR gels, use the temperature sensor alignment brace.

IMPORTANT Make sure the heat plate ground is connected before continuing.

4. Adjust the gel plate rests in the lower buffer chamber, if necessary (see 
Figure 4-6). The gel plates rests are located in the bottom of the buffer 
chamber and serve to elevate the glass plates. In order for the 34 cm plates 
to rest in the correct position, they must sit higher in the buffer chamber. 
All other plates rest in the lower position.

Each gel plate rest consists of several parts, a large ABS block on the 
bottom, a shorter ABS block on top of it, and an adjustable thumb screw. 
When the thumb screw is loose, the small block can be moved forward and 
back, so that the plates rest either on one block, or on two blocks (see 
Figure 4-6). 

a. Loosen the thumb screws.

b. Slide the blocks toward the back of the chamber if you are using 
34 cm plates, so the plates rest in the high position. Slide the blocks 
toward the front of the chamber for all other gel lengths so the plates 
rest in the low position.
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c. Tighten the thumb screws.

Figure 4-6.  Adjustable gel plate rests

5. Place the lower buffer chamber in the bottom of the electrophoresis 
chamber with the electrode to the front. The upper chamber will not be 
needed until later.

6. Unfasten the latches on either side of the beam-stop bar and swing the 
beam-stop bar forward, toward you.

7. Place the glass plates in the electrophoresis chamber in front of the heat 
plate and read window, with the bottom of the plates resting on the gel 
plate rests. 

Glass Plates rest here

Thumb Screw

Thumb Screw

a. For all run lengths except 34 cm. With 
the movable blocks toward the front of the 
electrophoresis chamber, the glass plates 
rest lower in the buffer chamber. 

b. For 34 cm runs only. With the movable 
blocks toward the back of the 
electrophoresis chamber, the glass plates 
rest higher in the buffer chamber. 

Front of electrophoresis chamber

Front of electrophoresis chamber
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a. Center the glass plates carefully, or the beam-stop bar will not fasten.

b. Press the glass plates against the heat plate and close the beam-stop 
bar.

c. Fasten the latches at either side of the beam-stop bar.

IMPORTANT Do not touch the gel plates within the read region.
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Setting Up the Software 

Before starting electrophoresis, you must ensure there is sufficient space on your 
hard disk and restart the Macintosh. If you delete files, you must restart the 
Macintosh. You must also set up certain files in the data collection software:

• Set preferences

• Record sample information in the GeneScan Sample Sheet

• Create a GeneScan Run file

Note These tasks are best performed while you are waiting for the gel to 
polymerize.

You can simplify creation of the files by setting preferences for certain parameters 
in each file. 

The procedures described here do not include detailed descriptions of the data 
collection software. They are intended to give you a guide for steps you perform 
and the order in which to perform them. For specific information about the 
software and how to complete specific fields, refer to Section 5. 

You may not need to change these default parameters for future runs, if you always 
run the same or similar parameters. However, it is important to verify these 
defaults, since they determine the names and locations of your data.

If you desire more detail, the steps described here refer you to the specific pages 
in Section 5 where you can find related information.

Setting up the Analysis Software

If you are running GeneScan applications or wish to use custom analysis settings, 
you should set up the conditions that control data analysis before you start a run. 
To do so, refer to the User’s Manual provided with your GeneScan analysis 
software.
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Starting the Data Collection Software

1. Choose Restart from the Special menu in the Finder to restart your 
Macintosh.

2. The data collection software should automatically open upon restarting 
the Macintosh. If it does not open, double-click the icon to open the 
program. Refer to To make the data collection program open at startup: on page 
5-13 for instructions to open the collection program at startup.

Note When you start the ABI PRISM 373 DNA Sequencer with XL Upgrade 
data collection program, the program searches for the current version 
of firmware on the Translation Interface Processor (TIP). If none is 
found, the program automatically copies the firmware image file (stored 
on the Macintosh) to the TIP. If the TIP’s version of firmware is different 
from the collection software version, a dialog box appears, allowing you 
to continue or send a new firmware to the TIP. Click Send New 
Firmware to update your firmware version.

Creating User-Specific Module Files

The ABI PRISM 373 DNA Sequencer with XL Upgrade DNA Sequencer upgrade is 
shipped with module file templates for plate check, prerun, sequencing and 
GeneScan runs. Table 4-1 shows the default parameters for the modules file 
templates.

IMPORTANT The parameters in Table 4-1 apply only to 24-cm WTR Classic or Leon 
denaturing 6% acrylamide gels. You must make appropriate modules 
for all other, i.e., 6-, 12-, and 34-cm plate lengths and for native 
applications.

Table 4-1.   Module File Default Parameters

Module
Field

(Volts)
Power
(Watts)

Current
(mAmps)

Laser Power
(mWatts)

Run Time
(Hours)

Plate Check -- -- -- 40 0.50
Pre Run 2500 30 40 40 0.33
Seq Run 2500 30 40 40 12
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You must create user-specific module files the first time the instrument is used and 
for each different run condition. Once you modify a module file template, you 
can save it and use it each time a similar run is performed. Refer to Table 1-3 on 
page 1-15 and Appendix B for suggested module file and Run parameters. 

To modify a module file:

1. Choose New from the File menu.

2. Click the Sequence Run or GeneScan icon in the window that appears.

3. Choose the module file you wish to modify from the Run Module pop-up 
menu.

Note You do not need to complete the other information in the Run window 
to modify a module file.

4. Click the small document icon next to the Run module pop-up menu.

Figure 4-7.  Module settings dialog box

5. Type new number in the applicable entry fields. Refer to Table 1-2 on page 
1-14 for recommended run parameters.

6. Save the changes.

GS Run 2500 30 40 40 12

Module
Field

(Volts)
Power
(Watts)

Current
(mAmps)

Laser Power
(mWatts)

Run Time
(Hours)



Applied Biosystems

4-22 4  Using the Instrument in GeneScan Mode March 2001

• Save as Default: To save the changed parameters as defaults for the 
module without changing the module name, click Save as Default. The 
new settings are permanently saved and the name of the module file 
remains unchanged.

• Save Copy in…: To save the changed parameters as defaults, click Save 
Copy in. Type in a new name for the module file and save the file in the 
Modules Folder. The new settings are permanently saved and the name 
of the module file is changed.

Note You will not be able to select your new module file in the pop-up menu 
until you save and close the Run window, then reopen the saved Run 
file or create a new Run file. 

• Save: To use the changes as a one-time override for the current run, 
click Save.

Note Custom module files are stored on your hard disk. and can be used for 
any subsequent run. If you reload your collection software, however, 
you must re-create your custom modules.

Setting Default Parameters (Preferences)

You might only need to set default parameters prior to the first run. If you are 
satisfied with the defaults stored in the instrument, skip to page 4-24 to create a 
Sample Sheet and a Run file. However, if more than one person uses the same 
instrument, we recommend you set or verify all preferences prior to starting a run.

You can set several types of preferred defaults:

• Folder locations: The ABI PRISM 373XL data collection software uses 
specified folders for data storage. This option allows you to change the 
folders it uses. For information about changing folder locations, refer to To 
change one of the data storage folders: on page 5-17.

• Default File names: The data collection program automatically names new 
files and folders created during a run. You can specify the prefix and suffix 
of each type of file (see Setting File Name Preferences on page 5-18).
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• GeneScan Sample Sheet defaults: You can set defaults for certain parameters 
on the Sample Sheet. Since the Sample Sheets differ for Sequence Analysis 
and GeneScan (fragment) Analysis, the parameters for which you can set 
defaults also differ somewhat. To set defaults for the GeneScan Sample 
Sheet, refer to To set Sample Sheet defaults for GeneScan analysis applications: on 
page 5-25.

• GeneScan Run defaults: You can also set defaults for certain parameters in 
the Run file. As with the Sample Sheet defaults, separate defaults apply for 
sequence runs and GeneScan analysis runs. To set defaults for sequence 
Run files, refer to Setting Defaults for GeneScan Analysis Applications on page 
5-25.

• General settings: The ABI PRISM 373XL instrument is normally attached to 
the Modem port of the Macintosh computer. If you need to change the 
connection, you can specify the change using this preference choice. Also 
use this choice to reset the global serial number, which is a number used 
by the file naming defaults (refer to General Settings on page 5-27). To 
change general settings, refer to To change the general settings: on page 5-28.

• Dye indicators: Each of the four dyes used during a run has a preset code and 
color. You can change the color assigned to each dye, and change the color 
that appears in the plot when it is printed. To do so, refer to To set dye 
indicator preferences for the analysis applications: on page 5-29.

To set preferences:

1. Choose Preferences from the Window menu and choose the appropriate 
option from the submenu that appears.
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Figure 4-8.  Preferences submenu

2. Enter or change the defaults, as described on the pages noted above.

3. Click OK to accept the changes.

Creating the GeneScan Sample Sheet

Before starting a run you must record sample information in the GeneScan 
Sample Sheet and the Run file. Once you have set up the Sample Sheet, you can 
automatically copy sample information into the Run file, which associates sample 
information (name and type of analysis) with each lane position in the gel.

Separate Sample Sheets exist for sequencing and GeneScan analysis applications 
(see Figure 4-9). Be sure to choose the correct type for your application.

If a Sample Sheet containing the correct information already exists, you can use 
it. In most cases, you need to create a new Sample Sheet for each run. You can 
enter the information directly or export information from a database in 
tab-delimited format and import it into the Sample Sheet. 

To create a GeneScan Sample sheet:

1. Choose New (z-N) from the File menu.

2. Click the GeneScan Sample Sheet icon in the window that appears.

The Sample Sheet is similar to a spreadsheet or ledger. It accepts more text 
than fits in the visible fields and automatically scrolls as you type your entry. 
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To view the beginning of a long entry, use the keyboard arrow keys. Many 
of the cells have default values that are automatically filled in for each 
sample.

3. Enter the necessary information. For details about completing the Sample 
Sheets (including information about importing from a database), refer to 
Creating and Editing a Sample Sheet on page 5-32.

IMPORTANT Although the Sample Sheet has 72 lanes available, fill in the sample 
information only for the number of lanes you are using.

IMPORTANT Do not mix sequence analysis and GeneScan analysis samples on the 
same Sample Sheet or the same run.

4. When you are finished, choose Save from the File menu.

The dialog box that appears shows the default file name and storage 
location as defined in the File Names and Folders locations preferences, 
respectively. You can change the file name if you wish.

5. Click Save. 

Make sure you are saving the file into the Sample Sheet folder, so the name 
will appear in the pop-up menu.
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6. Choose Close from the File menu, or click the close box.

Figure 4-9.  Blank GeneScan Sample Sheet 

Creating a Run File

In the Run file you specify the lanes in which the samples will run and parameters 
to be used for both the pre-run and the run. If a Run file exists that contains the 
proper parameters, you can copy it to a new folder and use it. In most cases you 
need to create a Run file for each new run.

Separate Run windows exist for sequencing and GeneScan analysis applications. 
They look almost the same; the GeneScan analysis version has an additional 
(Analysis Settings) column. Be sure to choose the correct type for your 
application.

Enter sample information and 
additional comments

Specify sample names 
for each color

Specify size 
standard color
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To create a Run file:

1. Choose New from the File menu.

2. Click the GeneScan Run icon in the window that appears.

Figure 4-10.  GeneScan Run window

3. Choose the parameters for the run from the pop-up menus.

Note Any changes you make in your preferences setting will not take effect 
until you open a new Run window.

a. Choose modules to be used for the plate check, the pre-run and the 
run in the Module pop-up menus. 

Run control 
buttons

Pop-up menus in 
these panels allow 
you to choose the 
modules 
(parameters), the 
associated 
Sample Sheet, the 
number of wells, 
the separation 
distance (WTR), 
and the matrix for 
the run

Small document icons open the selected 
*module or Sample Sheet for review

Lane numbers cannot be edited

Specify length of run
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b. Choose the Sample Sheet from the Sample Sheet pop-up menu.

When you choose the Sample Sheet, the information about the lanes 
in which the samples are to run fills in automatically. 

c. Choose the number of lanes and the separation distance from the 
Lanes pop-up menu and the WTR pop-up menu, respectively.

d. Choose XL Scan or Full Scan in the Run Mode pop-up menu. Use the 
table below to determine the appropriate run mode for your lane 
configuration. 

Note If you select a run mode that is incompatible with the selected lane 
configuration, the lane popup menu displays <none>.

e. Choose a matrix file from the Gel Matrix pop-up menu.

4. Enter the length of the run in the Collect Time entry field. 

Refer to Application Protocols in Appendix C of the 672 User’s Manual for 
collection times.

5. Enter your name in the Operator entry field.

The sample information for each lane is entered automatically in the grid 
at the bottom of the Run window when you choose a Sample Sheet. 

Lanes Comb Run Mode
24 Sharks-tooth Full Scan
24 Square-tooth Full Scan
32 Sharks-tooth Full Scan
34 Square-tooth Full Scan
36 Sharks-tooth Full Scan
36 Square-tooth Full Scan
48 Sharks-tooth XL Scan
50 Square-tooth XL Scan
64 Sharks-tooth XL Scan
66 Square-tooth XL Scan
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Note You cannot edit the Sample Sheet information in the Run window. 
Make any changes in the Sample Sheet, save it, select <none>, and 
then select the Sample Sheet again in the Run window to make the 
changes effective.

6. Choose the appropriate filter set: A or B.

IMPORTANT Failure to select the appropriate filter set results in the loss of data.

7. Select the Auto Analyze and Auto Print checkboxes if you want the analysis 
program to analyze and send data to the printer.

When you finish completing the information in the Run file, do not close the Run 
file window. You can use it to perform a plate check, as described next.

The options available to you at this time are:

• Save the file for future use, then click the close box to close it.

• Start a plate check by clicking the Plate Check button.

To save the file, choose Save from the File menu. To perform a plate check, see 
page 4-30.

For more information about creating the Run file, refer to page 5-40. 
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Checking the Plates

Scan the gel and plates before adding buffer and loading samples, to ensure that 
no peaks are produced by fluorescent particles on the glass plates or in the gel.

Figure 4-11.  Completed GeneScan Run window

To check the plates:

Note For 6-cm and 12-cm runs on Stretch-configured instruments, the 
temperature sensor alignment brace must be connected before runing 
the plate check.

1. Click Plate Check in the Run window.

Note If a dialog box appears indicating you do not have enough room on your 
hard disk to save the files created by a run, delete files (particularly Gel 
files) to create enough space, making sure to back them up on a disk 
or other storage device first, then click Plate Check again.

Click Plate Check after you choose the Plate 
Check module
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The laser scans the plates without electrophoresis to detect any unwanted 
fluorescent material in the read region.

2. Observe the Scan window that appears.

The Scan window should show a relatively flat line across the screen in each 
of the four colors. Typically, the lowest line is blue, followed by the green, 
yellow (black), and red lines. If the scan line is flat, then the plates are 
clean. Proceed to Checking the PMT Gain Setting on page 4-32.

If you see peaks in the Scan window, clean the glass plates again, as 
described below. 

WARNING LASER HAZARD. Do not look directly into the laser beam or allow 
a reflection of the beam to enter your eyes. Exposure to direct or 
reflected laser light at 40 mW for 0.1 seconds can burn the retina 
of the eye and leave a permanent blind spot. 

Cleaning the Plates or Skipping Lanes
Peaks in the scan lines could indicate dirt on the glass or contaminating 
fluorescence in the gel. To eliminate dirt on the glass, clean the plates and scan 
them again. If peaks still appear and you wish to use the gel, avoid loading samples 
in the lanes where the peaks appear.

To clean the plates and re-scan:

1. Click Pause to pause the plate check.

2. Open the door of the instrument and unlatch the beam stop bar and 
remove the plates.

3. Carefully reclean both sides of the glass in the laser read region with dH2O 
and a lint-free tissue or ultra-pure pressurized air.

4. Replace the plates, center them, and latch the beam stop bar in the 
electrophoresis chamber.

5. Click Resume and check the plates again.
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If the peaks do not disappear after cleaning the glass, the gel mixture or buffer 
might contain particles. If you wish to use the gel, avoid loading samples in the 
lanes where the peaks appear.

Note Occasionally, peaks in the scan window are caused by a dirty beam 
stop bar, rather than by dust or particulates in the gel. Clean the beam 
stop bar with dH2O and (optionally) a thin layer of oil, if the peaks do not 

disappear after cleaning the glass.

Skipping Lanes
If a plate check shows peaks in some lanes of a gel even after cleaning, the Scan 
window indicates which channels have contaminating fluorescence in them. Refer 
to Table 3-2 on page 3-29 as a guide for estimating the channel number/lane 
assignment correlations. This table should be used only as an approximation, as it 
determines the center of each lane for sharks-tooth comb configurations and may 
differ slightly for square-tooth combs.

If the contaminant peaks are close to the edge of a lane, you may want to skip two 
lanes to ensure that there is no contamination in the lanes you load.

Checking the PMT Gain Setting

Verify Run Mode
The PMT gain setting differs for each of the run modes (XL Scan and Full Scan). 
Verify that you have selected the correct run mode in the Run window before 
checking the PMT gain setting.

First Time Run
The PMT gain settings are stored in a Calibration file. If this is the first time the 
instrument is being used, you must make and send a Calibration file. Refer to 
Section 5 for instructions on how to make and send a Calibration file.
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Recommended PMT Gain

The photomultiplier (PMT) gain should be set such that the lowest scan line 
(usually the blue line) is positioned at approximately 900 on the y-axis in the Scan 
window. For subsequent runs, the PMT gain will need to be adjusted only if the 
y-axis value is out of the range of 800–1000 on the y-axis. Different PMT gains are 
required for the three run modes (XL Scan, Full Scan, and BaseSprinter).

To check the PMT gain:

1. While the Plate Check is running, view the four base lines (each line 
represents one of the four filters) in the Scan window of the 373XL 
collection program.

2. Position the cursor so the tip of the arrow just touches a flat section of the 
lowest scan line (usually the blue line), as in Figure 4-12.

Figure 4-12.  Cursor positioned correctly to measure PMT gain

3. Read the y-axis value displayed in the upper-left hand corner of the scan 
window.

• If the lowest scan line is positioned between 800–1000 on the y-axis, 
cancel the Plate Check, and then proceed to Inserting the Sharks-tooth 
Comb on page 4-34.

Read y-axis here



Applied Biosystems

4-34 4  Using the Instrument in GeneScan Mode March 2001

• If the lowest scan line is outside the recommended range, adjust the 
PMT gain.

To adjust the PMT gain:

1. While the Plate Check is running, choose Manual Control from the 
Window menu.

2. Adjust the size and position of the Scan and Manual Control windows so 
you can see both windows without any overlap.

3. In the Manual Control window, choose PMT Gain from the Fxn Name 
pop-up menu.

4. Type a new value, then click Execute.

Note If you enter a larger number than the one displayed, the lines in the 
Scan window will shift up; a smaller number causes them to shift down.

5. Check the y-axis value in the Scan window. (First click on the Scan window 
to make it active.)

6. Repeat steps 3–5 until the PMT gain is within the recommended range.

7. Close the Manual Control window.

8. Cancel the Plate Check in the Run window.

Note After selecting a different run mode, you must change the PMT gain.

Inserting the Sharks-tooth Comb

Note If you are using a square-tooth comb, skip this section and proceed to 
Completing Instrument Setup on page 4-36.

To insert the sharks-tooth comb:

1. Insert the sharks-tooth comb (see Figure 4-13).

a. Center the sharks-tooth comb in the glass notch and carefully slide it 
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between the glass plates. Make sure all of the points on the comb 
enter the space between the plates at the same time, to avoid bending 
or breaking the teeth. Carefully align the center registration line with 
the registration mark on the plates.

b. Slide the comb down until the tips of all the teeth just touch or slightly 
depress the surface of the gel. Do not deform the wells. Make sure the 
teeth just barely indent the well surface. All of the teeth must touch 
the surface of the gel. If the surface of the gel is not completely flat in 
the loading region, some of the teeth may have to be inserted below 
the surface of the gel (up to 0.5 mm), so all of the teeth touch the gel 
surface. If a tooth has penetrated the gel surface, do not attempt to 
withdraw the comb, or sample will leak into adjacent wells.

Figure 4-13.  Sharks-tooth comb just touching the gel
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Completing Instrument Setup

After completing Plate Check, do the following:

1. If you are using a square-tooth comb, attach the D-clamps to the upper buffer 
chamber, if they are not already attached.

a. Remove the screws at either side of the upper buffer chamber.

b. Place D-clamps so that the screw holes are aligned.

c. Insert the screws and turn them a few times.

2. Place the upper buffer chamber at the top of the gel plates by placing it on 
the upper shelf (Figure 4-3 on page 4-12) and sliding the front brackets of 
the chamber over the glass plates. The brackets should sit over the spacers 
on the outside edges of the plate.

3. For square-tooth comb runs, clamp the glass plates to the upper buffer 
chamber by placing the D-clamp against the front of the glass plates and 
inside the brackets of the buffer chamber.

The brace is not used for square-tooth comb runs.

4. For sharks-tooth runs, put the alignment brace in place against the front of 
the glass plates, inside the brackets of the buffer chamber, and resting on 
top of the heat plate. 

The alignment brace is made of highly polished acrylic so the numbers and 
the comb are readily visible through the plastic. Do not mark the 
alignment brace with felt-tipped pens, as the use of most organic solvents 
to remove the ink will dull the surface of the brace and reduce its clarity. 
Some ink may also fluoresce. 

5. Tighten the screws on the buffer chamber equally on both sides to 
maintain even pressure across the D-clamp or alignment brace. Turn the 
screws until you see the gasket compress completely against the glass. 
Finger-tighten only—do not overtighten. You may need to apply light 
pressure on the top of the brace to prevent it from moving during 
tightening.

Note The D-clamps are used in place of the alignment brace to prevent 
deformation of the wells formed by the acrylamide square teeth.

Classic
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6. Fill the upper buffer chamber with the 1X TBE buffer prepared earlier to 
at least half-way up the notched part of the plate (~ 1.3 cm). Check for 
leaks. Close the lid of the buffer chamber.

Note If there is a leak, tighten the brackets slightly. If the leak continues, 
siphon the upper buffer, then clean the gasket area on the chamber and 
the area of the plate that contacts the gasket. Reassemble as before.

7. Carefully fill the lower buffer chamber with 1X TBE buffer to about 
two-thirds full. 

Note Avoid splashing buffer against the back of the chamber since it will spill 
over into the liner. Remove any bubbles that are under the bottom edge 
of the gel plates using a clean needle and syringe. Bend the needle at 
an angle to guide the bubbles out.

8. Attach the top and bottom electrode leads located on the left side of the 
electrophoresis chamber and close the door gently.

1. If you are using a square-tooth comb, attach the D-clamps to the upper buffer 
chamber, if they are not already attached.

a. Remove the screws at either side of the upper buffer chamber.

b. Place D-clamps so that the screw holes are aligned.

c. Insert the screws and turn them a few times.

2. For 24-cm runs only, slide the heat plate into place against the glass plates, as 
follows (see Figure 4-4 on page 4-13):

a. Rest the lower edge of the heat plate (the edge with the supports 
protruding on both sides) on the upper inside ledge of the beam-stop 
bar where it meets the glass plate. The supports rest in the notches.

b. Stand the heat plate vertically against the glass plates.

c. Secure the beam-stop swivel clamps.

Leon
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3. Place the upper buffer chamber at the top of the gel plates, on the 
supports. Slide the clamps over the plates.

4. For square-tooth comb runs, clamp the glass plates to the upper buffer 
chamber by placing the D-clamps against the front of the glass plates and 
inside the brackets of the buffer chamber.

The brace is not used for square-tooth comb runs.

5. For sharks-tooth runs, put the alignment brace in place against the front of 
the glass plates, inside the brackets of the buffer chamber, and resting on 
top of the heat plate. 

The alignment brace is made of highly polished acrylic so the numbers and 
the comb are readily visible through the plastic. Do not mark the 
alignment brace with felt-tipped pens, as the use of most organic solvents 
to remove the ink will dull the surface of the brace and reduce its clarity. 
Some ink may also fluoresce. 

Note To use the D-clamps with 24-cm WTR, you must omit the heat plate.

6. Tighten the screws on both ends of the upper buffer chamber equally to 
maintain even pressure across the alignment brace or D-clamps. Turn the 
screws just until you see the gasket compress completely against the 
glass—do not overtighten.

Note The D-clamps are used in place of the alignment brace to prevent 
deformation of the wells formed by the acrylamide square teeth.

7. Fill the upper buffer chamber with the 1X TBE buffer prepared earlier to 
at least 2/3 up the notched part of the plate (greater than 1.3 cm). Check 
for leaks. Close the lid of the buffer chamber.

If there is a leak, slightly tighten the brackets. If the leak continues, siphon 
the buffer out of the upper buffer chamber and clean the gasket area on 
the chamber. Also, clean the area of the plate that contacts the gasket. 
Reassemble as before.

8. Carefully fill the lower buffer chamber with 1X TBE buffer to about 
two-thirds full. Avoid splashing buffer against the back of the chamber 
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because it will spill over into the liner. Bubbles should be removed if they 
are under the bottom edge of the gel plates. This can be done with a clean 
needle and syringe, with the needle bent at an angle to guide the bubbles 
out. 

9. Attach the top and bottom electrode leads located on the left side of the 
electrophoresis chamber and gently close the door.

1. If you are using a square-tooth comb, attach the D-clamps to the upper buffer 
chamber, if they are not already attached.

a. Remove the screws at either side of the upper buffer chamber.

b. Place D-clamps so that the screw holes are aligned.

c. Insert the screws and turn them a few times.

1. Place the upper buffer chamber at the top of the gel plates, on the white 
plastic shelf. Slide the clamps over the plates but do not tighten the clamps. 
(To ensure a tight seal between the buffer chamber and the glass plates, 
make sure the gasket on the upper buffer chamber is dry.)

IMPORTANT If you have two different upper buffer chambers, use the larger of the 
two for 34 cm runs. Use the small upper buffer chamber for all other 
GeneScan runs.

2. Follow the instructions for the WTR and comb configuration you are 
using:

• For 24-cm and 34-cm runs with a sharkstooth comb: Slide the plain acrylic 
alignment brace over the comb, between the upper buffer chamber clamps 
and the glass plates. Finger-tighten the clamps; be careful not to over 
tighten.

• For 24-cm and 34--cm runs with a square-tooth comb: Tighten the screws on the 
D-clamps; be careful not to over tighten. 

• For 6-cm and 12-cm runs with a square-tooth comb: Slide the acrylic alignment 
brace with the temperature sensor over the comb, between the upper 
buffer chamber clamps and the glass plates. Finger-tighten the clamps; be 

Stretch
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careful not to over tighten. Plug the temperature sensor into the socket at 
the top left of the chamber.

Note You must have the temperature sensor from either a heat plate or the 
acrylic brace connected for the instrument to run.

The alignment brace is made of highly polished plastic so the numbers and 
the comb are readily visible through the clear plastic. Do not mark the 
alignment brace or glass plates with felt-tipped pens, as the use of most 
organic solvents to remove the ink will dull the surface reduce its clarity. 
Some ink may also fluoresce. 

3. Plug the electrode lead on the upper buffer chamber into one of the two 
jacks. For 34 cm gels, use the top (rear) socket, and for all other gels, use 
the lower (front) socket (see Figure 4-5 on page 4-15).

4. Fill the upper buffer chamber to at least two-thirds up the notched part of 
the plate (greater than 1.3 cm). Check for leaks. Close the lid of the buffer 
chamber.

If there is a leak, slightly tighten the brackets. If the leak continues, siphon 
the buffer out of the upper buffer chamber and clean the gasket area on 
the chamber. Also, clean the area of the plate that contacts the gasket. 
Reassemble as before.

5. Carefully fill the lower buffer chamber with 1X TBE buffer to about 
two-thirds full. For 34 cm runs, fill the lower buffer chamber until the 
bottom of the glass plates is covered. Avoid splashing buffer against the 
back of the chamber because it will spill over into the liner. Bubbles should 
be removed if they are under the bottom edge of the gel plates. This can 
be done with a clean needle and syringe, with the needle bent at an angle 
to guide the bubbles out. 

IMPORTANT The buffer must completely cover the bottom of the gel plates. You will 
need to prepare 2 L of buffer for 34 cm gels. For all other lengths, the 
standard volume of 1.5 L is sufficient.

6. Attach bottom electrode lead located on the left side of the electrophoresis 
chamber.
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Preparing and Loading Samples

Pre-running the Gel

Pre-run the gel for 5 minutes to make sure all connections and components of the 
electrophoresis system are working properly. 

To pre-run the gel:

1. Flush all of the wells with running buffer. Direct the needle of a syringe 
filled with running buffer at the space between adjacent comb teeth, and 
gently flush the well.

Remove any bubbles under the bottom edge of the gel plates in the lower 
buffer chamber. Use a clean needle and syringe, with the needle bent at an 
angle to guide the bubbles out. 

2. If you have not done so, choose the PreRun module from the PreRun 
pop-up menu.

3. Click the PreRun button.

The instrument performs electrophoresis without collecting data during a 
pre-run. 

4. Pre-run the gel for 5 minutes.

5. Click Cancel in the Run window.
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Preparing Samples for Electrophoresis

Add your samples to loading cocktail, as described here. After the pre-run 
(~5 minutes), load the samples and start the run.

WARNING CHEMICAL HAZARD. Formamide is a known teratogen and can 
cause birth defects. Before using formamide, read the MSDS 
found in the Safety Summary. Wear protective eyewear, gloves, 
and safety clothing when working with formamide. Wash 
thoroughly after handling formamide.

To prepare samples for electrophoresis:

1. Prepare loading cocktail by mixing (5:1:1)

• 2.5 µL deionized formamide

• 0.5 µL Blue Dextran EDTA [1 mg Blue Dextran per 1 mL EDTA 
(25–50 mM, pH 8.0)]

• 0.5 µL appropriate GeneScan Size Standard

Store at 4° C for up to 1 week.

2. Determine the appropriate dilution of your fluorescently-labeled PCR 
products.

The dilution used is dependent on the volume of your PCR reaction 
labeling strategy, and efficiency of label incorporation.
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3. Prepare sample for loading.

Use the following table to determine the appropriate sample, cocktail, and 
loading volumes for the comb you are using.

Table 4-2.  Sample, Cocktail, and Loading Volumes

Note In the 66-well configuration, the best resolution is achieved with 0.5 µL 
load volumes. It might be necessary to concentrate your PCR product 
by vacuum drying or evaporation. Perform concentration before adding 
the loading cocktail.

4. Vortex and centrifuge briefly. 

5. Heat samples at 95°C for 5 minutes.

6. Immediately place samples on ice until ready to load.

Loading the Samples and Starting the Run

IMPORTANT Be sure you load samples in the lanes specified in the Run window. The 
sample information in the Run window when you start the run is the 
information stored in the Gel file. Changes you make in the Run window 
after you start the run are not implemented.

For GeneScan applications, we recommend you use a square-tooth comb. 
Sharks-tooth combs may be used only if there is a vacant lane between samples. 
Loading every other lane for a sharks-tooth prevents even the smallest amount of 
sample bleed-through from samples in adjacent lanes and is imperative for 
GeneScan analysis accuracy.

Comb Configuration (number of wells)

24 34/36 50 66

Sample volume* (µL) 1.5 1.5 1.5 1.5

Cocktail volume (µL) 3.5 3.5 2.5 2.5

Loading volume (µL) 5 4 1.5–2.5 0.5–1.5
*User must determine the correct concentration, such that the signal is not >2000 fluorescent units. 
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Note If you are doing GeneScan analysis and have formed the wells using 
the square tooth comb, you can load the samples in consecutive lanes.

Whenever possible, load a sample in lane one to help orient the tracker during 
analysis. For best results, follow the procedure described here.

Note In the following procedures, each button in the Run window has a 
corresponding menu choice in the Instrument menu. You can either 
click the button in the Run window or choose the command from the 
Instrument menu.

Make sure you deliver the samples to the bottom of the wells. Use either a single- 
or a multi-channel pipetter/syringe equipped with a flat tip less than 0.3 mm in 
diameter (we recommend one with a diameter of 0.17 to 0.20 mm). Do not 
overload the lanes. Follow the recommendations in Table 3-3 on page 3-40 for the 
allowable loading volumes. If you use too much sample volume or quantity, you 
will experience poor resolution.

To load samples from a square-tooth comb:

1. If you are pre-running the gel, click Cancel in the Run window. 

2. Carefully flush all of the wells with running buffer.

Tip Place formamide or loading buffer in the well to the left of your first 
sample lane, and in the well to the right of your last sample lane (the 
comb creates wells to either side of the numbered wells). The 
formamide in the buffer helps focus the bands in the first and last lanes.

3. If you are loading a square tooth comb for GeneScan analysis, you can load 
the wells consecutively. 

IMPORTANT Whenever possible, load a sample in lane one. Avoid skipping more 
than one lane between samples. It is better to leave extra empty lanes 
at the right end of the gel. The lane tracker may not work properly if 
there are many empty lanes between samples.
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4. Click Run to start the run.

A dialog box appears, allowing you to change the name and location of the 
gel file created by the run.

5. Click OK when you are satisfied with the name and location for the gel file.

Note If a dialog box appears indicating you do not have enough room on your 
hard disk to save the files created by a run, delete files (particularly Gel 
files) to create enough space, making sure to back them up on a floppy 
disk or other storage device first, then click Run again.

To load samples from a sharks-tooth comb:

1. If you are pre-running the gel, click Cancel in the Run window. 

2. Carefully flush all of the wells with running buffer.

Tip Place formamide or loading buffer in the well to the left of your first 
sample lane, and in the well to the right of your last sample lane (the 
comb creates wells to either side of the numbered wells). The 
formamide in the buffer helps focus the bands in the first and last lanes.

3. Immediately load the sample into each of the odd-numbered wells. 

If you are loading fewer than half the samples allowed by the comb, skip 
steps 6–10 and perform step 11. If you are loading a square tooth comb, 
you can load the wells consecutively and skip steps 4–9. 

IMPORTANT Whenever possible, load a sample in lane one. Avoid skipping more 
than one lane between samples. It is better to leave extra empty lanes 
at the right end of the gel. The lane tracker may not work properly if 
there are many empty lanes between samples.

4. Click Run in the Run window to start the run.

A dialog box appears, allowing you to change the name and location of the 
gel file created by the run.
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5. Click OK when you are satisfied with the name and location for the gel file.

Note If a dialog box appears indicating you do not have enough room on your 
hard disk to save the files created by a run, delete files (particularly Gel 
files) to create enough space, making sure to back them up on a floppy 
disk or other storage device first, then click Run again.

6. Choose Status from the Window menu to verify that electrophoresis and 
scanning resume (refer to page 5-50). If either electrophoresis or scanning 
does not resume, cancel the run and restart it. 

Figure 4-14 summarizes the buttons you click in the Run window from the time 
you start the plate check for a typical run. They are listed from top to bottom in 
the order you use them. 

Note The tasks described in Figure 4-14 are detailed in the preceding pages.
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Figure 4-14.  Run window buttons used during a typical run

Button to click Module in effect Task to perform

Plate Check module Check plates and gel for 
fluorescence

n/a
(Stops plate check scan)
Add buffer and check for leaks
Mount front heat-transfer plate

Pre-run module (Electrophoreses gel without 
data collection to equilibrate 
temperature) 
Prepare samples while 
pre-running

Pre-run module Load first set of samples during 
pause

Pre-run module (Electrophoreses samples into 
gel without data collection)

Pre-run module Load second set of samples 
during pause

n/a (Stops pre-run)

Run module (Starts electrophoresis and 
data collection)
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Observing Instrument Status and Data

After you begin electrophoresis and data collection, data appears on the 
computer screen as it is collected. You can open up to four windows to view the 
data and the instrument status. Only one window can be active at any given time, 
but status windows still update when they are not active. 

Note If they are displayed, status windows continually update during a run. 
They do so even when another application is running.

Open the data collection and status windows by choosing the name of the window 
of interest from the Window menu.

Data Collection Status Windows

To observe instrument status, choose one of the following commands from the 
Window menu. The page reference next to a window name indicates where you 
can find detailed information about that window.

• Status (refer to page 5-50)

• Electrophoresis History (refer to page 5-57)

• Log (refer to page 5-57)

Note After the run is completed, you can choose Log from the Window menu 
to display a comprehensive record of all error and status messages 
generated during the run.
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Real-time Data Windows

The data displayed in the real-time data windows (the Scan window and the Gel 
window) represents light intensities collected by the data collection software from 
the filter wheel and PMT in the instrument. The colors in the raw data windows 
represent the wavelengths of the dyes being detected, rather than the bases being 
detected. This is explained in The Electrophoresis History Window on page 5-57.

To observe the data as it is being generated, choose one of the following from the 
Window menu:

• Scan (refer to page 5-55)

• Gel (refer to page 5-56)
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Cleaning Up After the Run

After your run is complete, perform the following general cleanup steps:

• Remove the gel from the instrument.

• Clean the plates, comb, and spacers.

Removing the Gel from the Instrument

1. Disconnect the electrode leads from both buffer chambers.

2. Unlatch the beam-stop bar and pull it forward.

3. Carefully remove the upper buffer chamber, glass plates, and heat plate 
(Leon only) as one unit. Discard the buffer. 

You can also set up a siphon system to drain the upper and lower buffer 
chambers before removing them.

4. Remove the lower buffer chamber and discard the buffer.

5. Clean up any liquid left in the electrophoresis chamber.

6. Unclamp the plates from the upper buffer chamber.

7. Rinse the buffer chambers with dH2O and allow them to air dry.

1. Disconnect the electrode leads from both buffer chambers.

2. Unlatch the beam-stop bar and pull it forward.

3. Carefully remove the upper buffer chamber and glass plates as one unit. 
Discard the buffer.

4. Remove some of the buffer from the lower buffer chamber before 
removing it.

This is especially important for 34-cm runs, as the buffer level is very high. 
You can also set up a siphon system to drain the upper and lower buffer 
chambers before removing them.

5. Remove the lower buffer chamber and discard any remaining buffer.

Classic
and
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6. Clean up any liquid left in the electrophoresis chamber.

7. If you plan to change plate length next time, unplug the temperature 
sensor, and then remove the heat plate, otherwise leave both in place.

8. Unclamp the plates from the upper buffer chamber.

Note If the unnotched plate has been silated with a bind-silane compound, 
use 0.1 N HCl or NaOH to remove the gel from the silated area, or 
scrape it off gently.

9. Rinse the buffer chambers with dH2O and allow them to air dry.

Cleaning the Plates, Comb, and Spacers

1. Gently push a plastic wedge almost all the way in at the bottom of the plates 
(avoid the top notches) and pry the plates apart. Do not use too much 
force or the plates might chip. Remove the sharks-tooth comb and gel 
spacers.

2. Lay a large Kimwipe on the gel and roll it up, lifting the gel off the plate, 
and discard appropriately. 

3. Rinse the plates with water. Rub with a gloved hand to dislodge remaining 
gel bits, then rinse again with water. 

4. Wash with a detergent such as Alconox that will not leave a residue, rinse 
with dH2O, and allow to dry. 

5. Clean the comb and spacers and store them.
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WARNING CHEMICAL HAZARD. The acrylamide and bis-acrylamide used to 
prepare sequencing gels for the ABI PRISM 373 DNA Sequencer 
with XL Upgrade are toxic chemicals whose use requires utmost 
attention to safety. Be sure to read the Material Safety Data Sheets 
(MSDSs)for emergency and first-aid procedures. MSDSs are in the 
ABI PRISM 373 DNA Sequencer with XL Upgrade Pre-Installation 
Manual, P/N 901173. Acrylamide is a neurotoxin that can be 
absorbed through the skin. Wear a laboratory coat, eye protection, 
and gloves. The handling and disposal of chemical waste is the 
responsibility of the user, and not the Applied Biosystems service 
representative.
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Analyzing the Data

If you choose Auto Analyze for your samples in the GeneScan Run window, the 
data collected on the ABI PRISM 373XL is automatically analyzed by the GeneScan 
Analysis program. For complete instructions on using the analysis program, refer 
to the ABI PRISM GeneScan Analysis Software User’s Manual.

Automatic data analysis occurs approximately 1 to 10 hours after you start data 
collection (the amount of time depends on the run conditions and WTR you 
chose). Three channels of data are analyzed for each lane containing a sample on 
the gel. The analysis software prints electropherograms (if you selected AutoPrint 
in the Sample Sheet) and displays the gel window on the computer screen. 
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Evaluation Checklist

Before evaluating the quality of the data in your Samples files, check the following:

• After analysis, always view the Gel file on the computer screen. Check 
tracking and look for any atypical characteristics of the gel that may 
indicate a problem. For more information on fine tuning the gel file, refer 
to the ABI PRISM GeneScan Analysis Software User’s Manual.

• Examine data obtained with control reactions. If you obtain good data with 
control reactions, you can eliminate the possibility of problems with 
reagents, equipment, or general technique.

• Study the analyzed data. Take note of the peak shape, the amount of noise, 
any obscured, crowded peaks, or other peaks that appear under peaks.

• Review Appendix F for strategies you can employ to optimize PCR 
performance.

• For forensics applications, run a positive control of the analyst’s DNA to 
check for possible contamination of unknown samples and a negative 
control.

• Examine the standard curve for the sizing standard in each lane. Ensure 
the curve is linear and the proper peaks have been identified. If not, 
reanalyze the lane defining a new standards file for that lane. Refer to the 
ABI PRISM GeneScan Analysis Software User’s Manual.
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Characteristics of Good Data

An electropherogram from a Sample file that contains good data has sharp, 
well-defined peaks.

Figure 4-15.  Example of good data with sharp, well-defined peaks
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Characteristics of Poor Data

No Peaks

The absence of peaks in your results file could be due to no PCR amplification. 
To determine if this is the case, run another gel and include a lane of Taq 
Standard PCR Control or another reaction you know that has run successfully 
before. If you have no bands in your sample, but the size standard appears to be 
good, there was no amplification. For tips on optimizing PCR, see Appendix E.

Too Many Peaks— Noisy Data

If artifact bands, extra peaks, or peaks under peaks appear in your Sample files, 
try one or several of the following:

• Check for possible PCR carryover.

• Check PCR technique for practices that may have led to sample 
contamination.

• Check primer sequences for 3' complementarity.

• Design longer primers.

• Increase the amount of target DNA.

• Reduce the primer concentration.

• Reduce the number of cycles.

• Raise the annealing temperature.

• Decrease MgCl2 concentration in your reaction.
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Smeared or Fuzzy Bands

If you see smeared or fuzzy bands, try one or several of the following:

• Reduce the concentration of AmpliTaq DNA Polymerase. 

• Create a Master Mix of PCR reagents to ensure each reaction is getting the 
correct amount of all reagents.

• Increase the annealing temperature and consider a two-temperature PCR 
protocol.

• Reduce the magnesium concentration.

• Minimize the incubation times of the annealing and extension steps.

• Decrease the number of cycles.

• Perform electrophoresis at lower voltage.
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Troubleshooting Table
Table 4-3.  Troubleshooting for PCR and Electrophoresis Conditions 

Observation Possible Causes Potential Solution

PCR Conditions

Unsuccessful 
amplification
(faint or no 
peaks).

Impure DNA template.

PCR inhibitors may 
exist in the DNA 
sample.

Try different extraction procedures combined 
with filtration of DNA through a spin column 
before amplification.

Insufficient template 
DNA for human 
identification
experiments.

Use recommended amount of template DNA. 
Use a procedure such as QuantiBlot™
Human DNA Quantitation Kit to accurately 
quantitate human DNA samples.
If DNA is stored in water, check water purity.

Insufficient enzyme 
activity.

Use the recommended amount of AmpliTaq 
DNA Polymerase.

MgCl2
 solution not 

added to PCR control 
DNA reaction.

Add appropriate amount of 
MgCl2 solution to amplification reaction.

Incorrect thermal
cycling parameters.

Check protocol for correct 
thermal cycling parameters.

GeneAmp PCR 
instrument system 
failure.

Choose correct amplification program for 
each primer pair.
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Unsuccessful 
amplification
(faint or no 
peaks).

High salt

concentrations of K+, 

Na+, or Mg2+.

High concentration of 
EDTA.

Incorrect pH.

Incorrect volume of DNA can alter pH: use 
correct amount of DNA, and buffer.

Tubes not seated 
tightly in the 
thermal cycler during 
amplification.

Push reaction tubes firmly into contact with 
block before first cycle.

Unsuccessful 
amplification
(faint or no 
peaks).

Wrong style tube. Use Applied Biosystems GeneAmp 
Thin-Walled Reaction Tubes for the DNA 
Thermal Cycler 480, or MicroAmp Reaction 
Tubes with Cap for the GeneAmp PCR Sys-
tem 9600.

Primer concentration 
too low.

Use recommended primer concentration.

Weak signal. For multiplex PCR, 
lack of 2 minute down 
ramp time between
denaturation and 
annealing.

Between denaturation and annealing, add 2 
minute down ramp time to thermal cycling
program. For multiplex reactions, the fastest 
ramp time is not necessarily the best.

Observation Possible Causes Potential Solution
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Weak signal. Incorrect Mg2+ 
concentration.

Store DNA in H2O. The DNA volume should 
not be more than one fifth of the total reaction 
volume. EDTA in TE storage buffer affects 
the MgCl2 concentration.

Add correct amount of Mg2+ to reaction mix.
Use correct dilution (1X) of 10X PCR buffer.
Check dilution of dNTP stocks concentrations 
higher than recommended may lower the free 

Mg2+.
Perform additional organic extractions with 
EtOH precipitations and /or filter DNA 
through a spin column before amplification to 
remove any potential PCR inhibitors.

Inconsistent
results with 
control DNA.

Incorrect PCR thermal 
profile program.

Choose correct temperature control parame-
ters for PCR thermal profile (See GeneAmp 
PCR System 9600 User’s Manual).

System 9600 
misaligned lid.

Align 9600 lid properly so that white stripes 
align after twisting the top portion clockwise.

For DNA Thermal
Cycler 480, Improper 
tube placement in 
block.

Refer to DNA Thermal Cycler 480 User’s 
Manual.

Pipetting errors. Calibrate pipettes, attach tips firmly, check 
technique. Make a master mix of reagents.

Combined reagents 
not spun to bottom of 
tube.

Place all reagents in apex of tube, spin briefly 
after combining.

Combined reagents 
left at room 
temperature or on ice 
for extended 
periods of time.

Put tubes in block immediately after reagents 
are combined.

Observation Possible Causes Potential Solution
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Unbalanced 
signals with 
control DNA.

Pipetting errors. Calibrate pipets, attach tips firmly, check 
technique.

Unbalanced 
signals for
samples.

PCR inhibitors may be 
present in DNA 
sample.

Try different extraction 
procedures. Filter DNA through a spin 
column before amplification.

Extra peaks 
visible when 
sample(s) is 
known to 
contain DNA 
from a single 
source.

Contamination with 
exogenous DNA.

Use appropriate techniques to avoid intro-
ducing foreign DNA during laboratory 
handling.

Renaturation of 
denatured samples.

Load sample immediately 
following denaturation, or store on ice until 
you are ready to load.

Too much DNA in
reaction, promoting 
renaturation.

Use recommended amount 
of template DNA. Use a procedure such as 
QuantiBlot Human DNA 
Quantitation Kit to accurately quantitate DNA 
sample.

Too much DNA 
amplified and/or 
loaded resulting in 
crossover between 
color channels.

Check if any peak, particularly a homozygote, 
is over 6000 peak height. Re-run PCR using 
less DNA, or load less sample during 
electrophoresis.

For Stock-
Marks For Cat-
tle protocol, 
weak signal for 
TGLA53.

During thermal 
cycling, temperature 
ramps too quickly.

For GeneAmp instrument 
system, program one minute ramp rates. 

Observation Possible Causes Potential Solution
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Peaks are split 
into two peaks 
that are 1 bp
different in size.

Partial non-template 
addition of an extra 
nucleotide to the blunt 
end of the PCR 

product. High Mg2+ 

concentrations can 
lower the degree of 
nucleotide addition.

Add correct amount of Mg2+ to reaction mix.

Signal 
continually gets 
weaker.

Outdated or 
mishandled reagents.

Check expiration dates on 
reagents and store and use 
according to manufacturers
instructions. 
Compare with fresh reagents.

Electrophoresis Conditions

Inconsistent 
sizing of known 
DNA sample.

Inadvertent change in 
analysis parameters.

Check settings for GeneScan analysis
parameters.

Incorrect internal 
standard.

Check internal size standard peaks against 
definition used.

Incorrect gel
composition.

Check if gel composition matches protocol 
requirements. 

Check urea concentration.

Incorrect sample 
sheet.

Check Sample Sheet selection in data 
collection program, or check sample sheet 
embedded in Gel file.

Data was not 
automatically 
analyzed.

Sample sheet not 
completed.

Correctly complete sample sheet.

Observation Possible Causes Potential Solution
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Crossover of 
one or more 
colors different 
than the 
primary color.

Incorrect matrix 
chosen.

Check matrix selection in Run window of data 
collection program or Gel file.

Sample overloaded. Load sample volume recommended in 
application protocol.

Samples run 
faster than 
usual with 
decreased 
resolution.

Incorrect gel
composition.

Check whether gel composition matches 
protocol requirements.

Continued 
weakening of 
signal over 
time.

Degraded primers. Store primers at -20˚C when not in use. Keep 
on ice during set-up.

Additional
colors displayed 
underneath the 
position of one 
strong peak.

Off-scale data not 
matrixed correctly.

Repeat electrophoresis; load less sample.

Peaks
appearing in a 
dye color that 
should not be 
present.

Bleed through from 
other colors due to 
off-scale data.

Repeat electrophoresis; load less sample.

Allele peaks 
seen in 
correct
molecular 
weight range, 
with additional 
peaks seen 
outside this 
range.

Bleed through from 
other colors due to
off-scale data.
Primers not 
optimized.

Repeat electrophoresis; load less sample.
Refer to Appendix E.

Observation Possible Causes Potential Solution



Applied Biosystems

4-64 4  Using the Instrument in GeneScan Mode March 2001

With allele 
peaks of high 
intensity, 
GeneScan 
sites many 
small peaks.

Background above 
minimum peak height.

Too much PCR 
product loaded on gel.

Adjust minimum peak height; reanalyze 
(See the GeneScan Analysis Software User’s 
Manual).

Repeat electrophoresis; load less sample.

No current. Incorrect TBE buffer 
concentrations.

Check concentrations of TBE buffer:
10X in gel
1X in running buffer.

Instrument not
assembled correctly.

Check if leads are secure, and make sure 
that the bottom and top of gel immersed in 
running buffer.

Instrument parts
broken.

Check for breaks in leads,
buffer chambers, or platinum wire.

Observation Possible Causes Potential Solution
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Archiving the Data 

For best performance, keep as few files as possible on your hard disk. Do not 
archive gel files and run folders on your hard disk. It is important that you copy 
all files you want to save onto a backup medium before beginning another 
sequencing run, both to preserve the files and to free disk space.

Files Created During a Run

When you set up a run, the data collection software creates a Run folder and a Run 
file. During the run, the program automatically creates and saves two files: the Gel 
file and the Run Log file. After the run, the analysis program creates Sample files.

Run Files
Each Run file stores information associating specific samples with specific lane 
positions. It also stores information about the Sample Sheet and module 
associated with the run. Run files are small enough to store on floppy disk. 

Gel Files
Gel files contain the raw data acquired by the data collection program and 
typically take up 30–50MB of disk space. A separate Gel file is created in the Run 
folder each time you perform a run. Because Gel files take a substantial amount 
of space, you should delete them from your hard disk after you have obtained 
satisfactory Sample files. You do not usually need to keep gel files once the lane 
tracking is verified and sample files are created. 

Use magnetic tapes, removable cartridge drives, or optical drives to archive gel 
files. Gel files are too large to fit on floppy disks.

IMPORTANT Do not discard any gel file until you have verified the tracking and taken 
corrective action if necessary.

Run Log Files
Run logs provide a good record of your runs. Individually, Run Log files are small 
enough to archive on floppy disks. 
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Sample Files
Use floppy disks, a magnetic tape drive, a removable cartridge drive, or an optical 
drive to archive sample files. A 1.4 MB, high-density disk holds about six Sample 
or Sequence files. A Sample file is 150–200KB in size, depending on the length of 
the sequencing run. Save a Sample file when you feel confident that the channel 
selections (tracking) are correct for the sample.

Other Files

Other files provide information for a run that you might have customized and 
should therefore save. These include the Sample Sheet, analysis settings, or matrix 
files you create.

Sample Sheet Files
You can reuse the Sample Sheet, and it is a good reference after data collection. 
Individually, Sample Sheet files are small enough to archive on floppy disks.

Custom Analysis Settings and Matrix Files
If you have created customized files, you should keep backup copies of the files on 
a separate medium. Each of these types of files alone is small enough to store on 
a floppy disk.
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Overview of Data Collection Menu Commands

ABI PRISM 373 DNA Sequencer with XL Upgrade software programs are designed 
with the easy-to-use pull-down menus and the point-and-click technique 
commonly used in Macintosh-compatible programs. The menu bar at the top of 
the screen gives access to all functions. You can also use keyboard commands in 
many cases. If they are available, keyboard commands are listed opposite their 
corresponding commands on the pull down menus.

This section briefly describes each of the four menus on the data collection 
program main menu bar.

Apple Menu

At the left end of the menu bar is the Apple menu, a standard feature of 
Macintosh applications. It displays desk accessories installed on your system.

The top command, About ABI PRISM 373 DNA Sequencer with XL Upgrade 
Collection, opens the splash screen, which shows general information about the 
data collection program. Click on it to close it.

Figure 5-1.  Splash screen
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File Menu

The File menu contains commands for creating, opening, closing, and saving 
windows, importing and exporting data to other file types, printing, and quitting 
from the application.

Table 5-1.  File Menu Commands  

Command Description See for 
Detail

Close, Save, Save 
As..., Revert, Page 
Setup..., Print..., Quit

Standard Macintosh system commands. See 
the Macintosh System 7 Reference manual

Page 5-65

New... and Open... Open Run files or Sample Sheets for 
Sequencing or GeneScan applications. Use 
New to create a new file, or use Open to open 
an existing file.

Pages 5-34 
to 5-40

Save a Copy In... Saves a backup copy in a file other than the 
original. The name of the file with which you 
are working does not change.

Page 5-65
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Import... Imports text from files such as those generated 
by a database into the grid of the Sample 
Sheet or Run window.

Page 5-33

Export... Exports data from the grid of the Sample Sheet 
or Run window in tab-delimited text format for 
database applications.

Page 5-33

Print One Prints one copy of the active window, 
bypassing the standard print dialog box.

Page 5-66

Table 5-1.  File Menu Commands  (continued)

Command Description See for 
Detail
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Edit Menu

The Edit menu contains standard clipboard commands, commands for selecting 
and searching, spreadsheet editing commands (Insert and Fill Down), and a 
command for changing the time scale in the Electrophoresis History window.

Table 5-2.  Edit Menu Commands  

Command Description See for 
Detail

Undo (Redo), Cut, 
Copy, Paste, Clear, 
and Show Clipboard

Standard Macintosh system commands. See 
the Macintosh System 7 Reference manual

pages 5-32, 
5-38

Select All Selects all entries in the open window.

Fill Down Applies a parameter change to all cells in a 
column of a Sample Sheet or Run window.

Page 5-38

Set Scale... Sets the scale of the panels in the 
Electrophoresis History window.

Page 5-58
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Instrument Menu

The Instrument menu contains commands for starting, pausing and stopping the 
ABI PRISM 373XL. 

Table 5-3.  Instrument Menu Commands

Command Description See for 
Detail

Start Plate Check Allows you to scan the gel and plates before loading 
samples to ensure that no peaks are produced by 
fluorescent particles on the glass plates or in the gel.

Page 5-48

Start PreRun Starts a pre-run of the gel, using parameters in the 
pre-run module specified in the Run window.

Page 5-48

Start Run Begins automatic execution of a run using 
parameters in the run module specified in the Run 
window.

Page 5-48

Pause Temporarily interrupts a run. During a pause, no 
additional functions are performed. The laser stops 
scanning, but any data remaining in instrument 
memory continues to be collected.

Page 5-48

Resume Resumes a run that has been paused. Page 5-48

Cancel Run Only available if a module is currently running. 
Allows you to immediately stop the current module 
on the instrument. The run is ended and the Run file 
is closed. You cannot resume the run.

Page 5-48
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Window Menu

The Window menu contains a list of the default windows: instrument Status, Log 
file, Sample Sheet, Run file, Scan, Gel Image, and Electrophoresis History. At the 
bottom it also contains a list of any other open windows. Choosing any window 
from this menu brings that window to the front and makes it the active window. 

• To move a window around on the screen, click the top border, hold the 
mouse button down, and drag the window to another location on the 
screen.

• To change the size of a window, click the size box in the lower right corner 
of the window, hold the mouse button down, and drag the mouse to stretch 
or shrink the window.

• To close a window, click the close box at the upper left corner of that 
window or click in the window to make it active and choose Close (c-W) 
from the File menu.

• To expand a window so that it displays the entire contents within the 
window, click the zoom box in the upper right corner.
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Table 5-4.  Window Menu

Command Description See for 
Detail

Status Displays the status of hardware and status 
of the run. During a run, it displays current 
instrument conditions.

Page 5-50

Log Text file that contains date- and 
time-stamped status and error messages in 
chronological order.

Page 5-51

Sample Sheet Allows you to specify sample information for 
each lane position in the gel. The 
information you enter depends on the 
analysis program you are using.

Page 5-58

Run Allows you to specify the Sample Sheet and 
module information for an automatic run.

Page 5-58

Scan Displays electropherogram of raw data as it 
is being collected during the run.

Page 5-55

Gel Image Displays a reconstruction of actual data as it 
would appear on an autoradiogram. It is 
updated as data is collected from the 
instrument.

Page 5-56

Electrophoresis History Displays target and actual values for the 
electrophoresis power supply and gel 
temperature throughout the course of an 
electrophoresis run.

Page 5-57

Manual Control Displays a window for manual control of 
certain functions during a run.

Page 5-59

Preferences... Allows you to specify folder locations, file 
name conventions, and default settings.

Page 5-16
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Using the Data Collection Program

Before you start an ABI PRISM 373XL run, the following conditions should apply:

• You have set or verified Preferences

• You have created the Sample Sheet and the Run file

• The instrument is ready and samples are loaded 

• The Macintosh hard disk has adequate free space to store the collected 
data (It needs a minimum of 40 to 60MB free disk space for an average 
run.)

To learn about preparing gels and setting up the instrument, refer to Sections 2 
and 3. For information about choosing a proper sequencing chemistry, refer to 
the ABI PRISM DNA Sequencing Analysis Chemistry and Safety Guide. For information 
about GeneScan experimental design, refer to the GeneScan 672 User’s Manual.

This section describes how to use the data collection software to create and edit 
Sample Sheets and Run files, to perform a run, and to view the resulting data.

To prepare the software for a run, perform the following general steps:

• Restart the computer

• Start the data collection program

• Set or verify preferences

• Create a Sample Sheet*

• Create a Run file

When you start the data collection program and begin a run, the software displays 
data as it is received from the ABI PRISM 373XL, and you can view the data in 
different views, described on page 5-49. The data is stored on the computer. 

The data collection program typically runs for approximately 3.5–16 hours 
(1–6 hours for GeneScan) from the time you start the run to the time data analysis 
begins.

* If a Sample Sheet already contains information that applies to your samples, you do not need 
to create a new one. Specify lane position for each sample when you create the Run file.
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Starting the Data Collection Program
• Choose Restart from the Special menu in the Finder to restart your 

computer.

The data collection software should automatically open when you restart 
the computer. If it does not, double-click the icon to open the program. 
Refer to the instructions below to have the 373XL collection program open 
at startup.

If any of the data collection folders are not in the default locations, a dialog box 
appears asking you to specify where they are located.

The data collection program allows you to indicate preferences for folder 
locations, file name conventions, and default settings. To do so, refer to Setting 
Preferences on page 5-14.

Note If communications between the computer and the instrument do not 
seem to be working properly, refer to Total Reset of the Instrument on 
page 8-8.

To make the data collection program open at startup:

1. Locate and select (single-click) the 373XL data collection program icon. 

2. Choose Make Alias (z-M) from the File menu.

3. Open the System folder and locate the Startup Items folder.

4. Drag the 373XL collection alias into the Startup Items folder.

5. Choose Restart from the Special menu.
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Setting Preferences

The data collection program allows you to indicate preferences for folder 
locations, file name conventions, and default settings.

You can choose several types of preferences to set (see Figure 5-3):

• Folder Locations

• File Names

• Sequence Sample Sheet Defaults

• Sequence Run Defaults

• GeneScan Sample Sheet Defaults

• GeneScan Run Defaults

• General Settings

• Dye Indicators

The defaults are global parameters that appear in the data entry windows so they 
apply to all samples. Since separate Sample Sheets and Run files exist for 
sequencing and GeneScan analysis, the defaults you can set are also somewhat 
different.

Although the defaults you set appear when you open a new Sample Sheet or Run 
file, you can change the fields as required for the individual situation.

Some default settings also appear in the Page Setup dialog box for your particular 
printer. They are discussed in the section on printing (see Printing on page 5-67). 

Note The preferences you set are saved automatically when you close the 
Preferences window. You do not need to save each page individually.

For 
Sequencing 
analysis

For 
GeneScan 
analysis
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To set preferences:

1. Choose Preferences from the Window menu and choose the appropriate 
option from the submenu that appears.

Figure 5-2.  Preferences submenu

2. Enter or change the defaults, as described on the pages below.

3. Click OK to accept the changes.

Note You can switch from one preferences window to another by using the 
pop-up menu labeled “Page:” in the upper left corner of each 
preferences window.
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Setting Folder and File Preferences

Setting Folder Location Preferences
The data collection program automatically uses several specific folders for data 
storage. You can specify that it use different folders by changing the folder 
location preferences.

The Folder Locations page of the preferences dialog box shows the current 
folders that store Sample Sheets, modules, runs, the firmware image, and settings 
(see Figure 5-3).

Figure 5-3.  Preferences Folder Locations window

The locations initially shown in this screen are the folders where the indicated 
files are normally stored. If you store them in other folders, it is important that you 
specify in this screen where you store them. When you create Sample Sheets, 
modules, and Run files, the pop-up menus that allow you to choose various 
options refer to the folders indicated in this screen.

To change the folder where Settings are stored, click this button 

To set other preferences select from this pop-up menu. Any 
changes you made in this screen are saved automatically

Click here to return to the main menu
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• The Sample Sheet Folder button shows the name and path of the folder in 
which you store your Sample Sheets. The Run window pop-up menus that 
allow you to choose a Sample Sheet file refer to this folder.

• The Module Folder button shows the name and path of the folder where 
you store modules. This is referred to by the Run window pop-up menus 
for plate check, pre-run, and run modules.

• The Folder containing Run folders button indicates the name and path of 
the folder in which Run folders are created when you start a new run.

• The Firmware Image folder button indicates the name and path of the 
folder that contains the Firmware Image file. The first time you turn on the 
ABI PRISM 373 DNA Sequencer with XL Upgrade and open the data 
collection program, the program looks in this folder for the image file, 
which it automatically copies to the instrument. 

• The Settings Folder button indicates the folder containing mobility files, 
matrix files, analysis settings files, fragment size standard files, and comb 
files. The choices in other Preferences dialog boxes and in the Run 
windows refer to this folder for their pop-up menus. The Settings folder is 
initially set to be the ABI folder inside your System folder.

IMPORTANT If you plan to analyze your data using the Sequencing Analysis 
software program after data collection, the Settings folder must be set 
as the ABI folder. 

To change one of the data storage folders:

1. Choose Preferences from the Window menu and choose Folder Locations 
from the submenu that appears.

If you are already in the Preferences window, choose Folder Locations 
from the pop-up menu labeled “Page:”.

2. Click the button showing the folder's path name to display a dialog box 
(Figure 5-4).
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Figure 5-4.  Folder selection dialog box

3. Find the new location and click the Select button at the bottom of the file 
selection dialog box (Figure 5-4).

IMPORTANT The data collection software allows you to specify a Settings folder 
location. If you analyze your data with the ABI PRISM Sequencing 
Analysis program on the computer that you use for data collection, the 
Settings folder must always be specified as the ABI folder that is 
located in the System folder.

4. When you have changed all the desired folders, click OK in the Folder 
Locations Preferences dialog box (Figure 5-3 on page 5-16) or choose 
another preference from the Page pop-up menu.

These folder locations are normally on your local hard disk, but can be on any 
AppleShare server volume as well.

Setting File Name Preferences
The data collection program automatically names new files and folders created 
during a run (Sample Sheet files, Run folders, Run files, gel files). The Default File 
Names page of the preferences dialog shows the method used for automatically 
creating file and folder names (see Figure 5-5).

Click here to select 
the highlighted folder
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Figure 5-5.  Preferences File Names window

A file name can be any text string or nothing at all. By default, the software adds 
the date as a suffix, but you can choose to not display a suffix. A Sample file can 
have a prefix and a suffix. The prefix can be the lane number or the sample name. 
You can choose the suffix from a pop-up menu. The choices are:

• Nothing <none>

• Today's date and the current time <date>

• A serial number reset to one at the start of each run <serial number> 

• A serial number that increments across runs <global serial number>

• The sample name from the file’s Sample Sheet <sample name>

If you manually save any of these types of files, the name as specified in this dialog 
box appears automatically in the Save dialog box. You can change it if you wish.

pop-up menus 
allow you to 
select suffixes

Enter text in the entry fields to change names
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To change automatically generated file names:

1. Choose Preferences from the Window menu and choose File Names from 
the submenu that appears.

If you are already in the Preferences window, choose File Names from the 
pop-up menu labeled “Page:”.

2. Enter the desired text in the entry field for each type of 
automatically-named file or folder.

The text you enter will be the prefix for all file names of that type.

3. Specify a suffix by choosing from the pop-up menu to the right of the text 
entry field. 

4. When you are finished specifying file name defaults, click OK or choose 
another preference from the Page pop-up menu.

Note If you choose the “global serial number” option for a suffix, you can 
reset the global serial number if necessary. To do so, see page 5-29.
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Setting Defaults for Sequencing Analysis Applications

The following two headings discuss default settings for Sequencing Analysis 
applications only. If you are running GeneScan applications, see Setting Defaults for 
GeneScan Analysis Applications on page 5-25.

Setting Sequence Sample Sheet Defaults
If you are running sequencing analysis applications, you can set defaults for two 
of the choices in the Sample Sheet (Figure 5-6). 

Figure 5-6.  Sequence Sample Sheet Defaults window

Both the DyeSet/Primer and the Instrument file parameters have pop up menus 
that allow you to choose none or any dye/set and Instrument file in the Settings* 
folder.

To set Sample Sheet defaults for Sequencing Analysis applications:

1. Choose Preferences from the Window menu and choose Sequence Sample 
Sheet Defaults from the submenu that appears.

* If you are running Sequencing Analysis applications, this folder should be set as the ABI folder in 
your System folder (see page 5-17).

The pop-up menu options are files in the 
Settings* folder and are filtered for the 
correct file type
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If you are already in the Preferences window, choose Sequence Sample 
Sheet Defaults from the pop-up menu labeled “Page:”.

2. Choose parameters for the two defaults by selecting from the pop-up 
menus.

The files listed in the menu are all the applicable files in the Settings folder 
(filtered according to type). If you wish to choose a file that is not listed, 
choose Other, and a file dialog box allows you to choose any applicable file 
in any other folder.

3. Click OK or choose another preference from the Page pop-up menu.
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Setting Sequence Run Defaults
You can set several defaults for the Run file of a Sequencing Analysis run (see 
Figure 5-7). 

To set Run file preferences for Sequencing Analysis applications:

1. Choose Preferences from the Window menu and choose Sequence Run 
Defaults from the submenu that appears.

If you are already in the Preferences window, choose Sequence Run 
Defaults from the pop-up menu labeled “Page:”.

Figure 5-7.  Preferences Sequence Run Defaults window

Pop-up menus allow you to choose from filtered lists of files. The procedure 
below lists where the files are located. To choose a file that is not listed, choose 
Other. A file dialog box allows you to choose files from other folders
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2. Set the defaults as described below.

a. Enter your name in the Operator entry field.

b. Specify the separation distance by choosing from the WTR (well- 
to-read) pop-up menu.

The well- to-read (WTR) distance for sequencing runs is usually 24, 
34, or 48 cm. 

c. Click Lanes and choose the number of lanes from the pop-up menu 
that appears.

d. Choose default modules from the PreRun Module and the Run 
Module pop-up menus.

The menu shows all Module files in the Module folder (see page 
5-17).

e. To specify that the data be automatically analyzed by the Sequencing 
Analysis program, select the checkbox labeled “Autoanalyze with” and 
choose Other from the pop-up menu. 

In the dialog box that appears, find the analysis program and click 
Open.

This specifies the location of the analysis program.

f. Select the checkbox at the bottom of the window to specify automatic 
printing of the data after analysis.

3. Click OK or choose another preference from the Page pop-up menu.
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Setting Defaults for GeneScan Analysis Applications

The following three headings discuss default settings for GeneScan Analysis 
applications only. If you are running sequencing applications, see Setting Defaults 
for Sequencing Analysis Applications on page 5-21.

Setting GeneScan Sample Sheet Defaults
If you are running GeneScan analysis applications, you can set defaults for four 
Sample Sheet entries.

To set Sample Sheet defaults for GeneScan analysis applications:

1. Choose Preferences from the Window menu and choose GeneScan 
Sample Sheet Defaults from the submenu that appears.

If you are already in the Preferences window, choose GeneScan Sample 
Sheet Defaults from the pop-up menu labeled “Page:”.

Figure 5-8.  Preferences GeneScan Sample Sheet Defaults window

• Choose the color for the size standard color you are using.

2. Click OK or choose another preference from the Page pop-up menu.
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Setting GeneScan Run Defaults

To set Run file preferences for GeneScan Analysis applications:

1. Choose Preferences from the Window menu and choose GeneScan Run 
Defaults from the submenu that appears.

If you are already in the Preferences window, choose GeneScan Run 
Defaults from the pop-up menu labeled “Page:”.

A dialog box appears.

Figure 5-9.  Preferences GeneScan Run Defaults window

The default options are the same as for sequencing runs, but the filtered 
choices might be different for GeneScan analysis. 
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2. Set the defaults as described below.

a. Enter your name in the Operator entry field.

b. Specify the separation distance by choosing from the WTR (well- 
to-read) pop-up menu.

The well to read (WTR) distance for GeneScan analysis is usually 6, 
12, 24, or 34 cm.

c. Choose the number of lanes from the Lanes pop-up menu.

d. Choose default modules for the pre-run and the run from the Module 
pop-up menus.

The menu shows all Module files in the Modules folder (see page 
5-17).

e. To specify that the data be automatically analyzed by the GeneScan 
Analysis program, select the checkbox labeled “Autoanalyze with” and 
choose Other from the pop-up menu. 

In the dialog box that appears, find the analysis program and click 
Open.

This specifies the location of the analysis program.

f. Select the checkbox at the bottom of the window to specify automatic 
printing of the data after analysis.

3. Click OK or choose another preference from the Page pop-up menu.

General Settings

The General Settings window allows you to specify:

• A global serial number that increments across runs and can be used in the 
names of automatically generated files (see page 5-19).

• The module to be used for checking the plates.

• The computer port to which the instrument is attached. Set to modem 
port.

The Macintosh computer has two standard connection ports: a Modem 
port and a Printer port. Normally, the instrument is attached to the 
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computer by means of the Modem port, and a printer or network 
connection is attached to the Printer port. If, however, you need to move 
the instrument connection to the Printer port, specify that you have made 
the change in the general settings. A third option allows you to use the data 
collection software when no instrument is attached to the computer.

• The minimum number of scan lines in a gel.

The size of a gel file is calculated according to the collect time you enter in 
the Run window. The number in the General Settings specifies the 
minimum number of scan lines for a gel file.

IMPORTANT Do not change the minimum number of scan lines in a gel. If you make 
it smaller, the data collection software might not allocate enough hard 
disk space to collect all of your data.

To change the general settings:

1. Choose Preferences from the Window menu, and then choose General 
Settings from the submenu that appears.

If you are already in the Preferences window, choose General Settings from 
the pop-up menu labeled “Page:”.

Figure 5-10.  General settings window

2. Make changes as desired.

Choose Plate Check 
module

Select Modem Port

Keep at 800



March 2001 5  Using the Data Collection Software 5-29

Applied Biosystems

• To change the global serial number, select the number in the entry field 
and type the new number.

• Choose a plate check module from the pop-up menu.

• If you changed the instrument connection, click the name of the port 
to which the instrument is now attached. If you wish to use the data 
collection software off-line (not connected to the instrument), click No 
Port.

• To change the initial file size of the Gel file, select the number in the 
Number of Scans entry field and type a new one. You should not need 
to change this setting (see note below).

3. Click OK or choose another preference from the Page pop-up menu.

Note The data collection software always performs at least the minimum 
number of scans specified in the General Settings window. It performs 
more than the minimum specified if necessary to complete a run, based 
on the collection time specified in the Run window.

Setting Dye Indicators Defaults
To change the colors that represent the dyes when data is displayed, you can set 
Dye Indicators defaults. This is especially useful if you are color blind and the 
default settings shipped with the software are not appropriate for your needs.

To set dye indicator preferences for the analysis applications:

1. Choose Preferences from the Window menu and choose Dye Indicators 
from the submenu that appears.
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If you are already in the Preferences window, choose Dye Indicators from 
the pop-up menu labeled “Page:”.

Figure 5-11.  Preferences Dye Indicators window

2. Make changes as desired.

• To change a code, type a different character in the appropriate entry 
field in the Code column.

• To change a color, click the appropriate color button and choose a new 
color from the pop-up menu that appears. The Display Color column 
shows the colors used on the computer screen. The Print Color column 
shows the colors used for printing.

If you choose Other from the pop-up menu, a color picker appears 
(Figure 5-12).

To change a color, click the button and 
choose a new color from the pop-up

Dye Color is the color that 
appears on the computer screen

Plot color is the color that appears 
on the printed electropherogram
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Figure 5-12.  Color picker

You can choose a new color by using either the scrolling fields to the 
left or the color wheel to the right.

To use the scrolling fields, click one of the up or down arrows and 
hold down the mouse key. The upper half of the color box shows the 
colors as the parameters change. The lower half retains the original 
color until you click OK to accept a new color.

To use the color wheel, click the desired color in the wheel. The new 
color appears in the upper half of the color box. Move the insertion 
point and click again until you find the desired color.

Click OK when you are satisfied with the color.

3. When you are finished changing dye indicator preferences, click OK or 
choose another preference from the Page pop-up menu.

The upper box shows 
the selected color

The lower box shows 
the previous color

Click a scrolling arrow 
or the color wheel to 
change colors

Use the scroll bar to quickly change brightness
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Creating and Editing a Sample Sheet

Before starting a run you must record sample information in the Sample Sheet 
and the Run file. Once you have set up the Sample Sheet, you can automatically 
copy sample information into the Run file, which associates sample information 
(name and type of analysis) with each lane position in the gel. 

You can choose from two different Sample Sheets (typing or templates), 
depending on your application (Sequencing or GeneScan analysis). The only 
difference between them is in the entry fields. The entry fields in each are 
described under Creating a Sequence Sample Sheet on page 5-34 and Creating a 
GeneScan Analysis Sample Sheet on page 5-36. This general information applies to 
both.

IMPORTANT Do not mix sequence analysis and GeneScan analysis samples on the 
same Sample Sheet or the same run.

The information you record in the Sample Sheet becomes the sample 
identification and other sample-related information in the sample file when the 
data is analyzed. The information that you record is critical to the accuracy of 
automatic analysis, and is a good reference for you after data collection.

The Sample Sheet is a two-dimensional array, similar to a spreadsheet or ledger. 
It consists of rows and columns of fields, each field separated by horizontal and 
vertical lines (see Figure 5-13). It accepts more text than fits in the visible fields 
and automatically scrolls as you type your entry. To view the beginning of a long 
entry, use the keyboard arrow keys. Many of the cells have default values that are 
automatically filled in for each sample.

You can use the standard File menu and Edit menu commands in the Sample 
Sheet window. You can import from tab-delimited text files (for instance, files 
generated by a database) and print the window. You can reuse a Sample Sheet as 
often as you wish.

You can export the Sample Sheet as a tab-delimited text file for database, 
spreadsheet, or word processing programs (choose Export from the File menu).
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Importing and Exporting Sample Sheet Information
If you wish to import information from a database into the Sample Sheet, first 
export the information from the database into a tab-delimited text file. Note the 
following:

• The file should contain only the information you wish to import. It should 
not have a header.

• The information imported to the first field in the Sample Sheet is 
everything up to the first tab in the text file.

• Each row in the text file should contain the information for one row in the 
Sample Sheet, in the same order as the Sample Sheet columns.

Exporting a Sample Sheet creates a tab-delimited text file, with the same format 
as a file created for import.

To import a text file to the Sample Sheet:

1. Choose Select All (c-A) from the Edit menu to select all fields in the 
Sample Sheet grid.

2. Choose Import from the File menu.

3. In the dialog box that appears, choose the file you wish to import.

4. Click OK.

To export from the Sample Sheet to a text file:

1. Make sure the Sample Sheet window is active. If it is not, click in it.

2. Choose Export from the File menu.

3. In the dialog box that appears, enter a name for the text file, and then 
choose where to save the file.

4. Click OK.

The exported file has an icon like that of a Log file:



Applied Biosystems

5-34 5  Using the Data Collection Software March 2001

Creating a Sequence Sample Sheet
In the Sequence Sample Sheet you specify dyeset/primer and matrix information 
for each sample you plan to run. You can specify default values for both fields by 
setting preferences. The defaults appear automatically for each sample, but you 
can change them by editing the Sample Sheet. See Setting Defaults for Sequencing 
Analysis Applications on page 5-21. 

To create a new Sequence Sample Sheet:

1. Choose New (z- N) from the File menu.

2. Click the Sequence Sample Sheet icon in the window that appears.

If you set default values they appear in a new Sample Sheet automatically.

Figure 5-13.  The Sequence analysis Sample Sheet

To move from one field to another:

• Click a desired field

• Press the directional arrow keys on the keyboard

• Press Tab to move to the next field to the right

• Press Return to move to the next field down

When you set defaults for mobility and Instrument 
files, the columns are filled in automatically

Click an arrow to display a pop-up menu of options

Click a title 
to select the 
entire column

Sample lane 
numbers
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3. Enter/change information as necessary.

Note To import information from tab-delimited text files, see page 5-33. 

a. In the second column, enter the sample names corresponding to 
each lane number.

b. To choose a DyeSet/Primer mobility file or a multicomponent matrix 
other than the default, click the arrow in the field you wish to change 
and choose the new file from the pop-up menu that appears.

The DyeSet/Primer files and a default matrix file (the Instrument 
file) are provided with your instrument. When you click a field in the 
DyeSet/Primer column, the pop-up menu shows only available 
DyeSet/Primer files.

The DyeSet/Primer file names indicate information that helps you 
choose the correct file. See DyeSet/Primer File Naming Conventions 
in your Sequence Analysis User’s Manual.

For most sequencing chemistries the default matrix supplied with 
your instrument is appropriate. To read about matrices refer to 
Appendix C, Sequencing Instrument File.

Note To apply the same parameter to all fields in a column, select the 
parameter in the top field of the column, click the column title to select 
the entire column, and choose Fill Down from the Edit menu.

c. To enter a comment, click the comment field. An insertion point 
appears, allowing you to type in your comment.

4. Click the close box to accept the entries.

Note If you analyze with the wrong dye/primer set, you can use manual 
analysis to re-analyze the data against the correct set. Refer to the 
ABI PRISM DNA Sequencing Analysis Software User’s Manual.
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Creating a GeneScan Analysis Sample Sheet
In the GeneScan Sample Sheet, in addition to Matrix defaults, you can specify 
preferences for the size standard and the dye color used for the standard (see 
Setting Defaults for GeneScan Analysis Applications on page 5-25). The defaults appear 
automatically for each sample, but you can edit them in the Sample Sheet.

To create a new GeneScan Sample Sheet:

1. Choose New (z- N) from the File menu.

2. Click the GeneScan Sample Sheet icon in the window that appears.

Figure 5-14.  GeneScan Sample Sheet

To move from one field to another:

• Click a desired field

• Press the directional arrow keys

• Press Tab to move to the next field to the right

• Press Return to move to the next field down
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3. Enter/change information as necessary.

a. Type a descriptive sample name in the Sample Name column.

b. Select a size standard dye color.

The size standard marker (X) appears in the Std field next to the 
specified standard dye. You can mark only one size standard for each 
sample, and each sample can include up to four dyes per sample.

c. Enter dye/sample information in the Sample Info column.

The checkbox labeled Used becomes selected so the sample can be 
analyzed automatically.

d. To enter a comment, click the Comments field.

A text entry box appears, allowing you to type in your comments.

Note To import information from tab-delimited text files, see page 5-33. 

IMPORTANT For downstream analysis and sorting, you must fill out both the Sample 
Sheet and the Sample Information window when you create a new 
GeneScan Sample Sheet.

4. Choose Save from the File menu. 

Editing a Sequence or GeneScan Analysis Sample Sheet
When you edit Sample Sheets the general procedure is the same, whether it be a 
Sequence Sample Sheet or a GeneScan Analysis Sample Sheet. Follow the general 
procedure described here, and refer as necessary to the instructions for creating 
the individual Sample Sheets.

Note The Sample Sheet can contain up to 72 rows. If you insert rows beyond 
that, the last row in the sheet is dropped off.

You can use the standard Edit menu commands for the File Name, Sample Name, 
or Comments fields.



Applied Biosystems

5-38 5  Using the Data Collection Software March 2001

To modify an existing Sample Sheet:

1. Choose Open (z- O) from the File menu, and choose the file you want 
from the file dialog box that appears.

2. Edit fields as described for the individual Sample Sheets.

3. Save the Sample Sheet by choosing Save As from the File menu.

Be sure to save the file under a different name, so you preserve the original 
file.

Note You cannot change a run in progress by editing the Sample Sheet. You 
can change the Sample Sheet, but cannot re-select it in the Run 
window while the run is in progress. The changes are therefore not 
effective for the run in progress.

To move between fields in the Sample Sheet:

• Click a desired field

• Press the directional arrow keys

• Press Tab to move to the next field to the right

• Press Return to move to the next field down

To apply the same parameter to all fields in a column:

1. Select the parameter in the top field of the column.

2. Click the column title to select the entire column.

3. Choose Fill Down (c-D) from the Edit menu.

To copy information from one field to another:

1. Click the field to be copied.

2. Choose Copy (c-C) from the Edit menu.

3. Click the new field.

4. Choose Paste (c-V) from the Edit menu.
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To copy an entire row of information to another row:

1. Click the lane number in the left-most column to select the entire row.

2. Choose Copy (c-C) from the Edit menu.

3. Click the lane number of the row you wish to copy into.

4. Choose Paste (c-V) from the Edit menu.

To move sample information to a different lane:

• Hold down the Option key and click the lane number of the row 
containing the information you want to move, and drag the lane number 
to another lane number.

When you release the mouse button the sample information appears in the new 
location. The lane number does not move.
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Using the Run Window

In the Run window you specify the lane in which each sample will run and the 
modules containing the parameters to be used for the run. You also use this 
window to start a plate check, a pre-run, or a run. 

Separate Run files exist for sequencing and GeneScan analysis applications. Be 
sure to choose the correct type for your application.

Opening the Run Window
1. Choose New from the File menu and click the appropriate Run icon.

This automatically creates a new Run folder, and opens the Run window.

Figure 5-15.  Sequence Run window

Run control 
buttons

Pop-up menus in 
these panels 
allow you to 
choose the 
modules 
(parameters), 
the associated 
Sample Sheet, 
the number of 
wells, the 
separation 
distance (WTR), 
and the 
Instrument file 
for the run

Small document icons open the selected 
module or Sample Sheet for review

Lane numbers cannot be edited

Specify length of run

Select filter set
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Figure 5-16.  GeneScan Run window

You need not complete the entire window to perform a plate check. You 
must do so to run samples.

Completing a Run Window
You must complete the information in the Run window before pre-running a gel 
or running samples.

To complete the Sequence Run window:

1. Choose the parameters for the run from the pop-up menus.

a. Choose modules to be used for the plate check, the pre-run and the 
run in the Module pop-up menus. 

b. Choose the Sample Sheet from the Sample Sheet pop-up menu.

When you choose the Sample Sheet, the information about the lanes 
in which the samples are to run fills in automatically. 

Run control 
buttons

Pop-up menus in 
these panels allow 
you to choose the 
modules 
(parameters), the 
associated 
Sample Sheet, the 
number of wells, 
the separation 
distance (WTR), 
and the matrix for 
the run

Small document icons open the selected 
module or Sample Sheet for review

Lane numbers cannot be edited

Specify length of run
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c. Choose the number of lanes and the separation distance from the 
Lanes pop-up menu and the WTR pop-up menu, respectively. 

d. Choose an instrument file from the Instrument File pop-up menu.

Appendix D describes creating and using matrices.

e. Choose XL Scan or Full Scan in the Run Mode pop-up menu. Use the 
table below to determine the appropriate run mode for your lane 
configuration. 

2. Enter the length of the run in the Collect Time entry field. Following are 
some suggested run times for Sequencing runs.

3. Enter your name in the Operator entry field.

The sample information for each lane is entered automatically in the grid 
at the bottom of the Run window when you choose a Sample Sheet. 

Note You cannot edit the Sample Sheet information in the Run window. 
Make changes in the Sample Sheet, and select the Sample Sheet 
again in the Run window to make the changes effective.

4. Choose the appropriate filter set:

Lanes Comb Run Mode
24 Sharks-tooth Full Scan
32 Sharks-tooth Full Scan
36 Sharks-tooth Full Scan
36 Square-tooth Full Scan
48 Sharks-tooth XL Scan
64 Sharks-tooth XL Scan

Plate length 
(cm)

Type of Run Typical Collection Time 
(hours)

24 Full Scan or XL Scan 12
24 BaseSprinter 6.5
34 Full Scan or XL Scan 14
34 BaseSprinter 7
48 Full Scan or XL Scan 16
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For Sequenase T7 Terminator chemistry: Select filter set B. 

For all other sequencing chemistries: Select filter set A.

5. Select the Auto Analyze and Auto Print checkboxes if you want the analysis 
program to analyze and print the data.

To complete the GeneScan Run window:

1. Choose the parameters for the run from the pop-up menus.

Note Any changes you make in your preferences setting will not take effect 
until you open a new Run window.

a. Choose modules to be used for the plate check, the pre-run and the 
run in the Module pop-up menus. 

b. Choose the Sample Sheet from the Sample Sheet pop-up menu.

When you choose the Sample Sheet, the information about the lanes 
in which the samples are to run fills in automatically. 

c. Choose the number of lanes and the separation distance from the 
Lanes pop-up menu and the WTR pop-up menu, respectively.
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d. Choose XL Scan or Full Scan in the Run Mode pop-up menu. Use the 
table below to determine the appropriate run mode for your lane 
configuration. 

Note If you select a run mode that is incompatible with the selected lane 
configuration, the lane popup menu displays <none>.

e. Choose a matrix file from the Gel Matrix pop-up menu.

Appendix D describes using and creating matrices.

2. Enter the length of the run in the Collect Time entry field. Following are 
some suggested collection times.

3. Enter your name in the Operator entry field.

As noted, the sample information for each lane is entered automatically in 
the grid at the bottom of the Run window when you choose a Sample 
Sheet. 

Lanes Comb Run Mode
24 Sharks-tooth Full Scan
24 Square-tooth Full Scan
32 Sharks-tooth Full Scan
34 Square-tooth Full Scan
36 Sharks-tooth Full Scan
36 Square-tooth Full Scan
48 Sharks-tooth XL Scan
50 Square-tooth XL Scan
64 Sharks-tooth XL Scan
66 Square-tooth XL Scan

Plate length 
(cm)

Typical Collection Time 
(hr)

6 1.5
12 4
24 8
34 10
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Note You cannot edit the Sample Sheet information in the Run window. 
Make any changes in the Sample Sheet, select <none>, and then 
select the Sample Sheet again in the Run window to make the changes 
effective.

4. Choose the appropriate filter set: A or B. 

IMPORTANT Failure to select the appropriate filter set results in the loss of data.

5. Select the Auto Analyze and Auto Print checkboxes if you want the analysis 
program to analyze and print the data.

6. Complete the information in the Run window, save the file, and start a 
plate check or start a pre-run or run, as described in Starting a Pre-run or a 
Run on page 5-45.

Starting a Pre-run or a Run
You can start a pre-run or a run either from the Run window or by using menu 
commands from the Instrument menu.

IMPORTANT When starting a run, be sure the sample lanes specified in the Run 
window correspond to the lanes you loaded. The sample information in 
the Run window is the information stored in the Gel file when you start 
the run. Changes you make in the Run window after you start the run 
are not implemented.

Starting from the Run Window
When you are finished completing the Run window information, you can start the 
run directly from the Run window, as noted above. Instrument control buttons 
allow you to start, pause, and cancel the run (see Figure 5-15 on page 5-40).

• Click the PreRun button to pre-run the gel. The button becomes active 
when you have entered a module file name for the Pre-run. The Pre-run 
lasts for the period of time specified in the pre-run module listed in the 
Run window, unless you click the Pause button or the Cancel button. 
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Clicking Pre-run causes the instrument to perform electrophoresis, but no 
data is collected.

• Click the Run button to start the run. The button becomes active when you 
have entered enough information in the window to execute a run. Clicking 
Run causes the instrument to perform both electrophoresis and data 
collection.

• The Pause button becomes active when you start a run or a pre-run. Click 
it to temporarily halt the run (for instance, to load samples). When you do, 
the instrument stops electrophoresis. When the run is paused, the Pause 
button changes to read Resume. When you are ready to resume the run or 
pre-run, click the button again. 

Note If you click Pause during a pre-run to load samples, after all samples 
are loaded, click Cancel to stop the pre-run, then click Run to start the 
run.

• Click the Cancel button to stop a pre-run or run. If you cancel a pre-run, 
the module that is running stops and you can start a run. If you cancel a 
run, data collection stops. You cannot continue the run from the point at 
which you cancelled it.

Figure 5-17 shows a typical series of commands for a plate check, pre-run, and run 
on the ABI PRISM 373XL.
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Figure 5-17.  Run window buttons used during a typical run

Button to Click Module in effect Task to perform

Plate Check module Check plates and gel for 
fluorescence

n/a (Stops plate check scan)
Add buffer and check for leaks
Mount front heat-transfer plate

Pre-run module (Electrophoreses gel without 
data collection to equilibrate 
temperature)
Prepare samples while 
pre-running 

Pre-run module Load first set of samples 
during pause

Pre-run module (Electrophoreses samples into 
gel without data collection)

Pre-run module Load second set of samples 
during pause

n/a (Stops pre-run)

Run module (Starts electrophoresis and 
data collection)
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Starting from the Instrument Menu
The Instrument menu contains commands that perform the same functions as the 
Run window buttons (Plate Check, Start PreRun, Start Run, Pause, Resume, and 
Cancel Run). 

To check the plates for contamination:

Choose Start Plate Check from the Instrument menu.

To start a pre-run:

Choose Start PreRun from the Instrument menu.

To start a run:

Choose Start Run from the Instrument menu.

To temporarily stop a pre-run or run (and resume it later):

Choose Pause from the Instrument menu.

To resume a pre-run or run that has been paused:

Choose Resume from the Instrument menu.

To stop a run before it is finished:

Choose Cancel Run from the Instrument menu. This stops the module that is 
running and closes the Run file. You cannot continue the run from the point at 
which you cancelled it.

Note If you are familiar with running the Model 373 before this 
ABI PRISM 373XL DNA Sequencer upgrade, please note the data 
collection program no longer has a controller panel; you do not need to 
select the Collect button.
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Viewing the Data

Using the Data Collection Program Windows
In the collection program you can open all windows at one time, although the 
number might be limited by the available RAM on your Macintosh computer. 
Only one window can be active at any given time. Using these windows you can:

• Monitor the instrument status and error occurrence during a run

• Observe the data as it is generated, in the Scan or Gel views, and monitor 
the electrophoresis power supply

• Record or change sample information on the Sample Sheet

• Set up and start a run

• Set default settings and parameters for automatic analysis

Viewing the data and the instrument status is described here. Descriptions of the 
other functions are found on the following pages: 

Following is some general information about working with windows:

• To move a window around on the screen, click the top border, hold the 
mouse button down, and drag the window to another location. 

• To change the size of a window, click the size box in the lower right corner 
of the window, hold the mouse button down, and drag the mouse to stretch 
or shrink the window. 

• To close a window, click the close box at the upper left corner of that 
window or click in the window to make it active and choose Close (c-W) 
from the File menu. 

To perform this function: See this page:

Record sample information Page 5-32

Set up and start a run Page 5-40

Set defaults Page 5-21 (Sequencing)
Page 5-25 (GeneScan)
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Observing Instrument Status During and After a Run
During a run, you can observe the current status of the ABI PRISM 373XL in a 
status window, which is updated approximately every three seconds. After the run 
is finished, you can view a chronological record of significant system events in the 
Log file.

The Status Window
Open the Status window by choosing Status from the Window menu.

Figure 5-18.  Status Window example

Note The actual power and current readings during electrophoresis change 
gradually throughout the run. Table 5-5 lists the approximate readings 
you should see for power and current under normal running conditions.

Click arrows to 
collapse /expand 
parts of window

Time remaining in 
the function being 
executed 

Green arrow on 
scale indicates 
actual reading from 
the instrument

Gray box to right 
and red arrow on 
scale indicate
value set for this 
parameter by the 
chosen module

The total time selected for the 
function currently being executed 
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The Log File
A Run Log file is created for each run and stored in the Run folder when you start 
the run. To view the Log file, choose Log from the Window menu.

The Log file contains a comprehensive record of all error and status messages 
generated by the data collection program during a sequencing run, including:

• Start and stop times of the run

• Instrument errors and computer errors

These messages can be helpful to Applied Biosystems Field Service Engineers. 

Figure 5-19.  Log window example

The information in the file is formatted as follows:

xxx mm/dd/yy hh:mm:ss description

The entry in the first column, xxx, is variable. The possible entries are:

Table 5-5.  Readings Under Normal Running Conditions

 

Gel (%) WTR (cm) Watts

Approximate Readings
(Volts)

Start End
6 24 30 1200–1500 1800

4.75 34 32 1200–1500 1800
4.0 48 40 1500–1700 2100
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... information (system start or stop, file created)
 - -> message sent to instrument
<- - message received from instrument
*** warning
### error

The information in the second column shows month/day/year and 
hours:minutes:seconds, formatted as shown. The third column has a brief 
description of the event.

A Log file can get as big as your available disk space, although you can only view 
the last 32K of information using the data collection program. You can use a word 
processing program to view larger Log files.

Viewing Data
You can view information from a run in real time during data collection. The Scan 
window and the Gel window display the data being collected, and the 
Electrophoresis History window displays the set and actual values for the 
temperature and the electrophoresis power supply.

The real-time data display differs from the display of data after analysis, as 
described next.

Filters and Color of Data Display 
On the real-time displays (the Scan window and the Gel window), the data 
collection program displays these intensities, color-coded according to 
wavelength. Blue, green, yellow, and red (in that order) represent the wavelengths 
of the dye emissions within each dye set. Blue represents the shortest wavelength, 
and red represents the longest. The colors on the real-time displays therefore 
represent the wavelengths of the dyes being detected, rather than the bases being 
detected.

Each of the three chemistries used for preparing DNA is associated with one of 
the dye sets. Each dye set labels the four bases differently, so the relative 
wavelength, and therefore the color, associated with each base varies with the 
chemistry used to label it. Because of this, the four colors on the real-time displays 
represent different bases, depending on the chemistry used for labeling.
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Table 5-6 describes the colors that represent each of the four bases on the 
real-time displays.

Note The Sequencing Analysis program converts the information collected 
by the data collection program, so after analysis the colors are the 
same for each base: Blue for C, Green for A, Yellow* for G, 
and Red for T.

Table 5-7 shows the filter and its band pass wavelength for each filter set, and 
which dyes are detected with each filter. For GeneScan applications, it is 
important to have a multi-component matrix for every combination of dye sets 
you use. In some instances, you may need to make matrices specific for the gel type 
as well, as the spectral properties of the dyes are different under denaturing and 
native conditions. Because no two band pass filters (of the same wavelength) are 
exactly the same, it is necessary to make matrices for each instrument used.

Table 5-6.  Color Guide for Data Collection Program Raw Data Sequencing Displays 

Filter A Filter B

Color Taq and T7 Primers
(Dye Set 1)

Taq Terminators
(Dye Set 2)

T7 Terminators
(Dye Set 3)

Blue C G T

Green A A C

Yellow G T A

Red T C G

* When printed, G is black, so it is easier to see.
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Table 5-7.  GeneScan Filter Set Table

Filter Set
Band Pass Filters

531 545 560 580 610
Blue Green Yellow Red

A
5-FAM
R-110
6-FAM

--
HEX 

R6G

TAMRA ROX 

Blue Green Yellow Red

B 5-FAM
6-FAM

TET HEX 
JOE 

TAMRA 
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The Scan Window
Viewing the Scan window is one of three methods of viewing real-time data. Raw 
data appears in the Scan window, always in real time. To display the Scan window, 
choose Scan from the Window menu.

The Scan display shows the sweeps of the laser across the gel, with a different 
colored line representing each filter. The computer simultaneously updates the 
Scan window with four lines every few seconds during instrument operation.

Figure 5-20.  Scan window example

Note You can set the scale of the Scan window by choosing Set Scale from 
the Edit menu. A dialog box allows you to enter minimum and maximum 
values for the scale.
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The Gel Window
To display the Gel window, choose Gel Image from the Window menu.

Figure 5-21.  Gel window example

This window is a reconstruction of actual data similar to the way it would appear 
as an autoradiogram, but in color. The first fragments passing the laser appear at 
the bottom of the screen and move toward the top of the screen as new data is 
recorded throughout the run. By the end of the run, the window appears similar 
to an autoradiogram with the smaller DNA fragments near the top and the larger 
fragments near the bottom. Remember, however, that this window is a re-creation 
of the data through time and does not indicate the physical position of the 
fragments. 

Note You can scroll up or down or resize the Gel window to see the entire gel 
image representation.
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The Electrophoresis History Window
To display the electrophoresis history window, choose Electrophoresis History 
from the Window menu.

This window displays the set and actual values for the electrophoresis power 
supply and gel temperature throughout the course of an electrophoresis run. The 
scale for each panel is adjustable (see below). 

Figure 5-22.  Electrophoresis History window example

A green graph represents the actual value; a red graph represents the target. 
When the actual and target are identical, the green covers the red. This allows you 
to quickly check the status of the instrument visually: red alerts can indicate 
potential problems, although some fluctuation is normal.

Click here to adjust scale

Scan numbers
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Note The information in the Electrophoresis History window is stored in the 
Gel file.

To adjust the scale:

1. Double-click one of the panels in the window, or click a panel once and 
choose Scale from the Edit menu.

Figure 5-23.  Set Scale dialog box

2. In the entry fields of the dialog box that appears, type the minimum and 
maximum values you wish to display.

3. Click OK.

Viewing Other Run-Related Information
The Sample Sheet 
To display the Sample Sheet that is associated with the current run, choose 
Sample Sheet from the Window menu. This option is available only if a Sample 
Sheet is listed in a currently open Run window. See page 5-32 for details about 
creating or editing a Sample Sheet. 

The Run File
To display the Run file for the current run, choose Run from the Window menu. 
See page 5-40 for information about creating the Run file.
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Controlling the ABI PRISM 373 DNA Sequencer 
with XL Upgrade Manually

In Manual Control mode, you can change the instrument settings in real time. 
Functions you specify from the Manual Control Function pop-up menu are 
executed immediately when you click the Execute button, and remain in effect 
unless functions in a running module override them. You can run a module 
manually only when the instrument is not running any other module.

To control the instrument manually:

1. Choose Manual Control from the Window menu.

Figure 5-24.  Manual Control window

2. Choose a function or a module to run. Table 5-8 on page 5-60 lists the 
options.

To choose individual functions:

a. Click the Fxn Name field to choose a function from a pop-up menu.

To control individual functions, choose a function from the Fxn pop-up 
menu, and enter a value that is within the specified range
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b. Enter a value, if necessary, in the Value column of the grid.

The right-most column of the grid lists the range allowed. If you 
choose a function that does not take a parameter, No Value appears 
in the Value field.

To choose a module:

a. Click the Module field to choose the module from a pop-up menu.

3. Start the chosen function or module.

• To start an individual function: Click the Execute button.

• To start a module: Click the Start button.

To pause or cancel a currently running module, click the corresponding button. 
If you click Pause, the text on the button changes to read Resume, and you can 
click it again to resume the function or module.

Table 5-8.  Manual Control Functions

Function Range of Values

Electrophoresis Volts*

* You can manually control these parameters to make any of them limiting, 
but you should be thoroughly familiar with the principles of electrophoresis 
before doing so.

0.00 to 2.50 kV

Electrophoresis Current* 0.00 to 50.0 mA

Electrophoresis Power* 0 to 300 W

Laser Power 0.00 to 40.0 mW
(in 10ths of mW)

PMT Gain 0 to 999 V

Calibration File Make no value

Calibration Send Make no value
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PMT Gain and Calibration File

Checking and Adjusting the PMT Gain 
This section describes, in detail, how to check and adjust the PMT gain. Before 
checking or adjusting the PMT gain, you must have

• placed a gel in the instrument, and

• defined the Collection software preferences

Recommended PMT Gain
The PMT gain should be set such that the lowest scan line (usually the blue line) 
is positioned at approximately 900 on the y-axis in the Scan window display. For 
subsequent runs, the PMT gain needs to be adjusted only if the y-axis value is out 
of the range of 800–1000 on the y-axis. Different PMT gains are required for the 
three run modes (XL Scan, Full Scan, and BaseSprinter).

Checking the PMT
Use the procedure below to check and adjust the PMT gain for a one-time use or 
as part of the procedure to make a calibration file.

To check the PMT gain:

1. Choose New from the File menu.

2. Click the Sequence Run icon in the window that appears.

3. Complete the following information in the Run window.

a. Choose Plate Check from the Plate Check Module pop-up menu.

b. Choose the appropriate run mode from the Run Mode pop-up menu.

Note You do not need to complete the other information in the Run window 
to perform a plate check or create Calibration File.

4. Click the Plate Check button. 

5. Allow time for the Translation Processor to update the scan window and 
then view the four scan lines in the Scan window.
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6. Position the mouse so the tip of the arrow just touches a flat section of the 
lowest scan line (usually the blue line).

Figure 5-25.  Scan lines at the recommended range

Note You can set the scale of the Scan window by choosing Set Scale from 
the Edit menu. A dialog box allows you to enter minimum and maximum 
values for the scale.

7. Read the y-axis value displayed in the upper-left hand corner of the scan 
window.

• If the lowest scan line is positioned between 800–1000 on the 
y-axis, cancel the plate check. Proceed to step 8.

• If the lowest scan line is outside of the recommended range 
(800-–1000 on the y-axis), then proceed to Adjusting the PMT Gain.

8. Cancel plate check in the run window. If you wish to make a calibration file 
for this PMT gain setting, then proceed to Making and Sending a Calibration 
File on page 5-63.

Read y-axis here
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Adjusting the PMT Gain

To adjust the PMT gain:

1. While the plate check is running, choose Manual Control from the 
Window menu.

2. Adjust the size and position of the Scan and Manual control windows so 
that you can see both windows (no overlap).

3. In the Manual Control window, choose PMT Gain from the Fxn Name 
pop-up menu. 

4. Enter a new value then click Execute.

Entering a larger number than displayed in the value box will shift the scan 
lines up in the scan window. A smaller number will shift them down.

5. Click on the scan window to make it active. Allow time for the Translation 
Processor to update the scan window , and then check the y-axis value.

6. Repeat steps 4 and 5 until the PMT gain is within the recommended range.

7. Cancel the Plate Check. If you wish to make a calibration file for this PMT 
gain setting, then proceed to Making and Sending a Calibration File on page 
5-63.

Making and Sending a Calibration File
This section describes how to make and send a Calibration file. Before making a 
calibration file, you must:

• have a gel loaded in the instrument and

• know how to performed a plate check to obtain a valid PMT gain for each 
of the run modes

Calibration File
A calibration file is a single file which stores the PMT gain settings for the three 
run modes (XL Scan, Full Scan and BaseSprinter). When a calibration file is 
created, the file is named ABI 373XL Calibrations and is stored in the Preferences 
folder inside the System folder of the Macintosh. This file can be opened and read 
with the SimpleText application.
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Making a Calibration File
The function Calibration File Make in manual control is used store a valid PMT 
gain value for each run mode into the ABI 373XL Calibrations file.

To make a calibration file:

1. Perform a plate check in the XL Scan mode; adjust the PMT gain, if 
necessary.

2. Perform a plate check in the Full Scan mode; adjust the PMT gain, if 
necessary.

3. Perform a plate check in the BaseSprinter mode; adjust the PMT gain, if 
necessary.

4. Choose Manual Control from the Window menu.

5. Choose Calibration File Make from the Fxn Name pop-up menu. 

6. Click Execute.

7. The PMT gain values for the three run modes are saved in the ABI 373XL 
Calibrations file.

Sending a Calibration File
The function Calibration File Send sends a copy of the information (PMT gains) 
in the ABI 373XL Calibrations file to the Translation Processor’s non-volatile 
memory. The Translation Processor uses these stored PMT gain values for 
subsequent runs.

To send a calibration file:

1. Open the Manual Control window, if it is not already open.

2. Choose Calibration File Send, then click Execute.

3. A copy of the calibration values now reside in non-volatile memory in the 
Translation Processor.
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Saving and Printing Files

Saving Files

The log file created during a run is automatically saved in the corresponding Run 
folder. When you close Sample Sheet, run, or preferences windows, the settings in 
those windows are stored in the appropriate files. The files are named according 
to the default File Names preferences (see Setting File Name Preferences on page 
5-18), and are stored in the default folder locations specified in preferences.

You can open most files using the Open command in the File menu, and save 
them by choosing Save from the File menu. If you open and change a Sample 
Sheet, Run file, or Module window, you might want to save it under a separate file 
name to preserve the original information.

To save an altered file under a new name:

1. Choose Save As… from the File menu.

2. When the standard file dialog box appears, type a name for your file in the 
entry field, and select a location for it.

3. Click Save.

To save a backup copy of the file you are working with:

1. Choose Save a Copy In from the File menu.

2. When the standard file dialog box appears, type a name for your file in the 
entry field, and select a location for it.

3. Click Save.

A backup copy of the file is saved with the new file name, and the original 
file remains on your screen.
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Archiving Files

Gel Files
Gel files contain the raw data acquired by the data collection program and 
typically take up 10–55MB of disk space. A separate Gel file is created in the Run 
folder each time you perform a run. Because Gel files take a substantial amount 
of space, you should delete them from your hard disk after you have obtained 
satisfactory Sample files. You do not usually need to keep gel files once the 
tracking is verified and sample files are created. 

If you do wish to archive Gel files, use magnetic tapes, removable cartridge drives, 
or optical drives. Gel files are too large to fit on disks.

IMPORTANT Do not discard any gel file until you have verified the tracking and taken 
corrective action if necessary.

Sample files
Use disks, a magnetic tape drive, a removable cartridge drive, or an optical drive 
to archive sample files. A 1.4MB, high-density disk holds about six files. A sample 
file is 150–200KB in size, depending on the length of the sequencing run. Save a 
sample file when you feel confident that the channel selections (tracking) are 
correct for the sample.

Printing Files

You can print the contents of any of the editable windows (Sample Sheet, Run 
window, Module window).

To specify the location of the printer and the desired printer driver, choose 
Chooser from the Apple menu, and then highlight the printer and driver. 

Setting Up the Page for Printing
Before you print, you can specify certain parameters about the printout, such as 
the paper size, the orientation of the page, and whether or not the print should 
be reduced from actual size. To do so, choose Page Setup from the File menu.

The appearance of the Page Setup dialog box depends on the printer you are 
using. For information about the other default settings, refer to your printer 
manual.
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You must also designate the format of your printed analyzed data through the 
appropriate analysis program. Refer to the Sequence Analysis and/or the 
GeneScan Analysis preferences.

Printing

Note If you choose Auto Print for your samples in the Run window, 
electropherograms are automatically printed for them after the 
collected data is analyzed.

To print the contents of a window:

1. Make sure the printer is on and loaded with paper. 

2. Click the window you wish to print to make it active.

3. Choose Print (c-P) or Print One from the File menu.

Print One prints the window immediately, bypassing the standard print 
dialog box.

If you choose Print, you can set the number of copies and the pages that 
you want to print. The appearance of the print dialog box depends on the 
printer you are using.

4. Click Print.

Importing and Exporting Files

Exporting
Use the Export command to save the contents of a window grid (for instance, 
from the Sample Sheet or the Run window) into a tab-delimited text format. This 
format is useful with most database, word processing, or spreadsheet programs.

To export information to tab-delimited text format:

1. Click the window containing the information you wish to export, to make 
it active.

The window must be one of the windows containing a grid. The 
information in the grid is exported.

2. Choose Export from the File menu.
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3. Type a file name in the dialog box that appears.

4. Click OK.

Importing
You can also import from tab-delimited text files into the grids of the Sample 
Sheet and Run windows. Each row in the text file should contain the information 
for one row in the grid, in the same order as the columns of the grid.

To import tab-delimited text files into the data collection program windows:

1. Open the window into which you wish to import information and click the 
top left column of the grid.

1. Choose Import from the File menu.

2. In the dialog box that appears, choose the name of the file containing the 
text you wish to import.

3. Click OK.

Note Everything up to the first tab in the text file is imported into the first field 
in the grid.

Quitting the Data Collection Program

Be careful not to quit the data collection program while a run is in progress. If you 
do, however, a dialog box appears asking you if you want to quit.

To close any open windows:

Click a window to make it active, then close it in one of the following ways:

• Click the close box in the upper left corner of the window, or

• Choose Close from the File menu.

The current settings in the window are saved.

To quit the data collection program:

Choose Quit (z-Q) from the File menu.
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Note If a run is in progress, a dialog box asks you to verify that you want to 
quit. Quitting while a run is in progress cancels the run. If data collection 
is in progress, the collection is stopped, but collected data is not lost. 
You can use either analysis program to open the Gel file containing the 
collected data.
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About Data Collection Program Files

Numerous files are stored on the computer that runs the ABI PRISM 373XL. The 
application program and various ancillary files are organized in folders on your 
hard disk as shown in Figure 5-26 on page 5-71.

The ABI PRISM 373 DNA Sequencer with XL Upgrade folder contains the 
program file and folders for Sample Sheets, modules, runs, and settings.

Other files are located in the ABI folder (see Figure 5-26 on page 5-71). This ABI 
folder should always be in the System folder on your hard disk. It is the default 
Settings folder for the data collection software. 

IMPORTANT Although you can change the location specified as the Settings folder 
in the data collection software, the Settings folder must always be the 
ABI folder if you use the Sequencing Analysis program to analyze your 
data.
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Figure 5-26.  ABI PRISM 373XL file locations on the computer

Files in the ABI folder in the System Folder

The first time you 
start the data 
collection program 
the software copies 
the Image file to the 
instrument firmware

The Settings folder can 
contain preferences and 
special files used by the data 
collection and analysis 
programs. The default settings 
folder is the ABI folder in the 
System folder.
If you use the Sequencing 
Analysis software, you must 
leave the settings files in the 
ABI folder.

The Module folder 
contains the module 
files that provide 
instructions to the 
instrument during plate 
check, pre-run and run

The Runs folder 
contains an 
individual folder for 
each run. Each 
individual run folder 
contains the Run file, 
the Gel file, the Run 
Log, and, after 
analysis, the Sample 
files

Sample Sheets 
you create are 
stored in the 
Sample Sheets 
folder

Folders and Files in the ABI PRISM 373 DNA Sequencer with XL Upgrade Folder

373XL
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ABI PRISM 373 DNA Sequencer with XL Upgrade Data Flow

Figure 5-27 shows the flow of data between the Macintosh computer and the 
ABI PRISM 373 instrument during data collection.

Figure 5-27.  Data collection program data flow

Macintosh ComputerABI PRISM 373 Instrument

The Run file associates a list of samples with an electrophoresis module. The instrument receives the 
run data and sends back raw data to a Gel file, which is passed to the appropriate analysis program.
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Input and Output Files

The following describes the files that contribute information for software 
operation (input), the files created by the software (output), and the files located 
in the ABI folder (which contains both input and output files).

Input Files
The ABI PRISM 373XL input files contribute to operation of the instrument. Table 
5-9 details the input files that are not located in the System folder. Output files are 
described in Table 5-10 on page 5-74. The files that must be located in the System 
folder are described in Table 5-11 on page 5-76.

Table 5-9.  Input Files in ABI PRISM 373XL Data Collection Program  

File Type Location Description

ABI PRISM 
373 DNA 
Sequencer 
with XL 
Upgrade 
Firmware file
(input)

Firmware Image 
folder in the 
ABI PRISM 373XL 
folder

Contains an unalterable copy of firmware code that 
the instrument executes in order to run. This file is 
copied from the computer to the instrument the first 
time you start the ABI PRISM 373XL or if the 
instrument memory is cleared after a major power 
failure.

Program files ABI PRISM 373XL 
folder

Provide the primary input that runs the instrument 
and analyzes data. The data collection program 
collects and stores the data sent from the 
ABI PRISM 373XL during the run.The analysis 
program (Sequencing Analysis or GeneScan 
Analysis) analyzes this data after the run is 
complete.

Run files Individual Run 
folders inside the 
Runs folder inside 
the 
ABI PRISM 373XL 
folder

Each stores information associating specific 
samples with specific lane positions for a particular 
run. It also stores information about the Sample 
Sheet and modules associated with the run. Files 
associated with the run, such as the Run Log, the 
Gel file, and the Sample files, are stored in the Run 
folder.
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Output Files
The instrument automatically places two output files in the Run folder for an 
individual run: a Run file and a status log. Table 5-10 details all of the output files 
that are not located in the System folder and their locations. The files that must 
be located in the System folder are described in Table 5-11.

Sample Sheet 
files

Sample Sheets 
folder inside the 
ABI PRISM 373XL 
folder

Contain the header information that you entered 
into the data collection program Sample Sheet 
window. You can export Sample Sheet files in a 
format that Microsoft Excel can read.

Module files Modules folder 
inside the 
ABI PRISM 373XL
folder

Each contains a list of functions that are used by the 
instrument during a plate check, a pre-run, or a run. 
Module files containing commonly used functions 
are provided with the instrument.

Table 5-10.  Output Files in ABI PRISM 373XL Data Collection Program  

File type Location Description

Gel file Individual Run 
folder inside the 
Runs folder inside 
the 
ABI PRISM 373XL 
folder

A large file created by the data collection program. 
For a typical run a gel file can be very large (over 
20MB). This file contains all raw data acquired by 
the data collection program during the run. It is 
created in the Run folder when you perform a run.

Run Logs Individual Run 
folder inside the 
Runs folder inside 
the 
ABI PRISM 373XL 
folder

Created in the Run folder at the start of each run. 
This text file contains date and time-stamped status 
and error messages that maintain a comprehensive 
history of actions taken, instrument and computer 
conditions, and any errors received. You can view 
and print the log file at any time while the application 
is running.

Table 5-9.  Input Files in ABI PRISM 373XL Data Collection Program  (continued)

File Type Location Description
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Sample (data) 
files
(Analysis 
program 
output)

Individual Run 
folder inside the 
Runs folder inside 
the 
ABI PRISM 373XL 
folder

When you analyze the raw data, the gel file is not 
altered. The Sequencing Analysis and GeneScan 
Analysis programs* extract sample information from 
the gel file to create sample files. Each file contains 
the data for a single sample, or lane, including 
information you entered in the Sample Sheet; raw 
data from the instrument; run start and stop times; 
voltage, temperature and power values during the 
run; analyzed data; and base calls. 
Extracted data depends on tracking: if the tracking 
is incorrect, the Sample files are incorrect.

Sequence files
(Analysis 
program 
output)

Individual Run 
folder inside the 
Runs folder inside 
the 
ABI PRISM 373XL 
folder

The Sequencing Analysis program also creates 
document files called ”.Seq” files (the file names 
always end with “.Seq”). These files show the base 
letter sequence only (or might contain a header, 
depending on the format you choose).You can open 
them from word processing programs and print 
them. You can also save the files in several formats 
that can be read by other software programs. The 
Preferences dialog box in the specific analysis 
program allows you to choose the file format.

* The Analysis programs are described in detail in separate manuals. Refer to the ABI PRISM Sequencing Analysis 
Software User’s Manual or the ABI PRISM GeneScan Analysis Software User’s Manual, as necessary.

Table 5-10.  Output Files in ABI PRISM 373XL Data Collection Program  (continued)

File type Location Description
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Files Located in the System Folder 
The System folder on your Macintosh computer contains both input and output 
files. Some are in the ABI subfolder. Others are in the Preferences subfolder. 
Table 5-11 lists the ABI PRISM 373XL files located in the System folder.

Temporary Files Created in the System Folder 
The software programs create a number of temporary files in the System folder. If 
you happen to see them, leave them alone. The programs delete them when they 
no longer need them. 

Table 5-11.  Input and Output Files in the System Folder 

File type Subfolder Description

DyeSet 
Primer files*
(input)

* Installed by the analysis program

ABI folder Contain dye and primer mobility tables. Applied 
Biosystems supplies these files, which are used by 
both the data collection and the Sequencing 
analysis programs. 

Matrix files*
(input)

ABI folder Contain mathematical matrices that are applied to 
data to correct for spectral overlap.

Preferences 
file (input)

Preferences folder Maintains information about folder locations and 
default file name and settings data.
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About the ABI PRISM 373 DNA Sequencer With XL 
Upgrade 

The ABI PRISM 373 DNA Sequencer with XL upgrade includes a 
microprocessor-controlled electrophoresis and fluorescence detection 
instrument, a Power Macintosh computer, and a Translation Interface Processor. 

Figure 6-1.  ABI PRISM 373 DNA Sequencer with XL Upgrade

It is an integrated system in which all the components have been carefully 
engineered to provide maximum performance.




MacintoshCentris 650

Translation
Interface 
Processor

Power Macintosh

ABI PRISM 373A
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The components of the instrument fall into five major categories.

• Loading: Gel plates
Spacers
Casting comb
Sharks-tooth comb
Square-tooth comb
Comb overlay

• Separation: Electrophoresis power supply 
Buffer chambers, electrodes
Heat-transfer plates (Leon and Stretch)

• Detection: Argon laser and scanning stage
Filter wheel and PMT

• Control: Instrument firmware
Macintosh computer and software.
Main power supply
Translation Interface Processor

System Overview

Using a vertical slab gel, dye-labeled DNA fragments are loaded onto the 
instrument. Voltage is applied, causing the fragments to electrophorese through 
acrylamide gel and separate according to size. 

When the fragments reach a fixed position (the read region) above the lower 
buffer chamber, light from the laser excites the dyes, causing them to fluoresce. 
The laser beam scans back and forth across the read region of the gel. The emitted 
light is collected and focused onto a 5-filter wheel and photomultiplier tube 
(PMT). The computer screen displays information received from the Translation 
Interface Processor in real time. 

At the end of collection, the analysis software can automatically process, analyze, 
and translate the collected data into either base sequence, fragment sizing 
information, or relative concentrations, depending on your application. The 
software also allows you to print the collected data.
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Figure 6-2.  ABI PRISM 373 DNA Sequencer with XL upgrade overview
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The Loading System

Components

Glass Plates
Two specially designed glass plates are used to hold the gel through which DNA 
electrophoreses. 

Figure 6-3.  Glass plates and position of read region (Classic and Leon)

Figure 6-4.  Glass plates and position of read region (Stretch)
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The region of the glass where the laser scans is called the read region, and is the 
located behind the laser beam safety stop when the glass is mounted in the ABI 
PRISM 373 DNA Sequencer with XL Upgrade. It occupies an area of approximately 
16 cm x 2 cm located in the lower center area of the plates, and its location varies, 
depending on the instrument configuration: Classic, Leon, or Stretch (see Figure 
6-3 and Figure 6-4 on page 6-6).

Each time you use the glass plates, use them with the same side of each plate on 
the inside. After the first use, the notched plate has a hydrophobic area where the 
buffer chamber gasket made contact with the plate. You must therefore use the 
notched plate in the same orientation each time to avoid difficulty pouring the 
gel. It is a good idea to mark the outside of each plate the first time you use it. 
Mark the plates with a tiny scratch at the top that doesn’t interfere with the read 
region or the upper buffer chamber seal.

Note Do not touch the cleaned surfaces of the glass plates and wear gloves 
to handle the plates. 

Spacers
The spacers are small straight plastic pieces that determine the thickness of the 
gel. Positioning of the spacers is described in detail in Section 2.

Figure 6-5.  Spacers

Combs
ABI PRISM 373 DNA Sequencer with XL Upgrade lane-forming combs are used to 
create the individual wells at the top of the gel into which you load your DNA 
samples. The Sharks-tooth and square-tooth combs are available for the two 
general applications on the ABI PRISM 373 DNA Sequencer with XL Upgrade. A 
variety of well numbers is available.
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IMPORTANT Always use combs, glass plate spacers, and casting combs as a 
matched set. Do not mix and match material types or thicknesses within 
a set. Mismatching can cause loose-fitting combs, and can result in 
sample leaking and/or damage to the gel.

The sharks-tooth comb and casting comb (Figure 6-6) are used with the 
Sequencing application of the ABI PRISM 373 DNA Sequencer with XL Upgrade. 
The sharks-tooth comb is available with 18, 24, 36, 48, or 64 lanes (wells).

Figure 6-6.  Sharks-tooth comb and casting comb

After pouring the gel solution, insert the casting comb at the top of the gel to 
create a single well or slot. Remove the comb after polymerization. 

The sharks-tooth comb is used to form loading wells. Before loading samples, 
insert the teeth of the comb into the slot formed by the casting comb during 
polymerization. This creates the individual wells into which you load the DNA. 
The comb is marked with lane numbers to facilitate loading. 

Sharks-tooth comb

Casting comb
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The square tooth comb (Figure 6-7) is used with the GeneScan application of the 
ABI PRISM 373 DNA Sequencer with XL Upgrade. It is available with 34, 36, 50, 
and 66 lanes.

Figure 6-7.  Square tooth comb

You need to use only the square tooth comb during gel polymerization. After 
pouring the gel solution, insert the teeth of the square tooth comb into the 
solution so the comb creates individual wells at the top of the gel during gel 
polymerization. After polymerization, remove the comb. You do not need to 
re-insert it when you load samples.
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The Separation System

The Electrophoresis Power Supply

The electrophoresis power supply provides the electrophoresis field across the 
gel. The wattage and voltage are determined by the module you choose in the data 
collection software when you start a run. The electrophoresis supply has a 
maximum output of 3000 volts, 80 mAmps.

Note For Sequencing runs and some GeneScan runs, the ABI PRISM 373 
DNA Sequencer with XL Upgrade uses constant power, rather than 
constant voltage, in order to control temperature.

The Buffer Chambers and Electrodes

The ABI PRISM 373 is supplied with upper and lower buffer chambers. 
Color-coded electrophoresis cables, attached to electrodes installed in the 
properly filled buffer chambers, attach at the top and bottom of the 
electrophoresis chamber, and carry the current that facilitates electrophoresis.
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The Scanning/Detection System

The fluorescent dye labeled fragments passing through the read region (refer to 
Figure 6-9 on page 6-12) of the gel are excited by the argon ion laser. The laser 
beam is directed into the gel at a constant angle by means of the gel optics, which 
are attached to the moving stage. The collection optics are aligned directly in 
front of the point at which the laser beam contacts the gel medium. The collected 
fluoresced light is then passed in turn through four of the five filters. Each filter 
cuts a narrow band of light frequencies corresponding to the emission maxima of 
each of the four dyes. Behind the filter wheel is the photomultiplier tube ( PMT). 
The signal from the PMT is amplified, integrated, and converted to a digital signal 
for transmission to the data acquisition unit (refer to Figure 6-8). 

Figure 6-8.  Diagram of the laser/scanner assembly (top view)
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The Read Region and Run Modes

The read region is the section of the glass plates and gel where the laser scans 
(refer to Figure 6-9). This region is composed of channels at which data is 
collected. The ABI PRISM 373 DNA Sequencer with XL Upgrade is equipped with 
three data sampling or run modes: XL Scan, Full Scan, and BaseSprinter. 

Figure 6-9.  The Read region

XL Scan Mode
Data is collected along the entire read region (approximately six inches). The 
read region is divided into 388 channels or points where data acquisition occurs. 
A single scan of the gel plates with one filter takes 1.5 seconds. A complete scan 
with four filters takes six seconds.

Full Scan Mode
Data is collected along the entire read region (approximately six inches) in the 
Full Scan mode. The read region is divided into 194 channels or points where data 
acquisition occurs. A single scan of the gel plates with one filter takes 1.5 seconds. 
A complete scan with four filters takes six seconds. A complete scan equals one 
data point or one scan number. Either 194 or 388 channels can be used for the 
Full Scan mode.

BaseSprinter Mode
BaseSprinter is available only for Sequencing runs. Data is collected only along the 
center section of the read region (approximately three inches). A single scan of 
the gel plates with one filter takes 0.75 seconds. A complete scan with four filters 

Read region

Read region for Full Scan mode:

Read region for BaseSprinter mode:

0–193 channels

0–193 channels

Read region for XL Scan mode:

0–387 channels
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takes three seconds. A complete scan equals one data point or one scan number. 
BaseSprinter mode defaults to 388 channels, although only the middle 194 
channels are used.

Figure 6-10.  Pictorial representation of sequencing scan mode (filter set A).

Filter Wheel and Data Display

The five bandpass filters contained in the filter wheel are unique to your 
instrument. The center bandpasses of the individual filters are 531, 545, 560, 580 
and 610 nm. The five filters are split into two sets of four, which are called filter 
set A and filter set B. The filters used in filter set A are 531, 560, 580, and 610 nm. 
The filters used in filter set B are 531, 545, 560, and 580 nm. The two filter sets 
cannot be accessed at the same time.

The filter wheel separates the wavelengths emitted by the fluorescent dyes. On the 
real time displays (the Scan and Gel window), the data collection program 
displays these intensities, color-coded according to wavelength. Blue, green, 
yellow, and red (in that order) represent the wavelengths of the dyes’ emissions 
within each dye set. Blue represents the shortest wavelength, and red represents 
the longest. Different filter sets use the same four colors to represent different 
wavelengths, so the colors do not represent the relative wavelengths of the four 
dyes in each dye set.

T
im

e

 0 Channels 193 (or 387)

610 nm filter

560 nm filter

531 nm filter

580 nm filter



Applied Biosystems

6-14 6  Instrument Hardware March 2001

Sequencing
Four filters are used for each sequencing run, one for each dye. Filter set A is used 
with the fluorescent Dye Primer and Taq Terminator chemistries. Filter set B is 
used for the T7 Sequenase Terminator chemistry. 

The colors shown for raw data in the Gel and Scan windows (in the data collection 
program) reflect the filter used to detect each dye. Since base calling has not 
occurred, the colors used do not reflect the bases. Table 6-1 summarizes the 
relationship between the filters, dyes, and color display of raw data. In all analyzed 
data displays and printed sequencing analysis electropherograms, the colors 
correspond to the bases, as follows:

C - Blue, A - Green, G - Yellow (black when printed), T - Red

Table 6-1.  Relationship Between Filters, Sequencing Dyes and Data Display

Filter Center 
Band (nm)

Filter Set A 
Taq Primers

Filter Set A
Taq Terminators

Filter Set B
T7 Terminators

Color Base Color Base Color Base
531 Blue C Blue G Blue T
545 -- -- -- -- Green C
560 Green A Green A Yellow A
580 Yellow G Yellow T Red G
610 Red T Red C -- --
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GeneScan
Nine ABI PRISM dyes are available for labeling DNA fragments. The filter set you 
choose determines what color peaks appear for a particular dye. Each dye is 
detected within its optimum wavelength range through either filter set A or B. 
Table 6-2 summarizes the relationship between the filters, dyes, and color display.

Table 6-2.  Relationship Between Filters, GeneScan Dyes and Data Display

Instrument and Matrix Files

All three sequencing chemistries and GeneScan applications use fluorescent dye 
labels that are excited by an argon ion laser. Although the four dyes that are used 
fluoresce at different wavelengths, there is some overlapping in the emission 
spectra. It is necessary to correct for this overlap (or filter cross-talk) before 
analyzing data.

To accomplish this, a mathematical matrix is created for each chemistry type or 
dye set, and stored in a special file. For sequencing, this file is called an Instrument 
file and contains a separate matrix for each chemistry (dye set) that you run on 

Dyes

Filter Set

A B

Color 
Display

Filter Center 
Band (nm)

Color 
Display

Filter Center 
Band (nm)

Dye HEX Green 560 Yellow 560

 Phosphoramidites 6-FAM Blue 531 Blue 531

TET * * Green 545

TAMRA** Yellow 580 Red 580

NHS Esters ROX Red 610 * *

5-FAM*** Blue 531 Blue 531

JOE*** Green 560 Yellow 560

TAMRA Yellow 580 Red 580

[F]dNTPs RG6 Green 560 Yellow 560

R110 Blue 531 Blue 531

* Not recommended; the filter is not set at the emission maxima
** TAMRA is available as an NHS-Ester or as an [F]dNTP.
*** 5-FAM and JOE are available only as labeled primers in select reagent kits.
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the instrument. For GeneScan, the file is called a matrix file. A different matrix is 
required for each combination of the four dyes used, as well as for each type of gel.

When data is analyzed the appropriate matrix is applied to the data to subtract out 
any emission overlap. The Instrument file or matrix file is attached to a Gel file or 
Sample file when it is created to allow subsequent data analysis. Due to slight 
variations in the filters used in the filter wheels, the instrument and matrix files 
created on one ABI PRISM 373 DNA Sequencer with XL Upgrade instrument are 
not valid on other ABI PRISM 373 DNA Sequencer with XL Upgrade instruments.



Applied Biosystems

March 2001 6  Instrument Hardware 6-17

Translation Interface Processor Status and Control

Translation Interface Processor Control

The Translation Interface Processor, which sits on top of the computer’s CPU, 
serves as the communication link and data buffer/translator between the ABI 
PRISM 373 DNA Sequencer with XL Upgrade and the Power Macintosh.

The power switch is located on the back of the Translation Interface Processor. 
Three instrument status lights and a power light are located on the front of the 
Translation Interface Processor (see Figure 6-11). The status lights are described 
on page 6-19.

The first time you turn on the instrument and start the data collection program, 
the program copies a firmware image to the Translation Inteface Processor (refer 
to Restarting the Macintosh and Loading the Firmware Image on page 8-10). If you turn 
off the instrument between runs, a battery backup holds the image in memory, so 
you do not need to copy it again when you restart the system.

Note In order to maintain the optimum charge on the battery, we recommend 
you leave the Tranlation Interface Processor on when it is not in use.
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Figure 6-11.  Translation Interface Processor

Translation Interface Processor Firmware
Firmware programmed into the Translation Interface Processor itself controls the 
basic functions of the instrument. The Macintosh software communicates 
instructions to the firmware, which then operates the hardware.

If the firmware memory becomes corrupted, you might need to clear the 
Translation Information Processor’s memory so that the Macintosh copies a new 
firmware image into the Translation Interface Processor’s memory the next time 
it connects to the Translation Interface Processor. This process is called Resetting 
the Firmware Image.

ABI PRISM 373 DNA Sequencer with XL Upgrade Data Collection Software
The ABI PRISM 373 DNA Sequencer with XL Upgrade data collection software 
allows you to control and collect data from the instrument. The software 
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communicates instructions to the instrument firmware, which controls the 
hardware operation. In addition to displaying data as it is collected, the software 
allows you to display instrument status during a run.

After data collection, the data collection software can automatically start the 
correct analysis program, if selected.

For more detailed information about the data collection software, refer to 
Section 5. For information about the Macintosh computer hardware, refer to 
Section 7. Each of the analysis programs has a separate user’s manual.

Status Indicators

Three instrument status lights (LEDs) are located on the front and back of the 
Translation Interface Processor. See Figure 8-3 on page 8-9 for the location of the 
lights on the back. The LEDs report the status of instrument and indicate if the 
instrument’s memory appears to be corrupted.

Three LEDs are located on the front of the instrument (see Figure 6-11 on page 
6-18). They indicate instrument status as follows:

• Green indicates that the system is operational or operating. This LED 
comes on after completion of the power-on self tests and blinks during a 
run unless a special condition causes the amber or red LED to light. At the 
end of a run, it stops blinking but remains lit and a blinking amber light 
appears with it to indicate that the run is completed and the instrument is 
operational. When you open the doors (breaking the interlocks) to 
remove the gel, the green light goes steady and the amber light blinks. 
When you close the doors again and the system verifies that the interlocks 
are engaged, the amber LED goes out and the green LED lights again.

• Blinking amber indicates that the instrument is operating but paused, or 
has lost the firmware image. This LED blinks as the Translation Interface 
Processor goes through self-test when you turn the power on. It also blinks 
if you open the instrument door (this breaks the laser and electrophoresis 
safety interlocks), or if you pause the instrument by selecting Pause from 
the Macintosh. At the end of a run, it blinks along with a stable green light 
to indicate that the instrument is operational, but is paused because it has 
finished the run. A blinking amber light, in the absence of of all others 
means the Firmware Image has been lost.

• Red indicates an error condition that must be corrected for the system to 
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run properly. This LED lights if an error is detected during self-test. It also 
lights if any failures are detected during a run (for example, if the 
electrophoresis power or laser fails). Details of errors indicated by the red 
LED appear in the log file on the Macintosh. The red LED also lights if 
communication between the instrument and the Macintosh fails.

Table 6-3 shows some examples of how the LEDs indicate status during common 
and special instrument states.

Table 6-3.  System states indicated by status lights

Indicator State Notes

All off Instrument off

Green (steady) Operational Awaiting Run (no module running)
Passed self-test
Interlocks connected (door closed)

Green (blinking) Operational Run in progress
Run resumed after pause

Green (steady)/
Amber (blinking)

End of run Once instrument door is opened or 
a new module is started, the amber 
light goes off

Amber (blinking)/
Green (steady)/
Red (steady)

Power-up Self test in 
progress

When completed successfully, Red 
and Amber goes off and Green 
stays lit

Green (blinking)/
Amber (blinking)/

Run paused 
Door open

Awaiting Resume
Awaiting door closure

Red (blinking) Self-test failed
Instrument Failure Check Macintosh Error Log

Amber (blinking) Firmware Image lost Re-load Firmware Image
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About the ABI PRISM 373 DNA Sequencer with XL 
Upgrade Computer System

The ABI PRISM 373 DNA Sequencer with XL Upgrade computer system performs 
three primary functions:

• Instrument control

• Data collection

• Data analysis

The Macintosh computer provided with your instrument runs special software 
(described on page 7-5) to perform these functions.

System Requirements

The ABI PRISM 373 DNA Sequencer with XL Upgrade electrophoresis instrument 
is shipped with a Power Macintosh computer. An optional printer is also available. 
If you need to replace the computer, or did not order a printer with the 
instrument, following are specifications for the type of computer system you 
should use with the instrument.

• Macintosh Model: Power Macintosh (contact an Applied Biosystems 
representative for specific models)

• Monitor: Apple Power Macintosh-compatible color monitor, 15-inch display

• Disk Drive: Hard disk with a minimum of 250MB storage (500MB is 
recommended)

• RAM: Minimum 24MB random access memory (32MB is recommended)

Note About 16MB of RAM should be available at any given time to have both 
the data collection and analysis programs open together. To check your 
available RAM, choose About This Macintosh… from the Apple () 
menu.

• Printer: Color printer (contact an Applied Biosystems representative for a 
recommendation)
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• System Software: Macintosh system software version 7.5 or higher

Installing ABI PRISM 373 DNA Sequencer with XL Upgrade 
Software

Your field service specialist installs the ABI PRISM 373 DNA Sequencer with XL 
Upgrade collection software and analysis software on the Power Macintosh while 
installing the instrument. 

If you need to re-load the software at some point, this section describes how to 
load and configure the programs needed to perform data collection and analysis.

IMPORTANT Disable the virus protection software on your Macintosh during the 
installation process. After installation is complete, you can re-enable 
virus protection.

To install the ABI PRISM 373 DNA Sequencer with XL Upgrade software:

Each ABI PRISM 373 DNA Sequencer with XL Upgrade special software program 
installed on your computer (data collection and one or two analysis programs, as 
described below) is shipped on a separate disk. Follow these steps to install the 
ABI PRISM 373 DNA Sequencer with XL Upgrade Data Collection software.

1. Quit any currently running applications.

2. Disable any virus protection software and all other inits by holding down 
the shift key while choosing Restart from the Special menu.

3. Insert the Data Collection Install disk into the 3.5-inch disk drive of your 
computer.

4. Click the Installer icon.

5. Respond to prompts, as appropriate.

The installer script prompts you if you need to insert any other disks, and notifies 
you when installation is completed.

Refer to the individual analysis user’s manual for instructions on installing that 
application.
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When you have completed the software installation, we recommend you rebuild 
the desktop.

To rebuild the desktop:

1. Hold down both the command key (z) and Option key and choose 
Restart from the Special menu.

2. Continue to hold down the two keys until the message “Are you sure you 
want to rebuild the desktop file...?” appears on the screen.

3. Click OK.

Special Software for Data Collection and Analysis

The ABI PRISM 373 DNA Sequencer with XL Upgrade comes with software 
programs that perform raw data collection and data analysis.

The Data Collection software communicates instructions to firmware on the 
instrument that controls instrument function. It also records and displays 
instrument status and raw data during a run. You can specify that it automatically 
open the analysis program for data analysis after the run is completed.

To analyze the data collected, two other software packages are available, 
depending on your application. Normally, one is supplied with your 
ABI PRISM 373XL, depending on the configuration you ordered, although you 
might have ordered both.

• The Sequencing Analysis software analyzes the raw sequencing data 
collected by the data collection program and calls the base sequence. This 
program comes bundled with two other programs, GelDocII and 
DataUtility. GelDocII allows you to perform special tasks relating to Gel 
files. The DataUtility program enables you to make and copy matrices to 
correct for the spectral overlap of the fluorescent dye labels. Refer to 
Appendix C for instructions on using the DataUtility program. It can also 
be used by Applied Biosystems technical specialists to check noise levels.

• The GeneScan Analysis software enables you to use ABI PRISM 373 DNA 
Sequencer with XL Upgrade automated fluorescence detection to size and 
quantify DNA fragments. The program automates the entire process of 
separating, quantifying, and sizing DNA fragments. It also provides 
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flexibility to interactively confirm and fine-tune the data analysis, and 
allows you to display the results of an experiment in several different ways.

Each analysis program is described in detail in a separate manual: the ABI PRISM 
DNA Sequencing Analysis Software User’s Manual and the ABI PRISM GeneScan Analysis 
Software User’s Manual, respectively. For information about the Macintosh 
operating system, refer to the Macintosh System 7 Reference manual.

The data collection software and the analysis program(s) you ordered are 
installed on the Power Macintosh by your field service specialist when the 
instrument is installed, so you do not need to install them yourself.

What You Need to Know About the Macintosh Computer

To run the ABI PRISM 373 DNA Sequencer with XL Upgrade Sequencing System, 
you should be familiar with basic Macintosh computer vocabulary and operations, 
such as the following:

• Using the mouse: clicking and double-clicking, selecting and dragging

• Choosing commands: using menus, dialog boxes, radio buttons, checkboxes

• Working with windows: opening and closing, re-sizing and repositioning, 
scrolling, understanding the active window

• Using the Macintosh hierarchical file system: finding files and creating folders



Applied Biosystems

March 2001 7  Computer System 7-7

Maintaining and Caring for Your Macintosh 
Computer 

Computers require regular attention and maintenance to operate efficiently and 
consistently. Because the ABI PRISM 373 DNA Sequencer with XL Upgrade 
software on the Macintosh computer  works with large files and accesses the hard 
disk often, it is especially important that you follow the procedures described here 
to minimize the occurrence of errors during operation. These procedures should 
help keep your Macintosh computer operating at maximum efficiency. 

The following describes procedures recommended by Apple Computer, Inc. and 
Applied Biosystems for regular maintenance of Macintosh computers, and 
includes some hints specifically aimed at keeping your ABI PRISM 373 DNA 
Sequencer with XL Upgrade software running smoothly.

Hard Disk Maintenance

The following general principles can benefit all Macintosh system users. Follow 
these guidelines for optimal performance of the ABI PRISM 373 DNA Sequencer 
with XL Upgrade programs and the Macintosh computer.

• Install only one System per hard disk.

• Back up all programs and files regularly.

• Restart the Macintosh computer before each ABI PRISM 373 DNA 
Sequencer with XL Upgrade run.

• Remove non-essential files from the hard disk.

• Use a hard disk maintenance program every 2–4 weeks (see Use a Hard Disk 
Maintenance Program Regularly on page 7-9).

IMPORTANT With the large size of gel files and the constant reading and writing to 
the hard disk, defragmentation with DiskTools ((included on the Mac 
Operating System CD-ROM) or Norton Utilities (from Symantec) is 
required every 2 to 4 weeks.

• Use discretion when adding software programs, especially extension files.
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Install Only One System Per Hard Disk
The Macintosh computer requires only one System file to operate. This System file 
is located in the System Folder on your computer’s hard disk, and is essential for 
all operations on the Macintosh computer. The file contains critical information 
necessary to monitor and direct all interactions between you and the computer. 

Note Be sure to safely store the System and Utilities disks that came with 
your Macintosh computer. Because they are useful if you have 
problems starting the hard disk, you should make an extra copy of each 
of these important disks.

You do not receive a System file with the ABI PRISM 373 DNA Sequencer with XL 
Upgrade programs, but some other applications might furnish an additional 
System file. Whenever you copy a program from a disk to your hard disk, avoid 
copying additional System files. 

For more complete information about the System file and the System Folder, refer 
to the Macintosh System 7 Reference manual.

Back Up All Programs and Files Regularly
Although the hard disk is extremely reliable, always back up, or copy onto disks, 
the data files on your computer’s hard disk so you do not lose any data. The time 
you spend making copies of your files is minimal compared to the time you might 
spend if your hard disk fails and you must completely re-create all your files. You 
should also keep the original program disks for your software programs in a safe 
place, so you can reinstall the programs if necessary.

When you use the ABI PRISM 373 DNA Sequencer with XL Upgrade data 
collection and analysis programs regularly, several large data files might 
accumulate on your hard disk. These large files can eventually use up all your 
available Macintosh storage. Make copies of the data files you do not use regularly 
and remove the originals from your hard disk to reclaim storage space for future 
work. 

Restart the Macintosh computer Before Each ABI PRISM 373 DNA 
Sequencer with XL Upgrade Run
Restarting clears the random access memory (RAM) and provides access to the 
necessary amount of memory to start data collection.
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Remove Non-essential Files From the Hard Disk
It is a good idea to remove any unnecessary files from the hard disk before starting 
the data collection program. This ensures that you have enough disk space to 
store the new Gel file and Sample files for a new run.

To remove a Gel file from your hard disk:

1. Drag the Gel file into the trash can.

2. Choose Empty Trash from the Special menu. 

The files are not removed from the hard disk until you empty the trash.

Rebuild the Desktop Regularly
Rebuild the desktop monthly and after installing any new software.

To rebuild the desktop:

1. Hold down the Command (c) and Option keys and choose Restart from 
the Special menu.

2. Continue to hold down the two keys until the message “Are you sure you 
want to rebuild the desktop file...?” appears on the screen.

3. Click OK.

Use a Hard Disk Maintenance Program Regularly
Whenever you write files to the hard disk, and then open and rewrite them, their 
physical location on the disk can change. This causes the computer memory to 
become “fragmented.” If a significant amount of fragmentation occurs, the system 
might run more slowly, and files might be lost. It is extremely important that you 
protect your data by running a disk optimizer program regularly.

Optimize the hard disk monthly with Disk Express II, the Speed Disk utility in 
Norton Utilities (from Symantec), or a similar program, to prevent the hard disk 
from becoming too fragmented. Be sure to back up custom matrix files (in the 
folder designated as the Settings folder—refer to Setting Folder Location Preferences 
on page 5-16) and any important data before you optimize the hard disk.
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Use Discretion When Adding Software Programs
• Keep SAM Intercept (from Symantec) loaded on your hard disk to check 

any disks you insert, and use it to inspect your hard disk either when you 
start up or shut down the disk (at least once a day). Make sure you have a 
current version of SAM (version 4.08 or later).

Viruses can simply be annoying, but they can also, in the worst case, destroy 
all information stored on your hard disk. This could include the System 
software, ABI PRISM 373 DNA Sequencer with XL Upgrade software, and 
data files.

• Prevent program conflicts before they occur. Do not load games or other 
software programs onto your hard disk. Use the Macintosh computer only 
for ABI PRISM 373 DNA Sequencer with XL Upgrade software.

• Do not use any programs that require the installation of additional 
extensions. This includes games that might have custom sounds or 
graphics. Use only those that came on your original System Disks, or on the 
ABI PRISM 373 DNA Sequencer with XL Upgrade software disks.

Extensions reside in your extension folder in your system folder. They 
actually alter the programming code of the system. Compatibility with the 
ABI PRISM 373 DNA Sequencer with XL Upgrade software is only 
guaranteed for the extensions shipped with your system. Even seemingly 
innocuous extensions like After Dark, a screen saver, can interfere with 
operations.

While it is unlikely, you might experience conflicts from some extensions 
that you think you must use. For example, different printers might have 
extensions that access them. If you think a conflict exists, turn off specific 
extensions, or all extensions, restart your Macintosh computer, then try 
running without the suspect extensions. 

You can turn off all extensions by holding down the Shift key while you 
restart your computer. You will need to restart it again to turn them back 
on.

• If your System is ≥ 7.5, you have Extensions Manager. Do not keep the 
programs Init Picker, used previously with your Model 373, and Extensions 
Manager on the same volume.
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Error Messages

Following the procedures and precautions described above reduces the 
probability of errors occurring during ABI PRISM 373 DNA Sequencer with XL 
Upgrade runs. Unfortunately, it might not prevent errors from occurring 
altogether, so you still might see error messages after performing a run.

Note If you experience recurring errors, use a hard disk utility program to 
check and repair any damage on the hard disk. After it is repaired, 
follow all of the preventative maintenance procedures described in this 
document.

Hard Disk Maintenance Programs

Following is a limited list of maintenance programs that you can use to check or 
maintain your hard disk.

• Disk Express II AlSoft

• Norton Utilities Symantec

• Public Utilities Fifth Generation

• SilverLining La Cie

• CP Optimizer Central Point Software

• DiskTools Included on the Mac Operating System CD-ROM

IMPORTANT Do not use automatic optimization features that might optimize the hard 
disk in the background while collecting ABI PRISM 373 DNA Sequencer 
with XL Upgrade data. This could cause loss of data.
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Backing Up Important Files Before Optimizing Your Disk

Before optimizing your hard drive, back up all important files onto disks, or 
another storage medium, and locate all of the original disks necessary for 
reloading the whole system. Proceed as follows:

1. Back up Instrument and/or matrix files.

a. Insert a disk into your computer.

b. Open the System folder.

Note If a different folder is designated in Preferences as the Settings folder, 
open it instead.

c. Open the ABI folder.

d. Drag the Instrument and/or matrix file icons to the disk icon. 

2. Make backup copies of your data.

3. Optimize your hard drive according to the instructions included with your 
software.
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Maintenance

Most maintenance procedures on the ABI PRISM 373 DNA Sequencer with XL 
Upgrade should be performed by a trained Applied Biosystems service technician. 
However, you can perform certain procedures yourself, as described below.

Cleaning Instrument Accessories

Be sure to clean the following regularly, as described on the pages noted:

• Glass plates (pages 2-13 and 3-48)

• Spacers and combs (page 3-48)

Replacing Electrophoresis Cables and Electrodes

The electrophoresis cables and electrodes are built as assemblies that simplify 
installation in the buffer chambers. Change the entire electrode assembly when 
you need to replace either a cable or an electrode.

Figure 8-1 shows a drawing of the upper buffer chamber. Figure 8-2 refers to the 
lower buffer chamber. Refer to both figures as you perform the following 
procedures.
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Upper Buffer Chamber Replacement

Remove the clamps from the old upper buffer chamber and install them onto the 
new upper buffer chamber using the following steps (see Figure 8-1).

Figure 8-1.  Attach the clamps to the upper buffer chamber

Note The buffer chamber should be opaque with the ABI logo stamped on 
the lid. If your buffer chamber looks different, contact Applied 
Biosystems.

1. Remove the upper buffer chamber from the instrument and place it on a 
work area.

2. Remove the clamp screw from the right clamp by unwinding the head from 
the base of the screw.

3. Insert the provided Allen wrench through the notch of the right clamp and 
loosen the socket head screw by turning it counter-clockwise. If there is no 

Black cable

Left clamp
(005017)

Socket head screw
(212156)

Allen wrench

Right chamber flange

Right clamp
(005018) Dowel pin

Notch

Clamp screw
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notch on the clamp, use the shorter end of the Allen wrench to loosen the 
socket head screw.

Caution If the clamp cannot be removed because it is attached with 
adhesive or the screw is frozen, contact Applied Biosystems for 
further instructions.

4. Remove the right clamp from the flange of the old upper buffer chamber.

5. Install the right clamp onto the new upper buffer chamber. Make sure that 
the dowel pin of the clamp has been inserted into the hole of the right 
flange of the new chamber. Use the Allen wrench to tighten the socket 
head screw.

6. Replace the head of the clamp screw on the base.

7. Repeat steps 2–6 to remove the left clamp from the old upper buffer 
chamber

8. Place the new buffer chamber in the instrument. 

9. Connect the new black cable to the instrument.

WARNING Use ONLY the opaque upper buffer chamber with the ABI logo on 
the lid. If you do have extra upper buffer chambers that are made 
of the transparent material do not use them. If you need 
replacement chambers contact Applied Biosystems.
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Lower Electrode Replacement

Replace the electrode of the lower buffer chamber using the following steps (see 
Figure 8-2).

Figure 8-2.  Attach the electrode to the lower buffer chamber

1. Lift the lower buffer chamber from the instrument and place it on your 
work area.

2. Remove the red cable from the lower buffer chamber and discard.

3. Partially loosen nylon screw 2 using the screw driver and turn the tie holder 
180 degrees.

Nylon screw 2 is located on the inside bottom of the buffer chamber on the 
right side when the chamber is facing you. 

It is not necessary to loosen or remove nylon screw 1, which is the smaller 
nylon screw that attaches the curled cord clip on the left side of the 
electrode.

4. Remove the old electrode from the lower buffer chamber.

Nylon screw 1
(212160)
(do not loosen this screw

Nylon washer
(223071)

Cable clip
(200442)
(do not remove cable 
clip from the chamber)

Right support

Electrode
(604175)

Tie holder
(200629)

Feet

Red cable

Connector Nylon screw 2
(212179)
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5. Place the new electrode onto the lower buffer chamber. 

The right support of the chamber should be between the electrode’s two 
feet.

6. Insert the cable under the cable clip. 

The cable clip stretches around the top of the cable. Rotate the tie holder 
to its original position, and use the screw driver to tighten nylon screw 2. 
The tie holder and the cable clip should now secure the electrode in place.

7. Replace the chamber in the instrument.

Plug the new red cable into the instrument. The cable lies on the 
instrument between the chamber and the wall of the instrument.

Make a final check that both electrode cables are stored away so that they 
won’t interfere with the operation of the instrument door. The new 
electrode cables are stronger than the old cables, however, they are also 
less flexible so storing the cables may be slightly more difficult.

Note If in the future either the upper or lower electrode should need to be 
replaced, the entire electrode unit will be replaced by ordering a new 
electrode from Applied Biosystems. The upper electrode part number 
is P/N 604174. The lower electrode part number is P/N 604175.

Backing Up Important Files Before Optimizing Your Disk

Before optimizing your hard drive, back up all important files onto disks or 
another storage medium, and locate all of the original disks necessary for 
reloading the whole system. Refer to page 7-12.

Other Macintosh Computer Maintenance

Refer to Section 7, Computer System, for routine maintenance issues for the 
Macintosh computer. 
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Troubleshooting

If you have problems with the instrument, Translation Interface Processor, or the 
Macintosh computer, perform a Total Reset. Total Reset consists of several parts:

• Performing a Total Reset through the keyboard on the instrument

• Resetting the Firmware Image and restarting the Macintosh computer and 
Translation Interface Processor to load the Firmware Image

Total Reset of the Instrument

To perform a total reset of the instrument:

1. Verify the electrophoresis chamber door is closed.

2. Press the Main Menu key, and then press the Delete key.

3. Press Total Reset.

The screen goes blank, then the message, “Calibration in Progress Please 
Wait” appears. Total Reset takes about 60 seconds. The instrument is now 
ready for use.
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Resetting the Firmware Image and Restarting the Macintosh 
Computer

If the firmware memory becomes corrupted, you might need to clear the 
instrument’s memory so that the computer copies a new firmware image into 
memory the next time it connects to the instrument. Figure 8-3 shows the reset 
button and status indicators (LEDs) on the back of the Translation Interface 
Processor.

Figure 8-3.  ABI PRISM 373XL Translation Interface Procesor (back view)

Clearing the Firmware Image

Possible symptoms of corrupted memory

• The computer does not communicate with the Translation Interface 
Processor or the instrument does not appear to run properly (flat or no 
scan lines in the Scan window, or no instrument response to computer 
commands).

• The Translation Interface Processor does not communicate with the 
instrument or the Macintosh after pressing the reset button, located on the 
rear of the Translation Interface Processor.

• The Translation Interface Processor LEDs (see Figure 8-3 on page 8-9) do 
not blink in their characteristic pattern but are stuck in one pattern, which 
might be all on or all off AND

• The Translation Interface Processor might not be able to load a new 
Firmware Image on the instrument, OR

Power switch

Power connector

Status LEDs (9)

Diagnostics connection

Macintosh connection

Reset button

373XL connection
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• The Translation Interface Processor appears to have loaded a new 
Firmware Image onto the instrument but the instrument still does not run 
and the Translation Interface Processor LEDs are still not changing.

To clear the Translation Interface Processor’s memory:

1. Press the reset button on the back of the Translation Processor (refer to 
Figure 8-3 on page 8-9.

Use the eraser end of a pencil or something similar.

2. Watch the back panel LEDs and wait for them to blink in a four-on, four-off 
sequence. 

In this state, four consecutive lights are on at one time, then all four go off 
and the other four go on together.

3. While the four-on, four-off blink sequence is occurring, press the reset 
button a second time within about three seconds after the sequence.

The LEDs change to the “every other one on” state. This indicates that the 
Translation Interface Processor’s memory is clear and the Translation 
Interface Processor is ready for the computer to copy over a new firmware 
image. The next time you start the data collection program, the new 
Firmware Image will be copied to the instrument.

Restarting the Macintosh and Loading the Firmware Image 
The first time you turn on the ABI PRISM 373 DNA Sequencer with XL Upgrade 
and start the data collection program, the program searches for a current version 
of firmware on the instrument. If none is located, it automatically copies the 
Firmware Image file from the computer to the instrument.

If you turn off the instrument between runs, a battery backup holds the image in 
memory, so you do not need to copy it again when you restart the instrument. 
Occasionally, however, you might need to copy the image file again, for instance, 
if a power outage clears the instrument memory or the memory becomes 
corrupted.

To restart the Macintosh to load the Firmware Image:

1. Choose Restart from the Special menu in the Finder to restart your 
Macintosh.
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2. The data collection software should automatically open upon restarting 
the Macintosh. If it does not open, double-click the icon to open the 
program. Refer to To make the data collection program open at startup: 
on page 5-13 for instructions to open the collection program at startup.

If the program locates the firmware image file it automatically displays a 
progress window and starts copying the firmware image file to the 
instrument.

When the file is copied, an alert box notifies you to start the data collection 
program again.

3. Click Quit.

4. Double-click the ABI PRISM 373XL Collection icon to start the program 
again.

If, after Step 1, the program does not locate the Firmware Image, a dialog 
box appears asking you to identify its location.
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Figure 8-4.  Find Image dialog box

5. Locate the ABI PRISM 373XL Firmware file and click Open.

6. Click Quit when it is finished and restart the ABI PRISM 373XL Collection 
program.

Note If you click Cancel in the Find Image dialog box, the program quits and 
returns you to the Macintosh Finder. You cannot start a run without an 
ABI PRISM 373XL Firmware Image file.

373XL Firmware

373XL Firmware
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Problems During a Run

Table 8-1 contains a brief list of problems you might encounter during a run and 
what to do about them.

Table 8-1.  Problems That Might Occur During Runs

Problem What to do

Dialog box appears indicating there is not 
enough room to store files from run.

Delete files (particularly Gel files) from 
the hard disk to make room. Gel files are 
stored in each individual Run folder 
when you perform a run, and take up a 
substantial amount of room on the hard 
disk.

Buffer level in upper chamber is getting lower, 
but no external leaks apparent

Siphon the buffer out of the upper buffer 
chamber, dry the corners of the notched 
area at the top of the front plate, then 
apply a small amount of molten agarose 
to the corners of the notches. Refill the 
upper buffer chamber. If still l leaking, 
you may need to replace the gasket.

Buffer splashes and crystallizes around the 
read region

Be careful to not overfill the lower buffer 
chamber.

Communication problems between the 
instrument and the Manintosh 

• Check for loose or improperly 
connected cables
• Collection software preference set to 
No Port. Change preference to Modem 
Port.
• Corrupted Firmware. Perform a Total 
Reset.
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Troubleshooting Gels

Table 8-2 shows some problems you might encounter relating to gels, and 
recommends some solutions.

Table 8-2.  Gel Troubleshooting  

Problem Possible Cause Solution

Inconsistent mobilities 
from gel to gel

Wrong total percentage 
polymer 

Follow protocol carefully. 

Wrong concentration of Bis Follow protocol carefully.

Wrong buffer concentration Follow protocol carefully. 

Poor quality reagents Remake 10X TBE and 40% 
acrylamide stock solution 
using highest grade 
reagents. Urea must also be 
ultra pure.

Dissolved O2 concentration Keep vacuum strength/time 
constant; stir/pour gel 
solutions gently; filter/pour 
gels at 20-23 ˚C.

Variation in spacers Use spacers and comb sets 
that are of equal thickness

Temperature of room, gel 
solution or glass varies

20–23 ˚C is optimal 

Slow mobility Old gel Remake 10X TBE and 40% 
acrylamide stock solution 
using highest grade 
reagents. Urea must also be 
ultra pure.
Pour a fresh gel

Poor resolution Poor quality reagents 
(especially acrylamide)

Use fresh reagents from a 
reliable source. 

Small bubble between load 
and read region

Cast gel as described in 
protocol.

Well shape not flat Assure no oxygen trapped 
by comb; remove comb 
carefully; only load in flat 
wells.
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Old buffer Make 1X TBE fresh daily.

Old gel Use within 6 hours; do not 
refrigerate

Catastrophic loss of 
resolution (bands tilted 
and poorly resolved)

Gel extruding from between 
plates into upper buffer 
chamber

After cleaning plates, wash 
briefly in 3M HCl, wash with 
water, then clean as 
described on page 2-13.

Swirls in gel Excessive TEMED or APS Follow protocol

Temperature too high Polymerize at 20–23 ˚C

Polymerization too slow Excessive dissolved O2 Keep vacuum filter strength 
and time constant; stir and 
pour solutions gently; filter 
and pour gels at room 
temperature

 Not enough TEMED or APS 
(or degraded)

Use fresh high-quality 
reagents; use as indicated in 
protocol

Temperature too low Polymerize at 20–23 ˚C

Did not use dH2O Use only distilled or 
deionized water for making 
all solutions

Table 8-2.  Gel Troubleshooting  (continued)

Problem Possible Cause Solution
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Software Troubleshooting

Data Collection Run Log Errors
If an error message appears on the screen during collection, it also appears in the 
Run Log file. The Run Log lists both computer errors and instrument firmware 
errors.

Computer errors are individually created and listing each possibility individually 
is too massive a task for this manual. Such errors are usually due to problems 
related to:

• Memory 

For example, your computer might not have enough memory to handle a 
certain function or the data collection program might not have been 
allocated enough memory space when it started.

• File searching

For example, a file might be missing or in a different location so it is not 
found when the data collection program tries to open or save it, or a file 
might be corrupted.

• Disk problems

Any problems with your hard disk could cause computer error messages. 
Refer to Use a Hard Disk Maintenance Program Regularly on page 7-9.

Check these areas if the Run log lists computer errors.

One instrument firmware error might appear:

• The AD converter is not functioning.

If you see this message, turn off the power switch, then turn it on again. If the 
message appears again, run a plate check to see if a signal is displayed. If a signal 
appears, the irregularity is not severe, and you should be able to run samples and 
collect data.
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A Applied Biosystems Limited Warranty

Applied Biosystems warrants to the Customer that, for a period ending on the 
earlier of one year from completion of installation or fifteen (15) months from 
the date of shipment to the Customer (the “Warranty Period”), the ABI PRISM 373 
DNA Sequencer with XL Upgrade purchased by the Customer (the “Instrument”) 
will be free from defects in material and workmanship, and will perform in 
accordance with the performance specifications contained in the Instrument 
user’s manual that accompanies the instrument (the “Specifications”). During the 
Warranty Period, if the Instrument fails to perform in accordance with such 
specifications, Applied Biosystems will repair or replace the Instrument at no 
charge to the Customer, subject to the conditions below.

This Warranty does not apply to the Instrument's valves, reagent lines, or 
performance, unless the Customer uses only reagents and solvents supplied by 
Applied Biosystems or expressly recommended by Applied Biosystems, or to 
damages caused by reagents or solvents not supplied by Applied Biosystems, even 
though recommended by Applied Biosystems. This Warranty does not extend to 
any Instrument or part thereof (i) that has been the subjected of misuse, neglect 
or accident, (ii) that has been modified or repaired by any party other than 
Applied Biosystems or (iii) that has been used in a manner not in accordance with 
the instructions contained in the Instrument User's Manual. This Warranty does 
not cover the customer-installable consumable parts for the Instrument that are 
listed in the Instrument User's Manual.

Applied Biosystems obligation under this Warranty is limited to repairs or 
replacements that Applied Biosystems deems necessary to correct covered defects 
or failures of which Applied Biosystems is notified prior to expiration of the 
Warranty Period. All repairs and replacements under this Warranty shall be 
performed by Applied Biosystems on-site at the Customer's location at Applied 
Biosystems expense.

No agent, employee, or representative of Applied Biosystems has any authority to 
bind Applied Biosystems to any affirmation, representation, or warranty 
concerning the Instrument that is not contained in the printed product literature 
or this Warranty Statement. Any such affirmation, representation or warranty 
made by any agent, employee, or representative of Applied Biosystems shall not 
be binding on Applied Biosystems.

Applied Biosystems shall not be liable for any incidental, special, or consequential 
loss, damage or expense directly or indirectly arising from the purchase or use of 
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the Instrument. Applied Biosystems makes no warranty whatsoever with regard to 
products or parts furnished by third parties; such products or parts will be subject 
to the warranties, if any, of their respective manufacturers.

This Warranty is limited to the original Customer and is not transferable.

THIS WARRANTY IS THE SOLE AND EXCLUSIVE WARRANTY AS TO THE 
INSTRUMENT AND IS IN LIEU OF ANY OTHER EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, WITHOUT LIMITATION, ANY IMPLIED 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE AND OF ANY OTHER OBLIGATION ON THE PART OF APPLIED 
BIOSYSTEMS.
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Flow Chart of Typical Sequence Run 
Process
Prepare and label samples

Load gel on instrument
Run plate check

Cancel plate check
Add buffer

Start pre-run

Pause pre-run
Load second set of samples

Cancel pre-run
Start Run

Analyze and print (automatic)

Pour gel

Pause pre-run
Load first set of samples

Resume pre-run

Clean up

Restart Macintosh
Set up software

Resuspend DNA

Observe status 

Polymerize
~2 hr

Pre-run
~5 min

Run
~ 2–16 hr

Run samples 
into gel
~ 2 min
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Flow Chart of Typical GeneScan Run 
Process

Load gel on instrument
Run plate check

Cancel plate check
Add buffer, 

Start pre-run

Start Run

Analyze and print (automatic)

Pour gel

Cancel Pre-run
Load samples

Clean up

Restart Macintosh
Set up software

Mix sample with loading buffer size std
Heat sample

Observe status 

Polymerize
~2 hr

Pre-run
~5 min

Run
~ 3–8 hr

Run samples 
into gel
~ 2 min
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Acrylamide Gel Recipes

• Stir to dissolve
• Filter and degas
• Add 8 mL 10X TBE
• Bring to 80 mL with

dH2O

4.25% Gel (80 mL)

• 8.5 mL (40%)
• 40 g urea
• 27 mL dH2O
• 1 g resin

4.75% Gel (80 mL)

• 9.5 mL (40%)
• 40 g urea
• 27 mL dH2O
• 1 g resin

6.0% Gel (80 mL)

• 12 mL (40%)
• 40 g urea
• 27 mL dH2O
• 1 g resin

4.0% Gel (100 mL)

• 10 mL 40% 
acrylamide stock

• 50 g urea
• 37 mL dH2O
• 1.0 g mixed-bed 

resin

40% Acrylamide 
Stock

• 38 g acrylamide
• 2 g bis-acrylamide• 

Bring to 100 mL 
with dH2O

• Deionize
• Filter

10% Ammonium 
Persulfate (APS)

• 0.1 g APS
• 1.0 mL dH2O

10X TBE

• 108 g Tris
• 55 g boric acid
• 8.3 g EDTA (Na2)
• Bring to 1 L with

dH2O

25 mM EDTA 50 mg/mL 
Blue Dextran

• 0.93 g EDTA
• Add 90 mL dH2O
• Adjust to pH 8.0
• Bring to 100 mL with

dH2O
• Add 50 mg Blue Dextran

to 1 mL EDTA solution

• Stir to dissolve
• Filter and degas
• Add 10 mL 10X

TBE
• Bring to 100 mL

with dH2O

To Polymerize 4.25%, 
4.75%, and 6% Gels

• Add 400µL 10% APS
• Add 45 µL TEMED
• Mix gently
• Inject quickly

To Prepare Sequencing 
Sample

• Prepare solution:
• 1 part 25 mM EDTA with 

50 mg/mL Blue Dextran
•  5 parts deionized 

formamide
•Add to samples
• Mix well
• Heat at 90 °C for 2 min
• Place on ice

To Prepare Matrix 
Standards

• Prepare sample:
•  3 µL standard
•  3 µL formamide

• Mix well
• Heat at 90 °C for 2 min
• Place on ice

To Polymerize 4.0% Gel

• Add 500µL 10% APS
• Add 50 µL TEMED
• Mix gently
• Inject quickly

To Prepare GeneScan 
Sample

• Add loading cocktail to
sample: Blue EDTA;
formamide, size standard
(see Chapter 4)

• Mix well
• Heat at 95 °C for 5 min
• Place on ice
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Modules

IMPORTANT The Seq Run and GS Run default parameters are applicable only to 
24-cm WTR Classic and Leon 6% acrylamide gels.

ABI PRISM 373 DNA Sequencer with XL Upgrade Module 
Default Valuesa

a. These default values should be changed according to conditions appropriate to 
the gel you are running.

Module 
Name

Field 
(volts)

Power 

(watts)b

b. These parameters are limited by the Field parameter.

Current 
(mAmp)

Laser 
Power 
(mW)

Run 

Timec 
(hr)

c. Can be set in the Run window

Plate Check -- -- -- 40 0.50

PreRun 2500 30 40 40 0.33

Seq Run 2500 30 40 40 12

GS Run 2500 30 40 40 12
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Throughputs and Filter Sets

ABI PRISM 373 DNA Sequencer with XL Upgrade Throughputs for 
Sequencing

Instrument
Model

WTR 
Length 
(cm)

Gel 
Concen-
tration

(%)

Gel
Thickness

(mm)

Scan Mode Power 
(W)

Collec-
tion Time 

(hr)

Length of 
Read 

(bases
resolved)

Classic 24 6.0 0.4 XL or Full scan 30 12–14 450

Classic 24 4.75 0.4 BaseSprinter 40 6.5 450

Leon 24 6.0 0.4 XL or Full Scan 30 12–14 450

Leon 24 4.75 0.4 BaseSprinter 40 6.5 450

Stretch 24 6.0 0.4 XL or Full Scan 261 12–14 450

Stretch 24 4.75 0.4 BaseSprinter 35 7 450

Stretch 34 4.75 0.4 XL or Full Scan 321 14–16 550

Stretch 34 4.25 0.4 BaseSprinter 45 8 550

Stretch 48 4.0 0.3 XL or Full Scan 401 17–18 700

1. If necessary, adjust the power to achieve spacing of 9.5 to 12 for analyzed data.
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ABI PRISM 373 DNA Sequencer with XL Upgrade Throughputs for 
GeneScan

Application Resolution 
(bp)

Size Standard Gel Type 
(Acrylamide)

Gel 
Length
(cm)

Run 
Time 
(hr)

Microsatellite Genotyping 
(Linkage Mapping Set, 
dinucleotide tepeats)

1 GS-350 or 
GS-500

6.0% 
denaturing

24 6

Microsatellite Genotyping
(tri- and tetranucleotides)

1–2 GS-500 6.0% 
denaturing

12 4

VNTRs 1–2 GS-350 or 
GS-500

8.0% 
denaturing

12 4

Large Fragments
(0.5–2.5 kb)

3–4 GS-1000 or 
GS-2500

8.0% 
denaturing

6 2

AFLP™ Plant Mapping Kit 1 GS-500 6.0% 
denaturing

24 11

Stock Marks™ for Cattle 1 GS-350 6.0% 
denaturing

24 6

AmpFlSTR™ 
(tetranucleotides)

1 GS-500 6.5% 
denaturing

24 6
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Combs and Run Modes

Dye Sets and Filter Sets by Chemistry

Chemistry Dye Set Filter Set

Taq and T7 Primers 1 Filter Set A

Taq Terminators 2 Filter Set A

T7 Terminators 3 Filter Set B

Color Guide for Data Collection Program Raw Data and Gel Image Displays 

Filter A Filter B

Color Taq and T7 Primers
(Dye Set 1)

Taq Terminators
(Dye Set 2)

T7 Terminators
(Dye Set 3)

Blue C G T

Green A A C

Yellow G T A

Red T C G

Lanes Comb Run Mode

18 Sharks-tooth BaseSprinter

24 Sharks-tooth Full Scan

24 Square-tooth Full Scan

32 Sharks-tooth Full Scan

34 Square-tooth Full Scan

36 Sharks-tooth Full Scan

36 Square-tooth Full Scan

48 Sharks-tooth XLScan

50 Square-tooth XLScan

64 Sharks-tooth XLScan

68 Square-tooth XLScan
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Table of Abbreviations
APS Ammonium persulfate
bp Base pairs
CEHV Capillary Electrophoresis High Viscosity
COP assay Competitive Oligonucleotide Priming assay
CsCl Cesium chloride
dH2O Deionized, distilled water

DNA Deoxyribonucleic acid
ddNTP Dideoxynucleoside triphosphate
dNTP Deoxynucleoside triphosphate
dITP 2'-deoxyinosine-5'- triphosphate
ds Double stranded
DTT Dithiothreitol
EDTA Ethylenediaminetetraacetic acid, -tetracetate, -tetraacetato
HCl Hydrochloric acid
IPTG Isopropyl-ß-D-thio-galactopyranoside
KH2PO4 Potassium phosphate

kV Kilovolts
mA MilliAmps
min Minutes
mM Milli molar
mL Milliliter
mRNA Messenger RNA
nt Nucleotide
µg Microgram
µL Microliter
µm Micron or micrometer
NaCl Sodium Chloride
NaOH Sodium Hydroxide
PCR Polymerase Chain Reaction
PEG Polyethylene glycol 8000
PMT Photomultiplier tube
P/N Part number
q. s. Quantity sufficient
RF DNA Restriction Fragment DNA
s Seconds 
ss Single stranded
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STR Short tandem repeat
SDS Sodium dodecyl sulfate
TBE Tris-Borate-EDTA (pH 8.3)
TE 10 mM Tris-Cl (pH 8.0), 1 m M EDTA (pH 8.0)
TEMED N, N, N', N'-tetramethylethylenediamine
Tris-Cl Tris hydrochloride
VNTR Variable number of tandem repeats
w Watts
WTR Well-to-read or separation length; the distance the sample travels 

through the acrylamide before detection, this equals the distance from 
the bottom of the well to the laser-reading region.

X-GAL 5-bromo-4-chloro-3-indolyl-ß-galactoside

Table of Abbreviations
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Sequencing Instrument File

Sequencing Matrix Files in an Instrument File

Three chemistries are currently available to prepare DNA samples for sequencing 
on the ABI PRISM 373 DNA Sequencer with XL Upgrade: Dye Primers, Taq 
DyeDeoxy Terminators, and T7 Terminators. Each chemistry has a specified dye 
set: a set of dye labels that emit fluorescence when excited by a laser. Each dye 
label in the set emits fluorescence at a different wavelength and, during data 
collection, the wavelengths are detected. The wavelengths are separated by 
physical filters.

Although the dyes fluoresce at different wavelengths, there is some overlap in the 
spectra. To correct for this overlap before analyzing data, a mathematical matrix 
is created for each chemistry type (dye set) and stored in a file called the 
Instrument file. During data analysis the appropriate matrix is applied to remove 
any spectral overlap. 

The Instrument file must contain a matrix for each chemistry that you run on the 
instrument. When the Gel and Sample files are created, the Instrument file is 
attached to each to allow subsequent data analysis. Each ABI PRISM 373 DNA 
Sequencer with XL Upgrade must have an Instrument file inside the ABI folder 
located in the System Folder.

IMPORTANT Due to slight variations in the filter wheels, the Instrument file created 
on your ABI PRISM 373 DNA Sequencer with XL Upgrade is not valid on 
other ABI PRISM 373 DNA Sequencer with XL Upgrade instruments.

Create a new Instrument file only if the filter wheel is replaced, or if you should 
need a new matrix for a type of chemistry other than the three mentioned above.

Filter Wheel and Data Display

A filter wheel separates the wavelengths emitted by the fluorescent dyes. On the 
real-time displays (the Scan window and the Gel window), the data collection 
program displays these intensities, color-coded according to wavelength. Blue, 
green, yellow, and red (in that order) represent the wavelengths of the dye 
emissions within each dye set. Blue represents the shortest wavelength, and red 
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represents the longest. The colors on the real-time displays therefore represent 
the wavelengths of the dyes being detected, rather than the bases being detected.

Different filter sets use the same four colors to represent different wavelengths, so 
the colors do not represent actual wavelengths. They represent the relative 
wavelengths of the four dyes in each dye set. Filter A uses the four colors to 
represent wavelengths within Dye Set 1 and Dye Set 2. Filter B uses the four colors 
to represent wavelengths within Dye Set 3.

Each of the three chemistries used for preparing DNA is associated with one of 
the dye sets. Each dye set labels the four bases differently, so the relative 
wavelength, and therefore the color, associated with each base varies with the 
chemistry used to label it. Because of this, the four colors on the real-time displays 
represent different bases, depending on the chemistry used for labeling.
Table C-1 describes the colors that represent each of the four bases on the 
real-time displays.

The analysis program converts the information collected by the data collection 
program, so after analysis the colors are the same for each base. The colors on all 
displays of analyzed data, including printed electropherograms, are as follows:

C = Blue A = Green G = Yellow T = Red

Note When printed, and when shown against a white background on screen, 
G is black so it is easier to see.

Table D-1.  Color guide for data collection program raw data displays 

Filter 
Band 
Pass 

Center 
(nm)

Filter A Filter 
Band 
Pass 

Center 
(nm)

Filter B

Color
Taq and T7 

Primers
(Dye Set 1)

Taq 
Terminators
(Dye Set 2)

T7 
Terminators
(Dye Set 3)

Blue 531 C G 531 T

Green 560 A A 545 C

Yellow 580 G T 560 A

Red 610 T C 580 G
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Creating a Matrix File

Note If a valid Instrument file exists in the ABI folder (inside the System 
folder) on your Macintosh, you need not create one. If you lose your 
Instrument file and do not have a backup copy on a floppy disk, refer to 
the Sequencing Analysis User’s Manual.

This section describes, in detail, how to make a matrix. The steps you need to 
perform are:

1. Obtain the proper matrix standards for your purpose.

2. Prepare an acrylamide gel.

3. Prepare, load and electrophorese the matrix standards.

4. Refer to the Sequencing Analysis User’s Manual.

Matrix Standards

To make a matrix, you must electrophorese and analyze specific matrix standards. 
A separate standard exists for each of the four reactions in each of the three dye 
sets. Load only one matrix standard per lane. The matrix standards are sold in kits, 
one for each chemistry.
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Preparing, Loading and Electrophoresing Matrix Standards

After obtaining the correct matrix standards, follow the procedure below. You can 
run matrix standards for Dye Primers and Taq DyeDeoxy terminators on the same 
gel, using Filter Set A. Run standards for T7 Terminators on a separate gel using 
Filter Set B.

1. Prepare either a:

• 4.75% acrylamide gel (for Stretch) or a 

• 6% acrylamide gel (for Classic and Leon)

2. Set up the instrument according to Section 3  of this manual.

3. Restart the Macintosh (choose Restart from the Special menu in the 
Finder).

4. Start the data collection program.

5. Verify or define the data collection preferences.

6. Choose New from the File menu and click the Sequence Sample Sheet 
icon. 

7. Fill in the Sample Sheet, as described in Section 3 of this manual.

a. For convenience, name the matrix standards according to the labeled 
base (A, C, G, or T), followed by the specific sequencing chemistry 
(Primers, Taq Terminator, or T7 Terminator).

b. Choose Save As from the File menu to save the Sample Sheet. 

Be sure to save it in the folder designated as the Sample Sheets folder 
in the data collection program preferences.

8. Choose New from the File menu and click the Sequence Run icon. 

9. In the Run window, choose the proper files from the pop-up menus.

The Sample Sheet should be the one you completed in Step 7 above.

The Gel Matrix should be the current instrument file or any other 
applicable matrix file.

A B I  P R I S M 
3 7 3 X L  

C o l l e c t i o n
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10. Choose Off from the pop-up menus for Auto Analyze and Auto Print.

a. Choose Off in the top pop-up menu of the column.

b. Click the heading of the column to select the entire column.

c. Choose Fill Down (c-D) from the Edit menu to fill in the other fields.

11. Click the PreRun button to prerun the gel while you are preparing the 
standards. Pre-run for 5 minutes, then click Pause in the Run window.

Figure D-1.  Completed Sequencing Run window

12. Prepare the Matrix Standards as follows:

Note Do not prepare the matrix standard more than 3 hours in advance of 
loading.

Note As a precaution, prepare and run a duplicate set of matrix standards, in 
case one lane is inadequate or the data is lost.
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a. Briefly vortex the matrix standards to ensure the solutions are well 
mixed. Spin the solution briefly to collect the fluid at the bottom of 
the tube.

b. For each standard (one tube for each base), combine 3 µL of standard 
with 3 µL of deionized formamide.

c. Briefly vortex each of the tubes prepared above to ensure that the 
sample is well mixed. Spin the solution briefly to collect the fluid at 
the bottom of the tube.

d. Heat all matrix samples at 90˚C for 2 minutes. Immediately place 
samples on ice until loaded.

13. Load the matrix standards in the lanes you designated in the Sample Sheet.

14. Click Run to start the run.

A dialog box appears, allowing you to change the name and location of the 
gel file created by the run.

15. Proceed to either Making the First Matrix for a New Instrument File, or Adding 
or Replacing a Matrix to an Instrument File after the sequencing run is 
complete.

Making the First Matrix for a New Instrument File

If you need to re-create a matrix file for any reason, you should:

• Run the appropriate matrix standards

• Check the gel file to verify that lane tracking is correct and that peaks exist 
in the raw data.

• Make the matrix file, using the DataUtility program.

• Verify the accuracy of the matrix file, and its location.

Comb Configuration

18 24 32/36 48 64

Loading Volume (µL) 4 4–6 4 1.5–2 1–1.5
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Follow these steps (usually along with your Service Representative) when you get 
a new instrument. 

Note If you lose your Instrument file and do not have a backup copy on a 
floppy disk refer to the Sequencing Analysis User’s Manual before 
re-creating the entire Instrument file.

Now that the matrix standards have been electrophoresed, switch to the matrix 
making instructions in the Sequencing Analysis User’s Manual.
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Introduction

Although the dyes used to label your fragments fluoresce at different wavelengths, 
there is some overlap in the spectra. To correct for this overlap before analyzing 
data, the software uses a matrix file, which contains a mathematical matrix. 

You create one matrix for each chemistry and gel type. During data analysis the 
appropriate matrix is applied to remove any spectral overlap. 

A specifically created matrix file provides the best results for your particular 
instrument and the dye set and run conditions used in the experiment. In most 
cases, you should not need to modify the matrix file once you have created it. 

You may want to create a new matrix to accommodate these conditions:

• If you use gel materials or buffers with pH values that differ greatly from 
one another (in such a case you need different matrices)

• If you change dyes in a dye set, e.g., changing from 5-FAM to 6-FAM. Even 
though the dyes represent the same color, their spectral characteristics are 
different.

• If you use dyes other than those provided by Applied Biosystems

• If you see problems that appear to be the result of spectral overlap

Once you create a matrix file, you can apply that file to any run made under the 
same conditions, using the same dye set, and on the same instrument. 

Applied Biosystemss provides Matrix Standard kits that are designed to test and 
define the multicomponent matrices for specific dye sets. To work with a matrix 
file, use the Matrix Standard kit that was designed for the specific dye set you plan 
to use. Run the matrix standards of different types in different lanes to make the 
matrix and to test whether the spectral overlap of the dyes is corrected by the 
matrix. 

IMPORTANT To specify matrix file in the data collection program so you can perform 
automatic analysis, you must store the matrix files in the ABI folder 
inside your System folder.
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Filter Wheel and Data Display

The band pass filters on the filter wheel separate the wavelengths emitted by the 
fluorescent dyes. On the real-time displays (the Scan window and the Gel 
window), the data collection program displays these intensities, color-coded 
according to wavelength. Blue, green, yellow, and red (in that order) represent 
the wavelengths of the dye emissions within each dye set. Blue represents the 
shortest wavelength, and red represents the longest. The colors on the real-time 
displays therefore represent the wavelengths of the dyes being detected, rather 
than the fragments being detected.

Different filter sets use the same four colors to represent different wavelengths, so 
the colors do not represent actual wavelengths. They represent the relative 
wavelengths of the four dyes in each dye set. 

The filter set you choose determines what color peaks appear for a particular dye 
(see Table D-1). Through either filter set A or B, each dye is detected within its 
optimum wavelength range. It is important to have a matrix for every combination 
of dye sets you use.
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Table D-1.  ABI PRISM dyes and filter set color displays 

Dyes

Filter Set

A B

Color 
Display

Filter Center 
Band (nm)

Color 
Display

Filter Center 
Band (nm)

Dye HEX Green 560 Yellow 560

 phosphoramidites 6-FAM Blue 531 Blue 531

TET * * Green 545

TAMRA** Yellow 580 Red 580

NHS Esters ROX Red 610 * *

5-FAM*** Blue 531 Blue 531

JOE*** Green 560 Yellow 560

TAMRA Yellow 580 Red 580

[F]dNTPs RG6 Green 560 Yellow 560

R110 Blue 531 Blue 531

* Not recommended; the filter is not set at the emission maxima
** TAMRA is available as an NHS-Ester or as an [F]dNTP.
*** 5-FAM and JOE are available only as labeled primers in select reagent kits.
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Creating a Matrix File

To make a matrix:

1. Obtain the appropriate matrix standards.

2. Prepare an acrylamide gel.

3. Prepare, load, and electrophorese the matrix standards.

4. Follow the procedure on page D-6.

Matrix Standards

To make a matrix, you must electrophorese and analyze specific matrix standards. 
Separate standards exist for each dye. Each dye used must be recognized as a 
different color by a single filter (Table  D-1 on page  D -5). Table D-2 lists the kits 
and their part numbers.

Table D-2.  Matrix Standard Dyes and Part Numbers

Preparing, Loading and Electrophoresing Matrix Standards

To set up the instrument:

1. Prepare the appropriate gel.

2. Set up the instrument according to Section 4 of this manual.

3. Restart the computer (choose Restart from the Special menu in the 
Finder).

To set up the GeneScan Analysis software:

1. Start the GeneScan Analysis program.

2. Define the gel processing parameters.

a. Choose Gel Processing Parameters from the Settings menu.

Matrix Standards Part Number

Dye Primer (5-FAM, JOE, TAMRA, ROX) 401114

Fluorescent Amidite (6-FAM, HEX, TET, TAMRA, ROX) 401456
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b. Select both boxes for Auto-Launch Processing.

c. Set the Scan Range from 0 to 10000.

d. Deselect Multicomponent.

e. Click OK.

3. Define the analysis parameters.

a. Choose Analysis Parameters from the Settings menu.

b. Define all the appropriate parameters.

c. Select Baseline and deselect Multicomponent boxes.

d. Click OK.

4. Define the project options.

a. Choose Project Options from the Settings menu.

b. Complete the each of the submenus.

To complete the set up:

1. Start the data collection program.

2. Choose Preferences from the Window menu to verify or set the data 
collection preferences.

3. Choose New from the File menu, and then click the GeneScan Sample 
icon. 

4. Fill in the Sample Sheet as described in Section 4 of this manual.

a. In the sample name column, type in a name appropriate to the matrix 
standard loaded. 

b. Choose Save As from the File menu to save the Sample Sheet. 

Be sure to save it in the folder designated as the Sample Sheets folder 
in the data collection program preferences.

5. Choose New from the File menu, and then click the GeneScan Run icon. 
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6. In the Run window, choose the proper files from the pop-up menus.

The Sample Sheet should be the one you completed in Step 15, above.

The Gel Matrix should be <none>.

7. Choose Off from the pop-up menus for Auto Analyze and Auto Print.

a. Choose Off in the top pop-up menu of the column.

b. Click the heading of the column to select the entire column.

c. Choose Fill Down (c-D) from the Edit menu to fill in the other fields.

8. Click Plate Check.

a. Check the plates for extra peaks. Reclean, if necessary.

b. Set or verify the PMT setting.

9. Click PreRun to prerun the gel while you are preparing the standards. Pre-
run for 5 minutes, and then click Cancel in the Run window.

Figure D-1Completed GeneScan Run window

10. Prepare the Matrix Standards as follows:
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Note Do not prepare the matrix standard more than 3 hours in advance of 
loading.

Note As a precaution, prepare and run a duplicate set of matrix standards, in 
case one lane is inadequate or the data is lost.

a. Briefly vortex the matrix standards to ensure the solutions are well 
mixed. Spin the solution briefly to collect the fluid at the bottom of 
the tube.

b. For each standard (one tube for each base), combine 1 part standard 
with 1 part deionized formamide.

c. Briefly vortex each of the tubes prepared above to ensure that the 
sample is well mixed. Spin the solution briefly to collect the fluid at 
the bottom of the tube.

d. Heat all matrix samples at 90˚C for 2 minutes. Immediately place 
samples on ice until loaded.

11. Flush the wells with loading buffer.

12. Load the matrix standards in the lanes you designated in the Sample Sheet. 
Use the following table to determine the load volumes for your matrix run.

13. Click Run to start the run.

A dialog box appears, allowing you to change the name and location of the 
gel file created by the run. Click Save.

Number of Wells Load Volume (µL)

24 5

34/36 4

50 1.5–2

66 1–1.5
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Creating the Matrix File

After preparing, loading, and electrophoresing matrix standards, you verify lane 
tracking and peaks in the raw data, and then create the matrix.

To verify lane tracking and peaks in the raw data:

1. Start the GeneScan Analysis program.

2. Choose Open Gel from the File menu and open the gel containing the 
matrix standards. 

3. Check the Gel File window to see if the lane tracking was successful for 
each standard, and correct any gel tracking problems.

Note If you are unfamiliar with how to retrack a gel file and view data, refer to 
the ABI PRISM DNA GeneScan Analysis User’s Manual for detailed 
instructions.

To create the matrix and print the values:

1. Determine the range of scan points to be used for making the matrix.

a. Click the name of the four matrix standard sample files in the Analysis 
Control window and choose Raw Data (z-R) from the Project menu.

b. Select a starting data point that starts at a flat baseline in the middle 
of the run, well after the primer peaks. The range needs to contain a 
minimum of three well-defined peaks or 1000 data points.

Typically, the same start point and range is used on all four matrix 
standard sample files.

c. Close the raw data windows.

2. Choose New from the File menu, and then click the Matrix icon in the 
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window that appears. 

Figure D-2.  Make New Matrix dialog box

a. Click the B… button.

b. In the file dialog box that appears, choose the Sample file containing 
your blue dye matrix standard.

c. Enter the Start At point as determined in step 1.

d. Repeat steps a through c for the other three dyes.

e. Enter the number of data points to include, at least three well-defined 
peaks and 1000 points.
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f. Click OK.

The Matrix Values window appears, showing the values used to calculate 
the overlap correction. 

Figure D-3.  Matrix window example

For each dye, the value where the dye fluorescence is read by the 
appropriate filter is 1.000. The adjacent colors show the amount of overlap 
for which the system needs to compensate. 

3. Choose Save from the File menu, and give the new matrix file a unique, 
descriptive name.

Note Save all matrix files in the ABI folder in the System folder and name 
matrix files by instrument serial number and type of gel used, for 
example, “#273 TBE den urea.”
It is also helpful to include “GS” in the name of the matrix files to 
differentiate between sequencing and GeneScan applications.

4. Choose Print (c-P) or Print One from the File menu to print the matrix 
values. 

You can use this printout for documentation. 

5. Click the Close box to close the window.
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Applying and Verifying the Matrix

To apply and verify the matrix:

Use either of the following two methods to check the quality of the generated 
matrix.

Method 1
1. Apply the new matrix to your matrix sample files within a project.

a. Choose Analysis Control from the Windows menu.

b. Select the matrix standard sample files.

Shift-click to select multiple consecutive files or c-click to select 
multiple files that are not consecutive.

c. Choose Assign New Matrix from the Project menu.

d. In the directory box that appears, find and select the newly created 
matrix.

e. Click Open.

2. Verify the matrix. 

a. Choose Analysis Parameters from the Settings menu.

b. Select Baseline and Multicomponent (and any other applicable 
parameters).

c. Select the matrix sample files and the colors to be analyzed (B, G, Y, 
and R buttons).

d. Click Analyze.

e. Choose Results Control from the Windows menu.

f. Display the analyzed data.

For each sample file, the only visible peaks should represent the dye 
loaded in that lane. All other lines should be relatively flat. This 
indicates that the matrix properly compensated for the spectral 
overlap.
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A matrix that does not compensate for the other dyes (see Figure D-1) is 
unacceptable and must be regenerated. If necessary, the gel and matrix standards 
must be rerun. Examples of good and poor matrices applied to the same 5-FAM 
data (12-cm run) are shown in Figure D-1 and Figure D-1, respectively.

Figure D-1Good matrix—only blue peaks are present

Figure D-1Poor matrix—note the other peaks at the same scan number as the blue 
peaks
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Method 2
1. Apply the new matrix to your gel file.

a. With the collection gel open, choose Attach New Gel Matrix from the 
Gel menu.

b. Find and select the newly created matrix in the dialog box that 
appears.

c. Click Open.

2. Define the gel processing parameters.

a. Choose Gel Processing Parameters from the Settings menu.

b. Select the appropriate Scan range (excluding excess primer peak).

c. Select Multicomponent and baseline.

3. Choose Regenerate Gel Images from the Gel menu.

4. Use the “slice view” to examine the multicomponented sample files.

a. On the gel display, click the triangle above the lane which represents 
one of the matrix standards.

b. To the left of the gel image is a slice view. Use this view to examine the 
data.

c. Verify that the only visible peaks correspond to dye-labeled fragments 
loaded in the lane. All other lines should be relatively flat. This 
indicates that the matrix properly compensated for the spectral 
overlap.

d. Repeat steps a through c for the remaining sample files.

5. Apply the new matrix to the sample files within a project. Refer to
page D-4 and page D-5 for help interpreting data.
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Preparing Reaction Mixtures

A reaction mixture consists of all the components you put into a reaction tube 
before loading the tubes in a thermal cycler and running a PCR reaction. When 
preparing reaction mixtures, consider the following factors that can affect overall 
yield of specific DNA target sequences:

• Reaction volume and tube types

• Deoxynucleoside triphosphate (dNTP) concentration

• Magnesium ion concentration

• Primer concentration

• Template concentration

• Enzyme concentration

Reaction Volume and Tube Types

When using an Applied Biosystems PCR instrument system, reaction volumes may 
cover the range of 5–100 µL, but should not exceed 100 µL. If you use volumes 
larger than100 µL, you may need to program longer incubation times to assure 
adequate thermal equilibration of the reaction mixture.

Table  E-1 on page  E -4 shows the types of reaction tubes that you can use with 
each PCR instrument system.
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Table E-1.  Reaction tube types for PCR instrument systems

Although reaction tubes usually do not need to be sterilized or siliconized, you 
should autoclave tubes when dealing with small quantities of starting DNA 
template.

PCR Instrument 
System

Reaction Tube Type Uses

DNA Thermal Cycler GeneAmp® PCR 
Reaction Tubes

Optimized for fast PCR 
amplification of reaction 
volumes between 25 µL 
and 100 µL.

DNA Thermal Cycler 
480

0.5 mL GeneAmp
Thin-Walled Reaction 

Tubesa

a. Can also be used with the DNA Thermal Cycler if you set hold times of at least 60 seconds.

Allows you to program 
shorter hold times 
(45 sec. or more) at each 
temperature in the PCR 
cycle.

GeneAmp PCR 
System 9600

0.2 mL Thin-Walled 
MicroAmp® Reaction 
Tubes

Optimized for fast PCR 
amplification of reaction
volumes between 5 µL 
and 100 µL.
Can be used without 
mineral oil.

0.5 mL Thin-Walled 
MicroAmp Reaction 
Tubes

Optimized for fast PCR 
amplification of 100 µL 
reaction volumes.
Use with either an oil 
overlay or AmpliWax 
PCR Gem beads.

GeneAmp PCR 
System 2400

0.2 mL MicroAmp 
Reaction Tubes

Optimized for fast PCR 
amplification of reaction 
volumes between 5 µL 
and 100 µL.
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Deoxynucleoside Triphosphate (dNTP) Concentration

In the standard GeneAmp PCR protocol, the concentration of each 
deoxynucleoside triphosphate (dNTP) is 200 µM. For best base incorporation, 
keep the four dNTP concentrations balanced and above the estimated Km of each 
dNTP (10–15 µM). 

Note Some applications may deviate from these standards for dNTP 
concentrations.

Lower dNTP concentrations should not significantly affect yield of PCR 
amplification product.

Magnesium Ion Concentration

For most PCR amplifications, you can relate yield and enzyme fidelity to the free 
Mg++ concentration (free Mg++ concentration is the concentration of Mg++ minus 
the total dNTP concentration added to the reaction solution). When using 
AmpliTaq DNA Polymerase, too little free magnesium ion results in little or no 
PCR product, and too much free magnesium ion can produce a variety of 
unwanted by-products. 

Magnesium ion concentration generally has the most significant effect on 
amplification yield and specificity. To identify the optimal magnesium ion 
concentration; that which produces the highest yield of a specific PCR product, 
you can perform the following experiment. In the presence of 0.8 mM total dNTP 
concentration, run a series of 0.5 mM magnesium chloride concentration 
increments over a 1–4 mM range and identify the optimal concentration.

Primer Concentration

PCR primers are oligonucleotides, typically 15–30 bases long, hybridizing to 
opposite strands and flanking the region of interest in the target DNA. When 
choosing two PCR primers, never choose primers that contain bases 
complementary to themselves or with each other. Especially avoid primers that 
show complementarity at the 3' and 5' ends. These often promote formation of 
product artifacts called primer-dimers or primer-oligomers. 
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To avoid problems with the internal secondary structure of primers or long 
stretches of any one base, choose primers with a 40–60% G+C content. Also, avoid 
using primers that bind to a target region of secondary structure For instance, 
RNA sequences often have regions of looped secondary structures. Primers will 
have difficulty annealing to these target sequence.

By adding non-template complementary 5' extensions to primers you can 
facilitate a variety of useful post-amplification manipulations of the PCR product 
without adversely affecting the amplification process. These 5' extensions can be 
restriction sites, or promoter sequences.

Template Concentration

PCR templates may be single or double-stranded DNA or RNA. If your starting 
sample is RNA, then your template can be:

• Total cellular RNA

• Poly (A+) RNA

• Viral RNA

• tRNA

• rRNA

To prepare first-strand cDNA prior to conventional PCR amplification, you can 
include a reverse transcriptase such as MuLV or recombinant Thermus thermophilus 
(rTth) DNA Polymerase. For RNA templates with high G+C content or complex 
secondary structure, the high-temperature reverse transcriptase activity of 
thermostable rTth DNA Polymerase is effective.

If your starting sample is DNA, use nanogram amounts of cloned template, 
microgram amounts of genomic DNA, or up to 20,000 target copies to start 
optimization trials.

Even very low template concentrations (mRNA from tens of cells, DNA from 
single cells or individual genomes) are often sufficient for PCR amplification.

Enzyme Concentration

AmpliTaq DNA Polymerase is the recombinant form of Taq DNA Polymerase. It 
is obtained by expressing the Taq DNA Polymerase gene in an E. Coli host. Like 
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native Taq DNA Polymerase, it lacks endonuclease and 
3'-5' exonuclease activities, but has a 5'-3' exonuclease activity. AmpliTaq DNA 
Polymerase is the enzyme used for the majority of PCR applications.

For most PCR applications with a 100 µL reaction volume, 2.0–2.5 units of 
AmpliTaq DNA Polymerase are recommended. The enzyme can be added 
conveniently to a fresh Master Mix prepared for a number of reactions, thereby 
avoiding the tedium and possible accuracy problems associated with adding 
individual 0.5 µL enzyme aliquots to each tube.

Recombinant 94-kDa Thermus thermophilus (rTth) DNA Polymerase is able to 
quickly and efficiently reverse transcribe RNA to cDNA in the presence of MgCl2, 
after chelation of the magnesium ion with EGTA. RTth DNA Polymerase can thus 
be used as both a thermostable reverse transcriptase and as a thermostable DNA 
polymerase in successive reactions in the same tube.
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Performing Hot Start PCR 

Competing side reactions can become a major obstacle to routine, sensitive and 
specific PCR amplification. Examples of side reactions include amplification of 
non-target sequences in background DNA (mis-priming) and primer 
oligomerization. These reactions usually occur during pre-PCR setup when you 
mix together all reactants at room temperature.

In the Hot Start™ technique, you add reagents to the reaction tubes so that all 
reactants do not mix until they reach a temperature high enough to suppress 
primer annealing to non-target sequences. You can perform either a manual Hot 
Start or an AmpliWax™ PCR Gem-mediated Hot Start.

To perform a manual Hot Start:

Note Although manual Hot Start can increase specificity and yield, it is 
inconvenient and you may encounter reproducibility and contamination 
problems.

1. At room temperature, mix all reactants except AmpliTaq DNA polymerase 
below a mineral oil cap.

2. Load all tubes into a GeneAmp PCR instrument system.

3. Define temperature control parameters so that the temperature rises to 
70–80˚C.

4. Add AmpliTaq DNA polymerase enzyme to each tube, changing pipet tips 
after each sample.

To perform AmpliWax PCR Gem mediated Hot Start:

1. At room temperature mix all reactants except AmpliTaq DNA polymerase 
in each reaction tube.

2. Add a single AmpliWax PCR Gem to each reaction tube.

3. Define temperature control parameters so that the temperature rises to 
70–80˚C for 5 to 10 minutes, then cools to room temperature. This creates 
a wax barrier over the aqueous layer.
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4. Add the omitted reagent(s) and the test sample above the solid wax layer.

5. Create a PCR thermal profile as follows:

a. Rapidly heat samples to the first denaturation temperature.

This melts the wax layer, denatures the DNA template, and creates 
enough thermal convection to assure complete mixing of all PCR 
components under the melted wax. The wax also serves as a vapor 
barrier during cycling.

b. Program temperature control parameters for conventional thermal 
cycling.

6. Run the PCR.

After thermal cycling ends, the wax forms a solid shield, preventing 
spillage and evaporation.

7. For post-PCR analysis, you can penetrate the wax layer with a pipet tip and 
withdraw the PCR product. 

8. Reheat to seal for long-term storage.

Note AmpliTaq Gold DNA polymerase is a modified form of AmpliTaq DNA 
polymerase specifically designed for Hot Start PCR. AmpliTaq Gold is 
provided in an inactive state and regains activity through a pre-PCR 
heat step. Contact Applied Biosystems for more information about 
AmpliTaq Gold.
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Setting Temperature Control Parameters

Temperature control parameters are the temperature values and hold times you 
specify for a PCR thermal profile. Table E-2 shows guidelines you can follow when 
considering the effects of different PCR parameters on the outcome of a PCR 
reaction.
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Table E-2.  How Changing Temperature Control Parameters Affects the PCR 

DNA denaturation is the critical step in the GeneAmp PCR process and is often 
the focus of attention if PCR experiments fail. The practical range of effective 
denaturation temperatures for most samples is 94–96˚C.

Always allow sufficient time for thermal equilibration of the sample at this high-
temperature plateau. 

Temperature Control Parameter  PCR Performance

Raising the denaturation 
temperatures (up to 96˚C)

Amplifies GC-rich templates

Lowering annealing temperatures Increases yield, but may reduce 
specificity

Varying the annealing or 
denaturation temperatures in each 
run. For example, six runs with
annealing temperatures that vary by 
2˚C per run.

Increases chances of annealing

Setting each denaturation, annealing, 
and extension step to at least 15
seconds (preferably 30 seconds).

Allows complete extension of PCR
product

Using the autoextension function of a 
thermal cycler, to vary the parameters 
to allow longer extension times in the 
later cycles.

Increases yield
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Avoiding Contamination

PCR protocols can be very sensitive to contaminants in the DNA, as well as to DNA 
degradation that occurs before or during the purification process. 

Note Although many protocols have been published recently that describe 
“simple” or “fast” extraction or purification methods, you should carefully 
evaluate any changes or improvements in extraction or purification 
methods. Also, be sure that the physical and chemical condition of the 
sample itself is adequate for the intended labeling and assay method.

Sample contamination when preparing or analyzing samples can impair the PCR 
process, and lead to poor results.

Preventing PCR Product Carryover

Carryover of PCR products from previous amplifications contaminates samples, 
resulting in false–positive amplifications. Adopting the following laboratory 
practices can help you minimize the likelihood of PCR product carryover:

• If possible, use positive displacement pipets.

• Always run a negative control to ensure that target DNA from previous 
experiments does not contaminate your samples.

Note A negative control contains no DNA. The negative control contains only 
the DNA diluent (usually water or buffer).

• For each run, use the same reaction composition and samples in the same 
tubes, but after each run transfer the product to a unique product tube.

• Physically separate reactions prior to and following amplification. For each 
reaction, use separate sets of devices such as automatic pipetters, 
disposable pipet tips, microfuge tubes, and gloves.

• Use identical pipetting techniques for each run, but handle pre- and post- 
PCR solutions with separate dedicated pipetters.
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• Aliquot reaction reagents so as to minimize the number of times you use a 
particular stock solution.

• Use AmpErase® UNG in reaction mixtures to prevent the subsequent re-
amplification of DU-containing PCR products.

Cleaning Up Spills on Work Surfaces

If you do spill samples on your work surface, use a cloth soaked with 50% bleach 
to clean your bench top, thermal cycler sample blocks, or any other work surfaces 
contaminated with nucleic acids.

IMPORTANT When cleaning the sample block of a thermal cycler, refer to the 
instrument manual for proper cleaning instructions.
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Analyzing Post-PCR Products

If your PCR does not produce enough product to analyze, check the following:

• Did you add the right amount of enzyme to your reaction mixture?

• Did you use the right size GeneAmp or MicroAmp Reaction tubes for the 
Applied Biosystems thermal cycler you are using?

• Did you check the chemical integrity of the primers?

Suggestions for improving yield:

• Pre–incubate samples at 95˚C for 5 to 10 minutes in the absence of enzyme. 
This inactivates harmful proteases or nucleases in the sample. Pre-
incubation also ensures complete denaturation of complex starting 
templates.

• Consider performing the Hot Start technique (See Performing Hot Start 
PCR on page E-8).
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Applied Biosystems

Glossary
This glossary defines special terminology 
used in the ABI PRISM 373 DNA Sequencer 
with XL Upgrade User’s Manual. The terms 
are listed in alphabetical order. Many terms 
are defined in the text of the user’s manual, 
so if you do not find a term here, check the 
index.

beam stop – laser beam safety stop. This is the 
bar that prevents outside exposure to the 
laser beam when it is scanning the gel.

channels – divisions across the read region of 
a gel where the data collection software 
samples the data. The number of wells in the 
loading comb used determines the 
approximate number of channels assigned 
per lane of the gel (for instance, with a 36-
well comb, one lane is approximately five 
channels). When the Sequencing Analysis 
software tracks a gel, it places the tracker line 
for each lane in the channel showing the 
strongest fluorescent signal. The data from 
that channel and the adjacent channel on 
each side (total of three) are averaged to 
determine the raw data for the sample file.

Classic – This configuration includes 370s 
with Macintosh upgrade and the 373A. 
Classic models have electrophoresis 
chambers which support 24-cm WTR 
distances.

data point – The data collection software 
samples data 194 or 388 times as it scans 
across the gel. Each “sampling” is stored as a 
data point. A data point is also represented by 
one line on the Map or Gel display.

electropherogram – a four-color 
representation of a sequence, showing peaks 
that represent the bases. The term is used 
interchangeably with chromatogram in this 
manual. An electropherogram is generated 
by the Sequence or GeneScan Analysis 
applications.

exporting – storing the contents of selected 
sequences in a file other than the associated 
data file. 

Firmware Image – a file containing the 
executable software needed to run the 
Translation Processor (TP). This code is 
automatically sent to the TP by the 
ABI PRISM 373XL collection software 
running on the Macintosh, if the TP 
indicates it has no firmware.

gel casting comb – a specially formed piece of 
Mylar or Valox used to create wells or a single 
slot at the top of the gel during 
polymerization. For Sequencing 
applications, use the sharks-tooth comb after 
the single slot is formed by the gel casting 
comb. 

gel image – the colored display of the Gel file 
that appears on the computer screen. To 
decrease the size of the file, you can use the 
GelDocII program to remove the image from 
the file. If you do so, you cannot display the 
gel image on the screen. If you remove the 
image from the file, you can also use the 
GelDocII program to rebuild the image.

grid - a spreadsheet-like display used for 
entering data in tabular format. The Sample 
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Sheet and several data collection windows 
display grids for entering Sample 
information.

hygroscopic - readily absorbing moisture

image – see firmware image, gel image.

Instrument file – a file used to adjust for the 
spectral overlap between the fluorescent dyes 
used on the ABI PRISM 373 DNA Sequencer 
with XL Upgrade. A mathematical matrix of 
the spectral overlaps is created and the 
inverse matrix is used to correct the data 
during analysis. The file is stored in the ABI 
folder in the System folder.

INIT – a Macintosh system extension that 
expands the capabilities of the system 
software. Examples are printer drivers and 
programs that add features to the Finder or 
the system software. INITs are stored in the 
extensions folder inside the System folder. 
Do not use CDEVs and INITs other than 
those shipped with your system.

IUB code – alphabetic character 
representing the occurrence of mixed bases 
at a given position in a sequence. Originally 
defined by the International Union of 
Biochemistry. The following table contains a 
list of IUB codes, the mixed bases they 
represent, and a listing of the complements.

IUPAC – International Union of Pure and 
Applied Chemistry. IUB codes are also 
referred to with this acronym, since IUPAC 
adopted the codes as a standard.

length – the length of a sequence is the 
number of characters it contains.

LED – light emitting diode. In this manual, 
this term refers to the status-indicator lights 

on the front and the back of the instrument. 
In general, this refers to a “semiconductor 
diode that converts applied voltage to light 
and that is used in digital displays”, such as 
calculator and some computer displays (The 
American Heritage Dictionary, Second College 
Edition, Houghton Mifflin Company: 
Boston/New York,1991; p 721).

IUB Codes and their complements
IUB Codes Complements

A = Adenosine R = A or G (puRine) A T S W

C - Cytidine Y = C or T (pYrimidine) C G W S

G = Guanosine K = G or T (Keto) G C

T = Thymidine M = A or C (aMino) T A B V

B = C,G, or T S = G or C (Strong— 3 H bonds) D H

D = A, G, or T W = A or T (Weak—2 H bonds) R Y H D

H = A, C, or T N = aNy base Y R V B

V = A, C, or G K M N N
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Leon – this Model 373 configuration has an 
electrophoresis chamber which supports 6-, 
12-, and 24-cm WTR distances.

matrix file/multicomponent matrix – a file 
used to adjust for the spectral overlap 
between the fluorescent dyes used on the ABI 
PRISM 373 DNA Sequencer with XL Upgrade. 
A mathematical matrix of the spectral 
overlaps is created and the inverse matrix is 
used to correct the data during analysis. The 
file is stored in the ABI folder the System 
folder.

module – a file that provides instructions 
about conditions of operation to the 
instrument. You might use three different 
modules during a typical run to specify 
conditions for plate check, pre-run, and the 
run itself.

PMT – photomultiplier tube. 

read region – The region of the glass plates 
where the laser scans. The location of this 
area depends on the instrument. See Figure 
6-3. and Figure 6-3. on page 2-6.

sample files – data files produced by the 
Analysis Software associated with the ABI 
PRISM 373XL DNA Sequencer. These files 
contain data produced by the instrument: a 
sequence of base calls, peak locations, and an 
electropherogram. The original data in 
sample files is always maintained in its 
pristine state (as it came from the ABI PRISM 
373 DNA Sequencer with XL Upgrade). 
When you save changes you have made to the 
sequence, they are stored to a copy of the 
original data called the editable data. 

separation distance – the length from the 
wells of the gel to the read region of the gel. 
Also called the well-to-read or WTR.

sequence – a linear series of characters. The 
characters are displayed in rows from left to 
right. More specifically, a sequence is a series 
of nucleotide base characters that represent a 
linear DNA sequence, or a series of amino 
acid characters that represent a protein 
sequence.

sequencing reactions – the chemistry 
performed to incorporate fluorescent dye 
labels into DNA extension products. The 
chemistries and kits supplied by Applied 
Biosystems for performing such reactions are 
described in the ABI PRISM 300Sequencing 
Chemistry Guide.

settings – choices that you specify in the data 
collection software about the parameters 
used for data collection.

sharks-tooth comb – Mylar or Valox device 
used to form wells for a sequencing gel. It is 
inserted after the gel has polymerized with 
the gel casting comb in place. The casting 
comb is removed, leaving a slot into which 
the sharks-tooth comb is inserted.

square-tooth comb – specially formed piece 
of Mylar or Valox used to create square-
shaped wells at the top of a gel during casting.

Stretch - this Model 373 configuration 
supports 6-, 12-, 24-, 34-, and 48-cm WTR 
distances and is easily identified by its 
extended door. 

tared – counterbalanced.



Applied Biosystems

G-4 Glossary March 2001

text files – type of simple file produced by all 
Macintosh word processing programs, and 
many other programs. 

Translation Interface Processor– this device, 
which sits on top of the computer’s CPU, 
serves as the communication link and data 
buffer/translator between the ABI PRISM 373 
DNA Sequencer with XL Upgrade and the 
Power Macintosh. 

well-to-read length (WTR) – the distance 
from the wells of the gel to the laser scanning 
(read) region of the gel; separation distance 
for a run. The length of the glass plates is 
usually expressed as the well-to-read length 
(for instance, when you prepare a gel using 
34-cm plates, the separation distance 
between the sample loading wells and the 
read region of the gel is 34 cm).
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Index
Symbols
0.2 mm gel spacers, using when assembling 

the plates 2-15
0.3 mm gels casting comb

 48 cm combs 2-26
10 mM Tris-Cl (pH 8.0), 1 m M EDTA (pH 

8.0) B-11
24 cm BaseSprinter

 preparing 4.75% gel 2-19
34 cm Full Scan gel

 preparing 4.75% gel 2-19
373 DNA Sequencers

 configurations 1-4
 difference from ABI PRISM 373 with XL 

upgrade 1-20
373 with XL upgrade 23
4% acrylamide-urea gel solutions 2-19, 2-25
4.75% acrylamide-urea gel solutions 2-19
48 cm gel

 casting 2-23–2-24, 2-26–2-27
 preparing 4.0% acrylamide gels 2-25

48 cm run
 applying the Bind-Silane 

compound 2-14, 2-22
 preparing glass plates 2-22

6% acrylamide-urea gel solutions 2-19

A
abbreviations, table of B-10–B-11
ABI folder

 files located in 5-73
  See Sequencing Analysis program

ABI PRISM 373 DNA Sequencer with XL 
upgrade

 system hardware 6-3–6-9
ABI PRISM 373 with XL upgrade 15

 clearing random access memory 7-8

 difference from ABI 373 1-20
 general description 1-9–1-13
 power switch 6-17
 status lights 6-17
 system hardware 6-3–6-5
 using for sequencing and 

GeneScan 1-10–1-11
 See Also computer; maintenance

ABI PRISM 373 with XL upgrade
 controlling manually 5-59–5-60
 data flow diagram 5-72
 detection described 2-9
 firmware 6-18
 general default settings 3-20, 4-23
 general description

how it works 1-12–1-13
 instrument maintenance 8-3–8-7
 instrument status and control 6-19–6-20
 Macintosh vocabulary and operations 7-6
 programs that come bundled with 1-16
 setting up 3-6–3-38, 4-9
 software provided 7-5
 system hardware 6-3–6-5
 throughput 1-14
 translation processor status and 

control 6-17–6-19
 using for sequencing and GeneScan 1-11

About ABI PRISM 373 with XL 
upgradecommand 5-5

acrylamide
 denaturing gels described 2-9–2-12
 effect of impurities on 

sequencing 2-3–2-4
 gels

electrophoresis 1-12
recipes B-5
troubleshooting 8-3
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 polymerization 2-3
 preparing stock solution 2-11
 safety warning 2-4, 2-9, 2-18
 solution for gel 2-18–2-19
 stock solution purchase 2-4, 2-10
 storage 2-4

acrylamide-urea gel solutions
 recipes for 2-18–2-19, B-5
 See Also acrylamide

acrylic acid, hydrolysis product 2-4
adding

 software programs 7-10
After Dark®

 compatibility with the instrument 
system 7-10

air bubbles
 effect on gel quality 2-7
 under gel plates in buffer chamber 4-41
 See Also quality, factors affecting gel quality

Alconox™
 using to wash plates 2-13, 3-48, 4-51

alerts, red 5-57
alignment algorithms for DNA 1-18
alignment brace, marking on

 Classic configuration 4-36
 Leon configuration 3-36, 4-38
 Stretch configuration 4-40

amber LED 6-19
ammonium persulfate. See APS
AmpErase UNG E-13

 See Also carryover of PCR products
amplification, unsuccessful 4-58, 4-59
AmpliTaq® DNA Polymerase 4-58, E-6

 commonly used 1-11
 reducing concentration to improve data 

quality 4-57
AmpliWax PCR Gem E-8

analysis
 after analysis, automatic 

printing 3-25, 4-53, 5-67
 analyzing data electropherograms 3-51
 automatic 

analysis 3-50–3-51, 4-53, 5-24, 5-27
and sample sheet 5-32

 customize settings before run 4-8, 4-19
 default Base Caller for automatic 

analysis 3-16
 further analysis of processed 

data 1-17–1-18
 recording sample 

information 3-21–3-22, 5-32
 Sequencing Analysis program 5-75
 setting up automatic analysis 3-15
 use separate sample sheets for sequence 

or fragment analysis 3-21
 using a setting other than default 3-5
  See Also GeneScan

analysis software, setting up
 GeneScan mode 4-19
 recommended amount of RAM 7-3
 Sequencing mode 3-16

analyzing 3-50–3-51
 electropherograms 3-51
 in GeneScan mode 4-53
 post-PCR products E-14
 wavelengths of the dyes being 

detected 3-50
annealing temperature E-11

 increasing to improve data quality 4-57
Apple menu 5-5
APS 2-3

 adding to cast the gel 2-20
 changing concentration, effect of 2-7
 preparing gels 2-12
 storage 2-5

archiving 4-65–4-66
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 backing up data to magnetic 
tape 3-53, 4-66

 before optimizing your disk 7-12, 8-7
 files 5-66

created during a run
GeneScan mode 4-65–4-66
Sequencing mode 3-52–3-53

other files 3-53, 4-66
 See Also saving

Auto Analyze checkbox 3-50–3-51
 automatic analysis after analysis 4-53
 completing the Sequence Run window for 

a pre-run or run 5-43
Auto Print checkbox 3-25, 4-53

 automatic printing after 
analysis 4-29, 5-45, 5-67

 completing the Sequence Scan window 
for a pre-run or run 5-43

AutoAssembler software™ 1-17, 1-18
autoextension, uses of E-11
automatic analysis. See analysis
automatic lane tracker 3-41
autoradiogram

 reconstructed data displayed in Gel 
window 1-13

  See Also Gel window

B
backing up. See archiving
bands, smeared or fuzzy 4-57
Base Callers

 default for automatic analysis 3-16
base spacing 1
baseline subtraction, processing data 1-16
bases

 colors in real-time displays 5-53, B-9, C-4
 positions on electropherogram 3-51

BaseSprinter mode 6-12–6-13
battery backup 6-17

beam-stop bar 1
 installing 4-13

Bind-Silane
 applying the compound to the 

plate 2-14, 2-23
bis-acrylamide 2-4

 effect of impurities on sequencing 2-3
 polymerization 2-3
 safety warning 2-4, 2-9, 2-18
 storage 2-4

buffer
 affect of impurities 2-6
 flush wells before loading 4-41
 loading for better accuracy 3-40
 recipes 2-10–2-11

buffer chambers 6-10
 removing air bubbles 4-41
 See Also individual sequencer 

configuration
buttons

 Cancel button 5-46
 color, using to change color 5-30
 Execute button (manual control) 5-59
 Pause button 5-46

pausing to load additional 
samples 3-43

 PreRun button 3-39, 4-41, 5-45
 to control instrument 3-23, 4-27, 5-41

C
calibration file

 checking and adjusting 5-61–5-64
Cancel button 5-46
Cancel Run 5-9

 using the Cancel button to stop a pre-run 
or run 5-46

 using to stop a run before it is 
finished 5-48

carryover of PCR products E-12–E-13



Applied Biosystems

I-4 Index March 2001

 evidence of 4-56
casting comb. See gel casting comb
casting gels 2-20

 48 cm 2-23–2-24
 48 cm gel 2-26–2-27
 inserting the gel casting comb 2-20
 See Also gels

channels 1
 numbers in lanes 3-29–3-31

chemical hazard
 formamide 3-40, 4-42
 reagents and supplies for gels 2-11
  See safety warnings

chemistry
 associated with dye set 5-52
 determines color on real-time 

display 5-52
 sequencing C-3

chromatograms. See electropherograms
Classic, Model 373 DNA Sequencer 

configuration 1-4, 1
 completing instrument 

setup 3-35–3-36, 4-36–4-37
 model specific notation 3-8, 4-11
 preparing the electrophoresis 

chamber 3-9, 4-12–4-13
 replacing lower electrode 8-6–8-7
 replacing upper buffer chamber 8-4–8-5

cleaning
 after a run

in GeneScan mode 4-50
plates, comb, and spacers 4-51

in Sequencing mode 3-47
 instrument accessories 8-3
 plates

in GeneScan mode 4-31–4-32
in Sequencing mode 3-28–3-29

 sample block of thermal cycler E-13
 up spills in work area E-13

Clear command 5-8
client-server, upgrade for the AutoAssembler 

Sequence Assembly Software 1-18
Close command 5-6
closing windows 5-10, 5-49, 5-68
codes, dye indicator defaults 5-30
colors

 bases in real-time displays 5-53
 in electrophoresis history window 5-57
 in real-time displays C-4, D-4
 setting defaults for data display and 

printing 5-29
 using Color button to change color 5-30
 wavelengths of the dyes being 

detected 3-50
combs 6-7–6-9

 compatibility with spacers and casting 
comb 2-15, 3-34

 table of combs and run modes B-9
  See Also gel casting comb

comprehensive record of errors, 
status 3-45, 4-48

computer
 ABI PRISM 373 with XL upgrade 

system 1-9
 adding software programs 7-10
 installing the software 7-4–7-5
 log of conditions 5-74
 Macintosh vocabulary and operations 7-6
 maintenance 7-7–7-12
 rebuilding the desktop 7-5
 software provided 7-5
 special software for data collection and 

analysis 7-5–7-6
 system requirements 7-3
  See Also Macintosh

computer system. See computer
concentration

 of initiator and polymerization 2-6, 2-7
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contamination E-12–E-13
 cleaning plates 3-28–3-29, 4-31–4-32
 cleaning up spills E-13
 preventing PCR product 

carryover E-12–E-13
 using distilled, deionized water to avoid 

contamination of reagents 2-6
 See Also marking the alignment brace; 

samples
control reactions

 evaluating quality of data 4-54
 inconsistent results with 4-60

COP assay
 using GeneScan to perform quantitative 

gene analysis 1-17
Copy command 5-8
corrupted memory 6-18
CP Optimizer

 using to maintain your hard disk 7-11
creating

 GeneScan analysis sample 
sheet 5-36–5-37

 GeneScan matrix file D-6–D-15
creating the matrix file D-10–D-12
matrix standards D-6
preparing, loading and electro-

phoresing matrix 
standards D-6–D-9

 GeneScan sample sheet 4-24–4-26
 icon for creating Run folder 5-40
 Instrument file C-5
 Run file for GeneScan mode 4-26–4-29
 sample sheet 3-21–3-22, 5-36–5-37
 Sequence sample sheet 5-34–5-35

crossover between color channel 
(troubleshooting) 4-61

current (voltage), problems with 4-64
Cut command 5-8

D
data

 analysis software 1-16–1-18
 appearing as on autoradiogram 1-13
 archiving 3-52–3-53
 characteristics of good data 4-55
 characteristics of poor data 4-56
 color in real-time displays D-4
 evaluating quality of 4-58–4-64
 general description of data analysis 1-13
 interpreting 3-50–3-51
 printing 1-13
 real time observation of data 1-12, 3-45
 saving 3-52, 4-65–4-66
 software for analysis 1-16–1-18
  See Also viewing

data collection
 data collection run log error 

message 8-16
 getting program information 5-5
 menu commands 5-5–5-11
 PMT gain and calibration file 5-61–5-64
 preparing for a run 5-12
 program files 5-70–5-76

files located in the system 
folder 5-76

input and output files 5-73–5-76
output files 5-74–5-75
temporary files located in the system 

folder 5-76
 quitting the program 5-68
 setting preferences for data collection 

program 5-14–5-29
 starting Data Collection software

in GeneScan mode 4-20–4-29
in Sequencing mode 3-17

 temporary files created in the system 
folder 5-76



Applied Biosystems

I-6 Index March 2001

 using the data collection 
program 5-12–5-13

data point 1
database, exporting files for 5-67
DataUtility software

 bundled with Sequencing Analysis 
program 1-16

 using to make and copy matrices 7-5
ddNTP, defined B-10
defaults 3-19–3-20, 4-22–4-23

 Base Caller for automatic analysis 3-16
 file names in Sequencing 

mode 3-19, 4-22
 general settings 5-27–5-29
 saving module settings as 

defaults 3-18–3-19
 setting

for GeneScan Analysis 
applications 5-25–5-31

for Sequencing Analysis 
applications 5-21–5-24

 table of ABI PRISM 373 with XL upgrade 
module default values B-6

definitions of terms 1–4
defragmenting your hard drive 7-7–7-10
deionizing resin

 preparing acrylamide stock solution 2-11
 preventing breakdown 2-9

denaturing gels
 changing temperatures affects the 

PCR E-11
 preparing 2-9–2-12
  See Also gel

deoxynucleoside triphosphate (dNTP)
 optimizing PCR reaction E-5

detection
 ABI PRISM 373 with XL upgrade 

description 1-12
 affected by gel fluorescence 2-9

dH2O, defined B-10
diffuse bands, resulting from Acrylic acid 2-4
digitized output signal 1-12
Disk Express II

 using to maintain your hard disk 7-11
 using to optimize the hard disk 7-9

DiskTools, using to defragment your hard 
drive 7-7–7-10

displays, in real-time 5-52–5-58
 filters and color guide 5-52–5-54
 using

the Electrophoresis History 
window 5-57–5-58

the Gel window 5-56
the Scan window 5-55

Dithiothreitol B-10
DNA

 alignment using Sequence 
Navigator 1-18

 assembling using AutoAssembler 
software 1-17

 electrophoresis and detection 1-12
 incorporating dye labels 1-11
 mitochondrial, using Sequence Navigator 

to screen sequences 1-18
 optimal quantities for sequencing 3-5
 PCR template concentration E-6
 resuspending 3-40
 sizing and quantitating 

fragments 1-9, 7-5
 table listing sequencing resuspension and 

loading volumes 3-40
 template concentration E-6
 using a negative control E-12

DNA Sequencing Analysis software 1-16
  See Also Sequencing Analysis program

DNA Thermal Cycler
 tube types E-4

DNA Thermal Cycler 480
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 tube types E-4
document icons

 in run window 3-23, 4-27, 5-40, 5-41
DTT (Dithiothreitol) B-10
dyes

 analyzing wavelengths of the dyes being 
detected 3-50

 dye indicator defaults 5-29
 fluorescent dyes for labeling 1-12
 indicator defaults 3-20, 4-23
 table

dye set and filter sets by 
chemistry B-9

dyes and filter set color displays D-5
DyeSet/Primer

 choosing in sample sheet 5-35
 file naming conventions 5-34–5-35
 setting default for sample sheet 5-21

E
Edit menu 5-8
editing, sample sheet 5-37–5-39
EDTA

 defined B-10
 resuspending DNA 3-40

electrical shock. See safety warnings
electrodes, replacing 8-3
electropherograms 1

 reading 3-51
 setting default colors for 5-29

electrophoresis
 ABI PRISM 373 with XL upgrade 

description of how instrument 
works 1-12

 chamber, setting up for sequencing 3-12
 current and voltage during a run 5-50
 power supply

about 6-10

displaying the set and actual 
values 5-57

 pre-running to check the system 3-39
 replacing cables and electrodes 8-3
 troubleshooting table for GeneScan 

mode 4-58
Electrophoresis History window

 command 5-11
 setting scale 5-58
 using to view instrument status in 

real-time 5-57–5-58
enzyme concentration E-6–E-7
errors

 data collection run log errors 8-16
 log file 3-45, 4-48
 messages 7-11
 using the Log file 5-51–5-52

Excel®, exporting the sample sheet to 5-74
Execute button 5-59
exporting 5-7, 1

 sample sheet information 5-33
 using to save the contents of a window 

grid 5-67
extensions

 turning off when restarting 7-10
extraction procedures 4-58

F
Factura software 1-17
felt-tipped pens, using. See marking the 

alignment brace
File menu 5-6–5-7
files

 .seq files 5-75
 ABI folder, files located in 5-73
 archiving 5-66
 automatically change generated file 

names 5-20
 Data Collection program files 5-70–5-76
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 ensuring disk space for automatically 
created 
files 3-27, 3-42, 4-30, 4-45, 4-46

 importing and exporting 5-67
 input files in the Data Collection 

program 5-71–5-74
 located in the system folder 5-76
 locations on computer 5-71
 output files in the Data Collection 

program 5-74
 printing 5-66–5-67
 removing non-essential files from hard 

disk 7-9
 resetting global serial number (for file 

names) 5-27
 Sample file format compatible with other 

programs 1-16
 saving 5-65
 temporary files 5-76
  See Also run file; sample sheet

Fill Down command 5-8
filter sets

 color displays, table of D-5
 filter set table for GeneScan 5-53–5-54

filter wheel and data 
display 6-13–6-15, C-3–C-4

 GeneScan matrices D-4–D-5
firmware 6-18

 clearing if memory corrupt 6-18
 image, defined 1

fluorescence
 checking the plates for 3-27–3-38
 dye-labeled primers 1-11
 spectra

matrices C-3
overlap corrected with matrices D-3

  See Also dyes
flushing wells before loading 4-41

folders
 changing data storage folders in 

preference settings 5-17–5-18
 creating Run folder 5-40
 default location 3-19, 4-22
 diagram, locations on computer 5-71

forensics applications, evaluating the quality 
of the data 4-54

formamide
 chemical hazard 3-40, 4-42
 resuspending DNA 3-40
 using in empty wells 3-42, 4-44, 4-45

format
 log file 5-51
 tab-delimited text 5-67

fragment analysis
 sample sheet defaults 5-25
 sizing and quantitating 1-9, 7-5
 use separate sample sheet 3-21, 5-32
  See Also GeneScan

free radical, factor that affect gel quality 2-7
Full Scan mode 6-12

G
gel

 casting 2-20–2-21
 cleaning plates after run 3-48
 color guide for gel image displays B-9
 completing

GeneScan Run window for a pre-run 
or run 5-43–5-45

Sequence window for pre-run or 
run 5-41–5-43

 detection described 2-9
 determining which lanes in a gel are 

contaminated 3-29–3-31
 factors that affect gel quality 2-6
 matrix formation 2-3
 polymerization mechanism 2-3
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 preparing
the acrylamide-urea 

solution 2-6, 2-18–2-19
the gel for loading in GeneScan 

mode 4-9–4-10
the glass plate 2-13–2-14
to mix sequencing gel 2-11–2-12

 pre-running the gel 3-39
 reagents

for stock solutions 2-10–2-11
purity 2-18
reagents and supplies 2-11–2-12

 reducing the size of the gel image file 1
 removing the gel from the instrument

in GeneScan mode 4-50–4-51
in Sequencing mode 3-47–3-48

 run readings under normal 
conditions 5-51

 scanning the plates for 
fluorescence 3-27–3-38, 4-30–4-31

 temperature status during run 1-12, 5-57
 tips for preparing gels for long runs 2-20
 troubleshooting 8-14–8-15
 using for consistent results 2-8

gel cassette
 mounting glass plates 2-15–2-17

gel casting comb 1
 48 cm gels 2-26
 air bubbles trapped between comb and 

solution 2-7
 compatibility with combs and 

spacers 2-15, 3-34
 inserting 2-20
  See Also square-tooth comb; Sharks-tooth 

comb; gel, preparing to mix 
sequencing gel

gel files 5-74
 acrylamide gel recipes B-5
 and GelDoc II software 1-16

 archiving 3-52, 4-65
 removing file from hard disk 7-9
 saving 3-52, 4-65, 5-66
 using GelDocII 7-5

gel image 1
 command 5-11

gel plate rest
 adjusting 4-16
 components of 3-13, 4-16

gel spacers 2-15, 6-7
 compatibility with combs and casting 

comb 2-15
 if longer than the full length of the glass 

plates 2-15
Gel window

 viewing data 1-13
in real-time 3-45, 4-49

 viewing instrument status 5-56
GelDocII 1-16

 using on Gel files 7-5
 using to reduce the size of the gel image 

file 1
GeneAmp PCR System 2400

 tube types E-4
GeneAmp PCR System 9600

 misaligned lid 4-60
 tube types E-4

GeneAmp Thin-Walled Reaction Tubes
 See reaction tubes

GeneAssist, using to search biological 
databases 1-18

GeneScan 1-17
 analysis application, setting 

defaults 5-25–5-31
 creating a sample sheet 5-36–5-37
 filter set table 5-53–5-54
 flowchart of typical run process B-4
 Genotyper software to convert data 1-18
 matrices D-3–D-15
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creating a matrix file D-6–D-15
creating the file D-10–D-12
matrix standards D-6
preparing, loading and electro-

phoresing matrix 
standards D-6–D-9

filter wheel and data 
display D-4–D-5

Matrix Standard kits D-3
verifying quality of 

matrix D-13–D-15
 preparing samples 4-41–4-43
 sample files created by 5-75
 sample sheet

different from sequencing 3-21
run defaults 5-25

 set analysis parameters before 
run 4-8, 4-19

 table of run times and filter sets B-8
 template shipped with 

system 3-17–3-19, 4-20–4-21
 using on the ABI PRISM 373 with XL 

upgrade 1-11
 using on the ABI PRISM 373 with XL 

upgrade 1-11
 See Also GeneScan mode

GeneScan Analysis Software User’s 
Manual 1-10

GeneScan mode
 before you set up the instrument 4-5–4-8

experimental design 
considerations 4-5–4-7

preparing samples 4-5
setting up the instrument 4-8

 checking the plates 4-30–4-40
checking PMT setting 4-32–4-34
completing instrument 

setup 4-36–4-40

inserting the Sharks-tooth 
comb 4-34–4-35

 cleaning, after a run 4-50
 evaluating the quality of the data 4-54

characteristics of good data 4-55
characteristics of poor 

data 4-56–4-57
 loading samples 4-43–4-47
 preparing the sample

for electrophoresis 4-42–4-43
pre-running the gel 4-41

 setting up the instrument 4-9–4-18
preparing the electrophoresis 

chamber 4-11–4-18
for Classic 

configuration 4-12–4-13
for Leon 

configuration 4-13–4-14
for Stretch 

configuration 4-11–4-18
preparing the gel for 

loading 4-9–4-10
 setting up the software 4-19–4-29

creating a Run file 4-26–4-29
creating the GeneScan sample 

sheet 4-24–4-26
setting default parameters 4-22–4-24
setting up the analysis software 4-19
starting the Data Collection 

software 4-20–4-29
 troubleshooting table 4-58

GeneScan Run window
 completing for pre-run or run 5-43–5-45

Genotyper™ software 1-18
getting started

 quick start information 1-8
glass plates

 about 6-6–6-7
 alignment example 2-16
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 casting gel example 2-13
 cleaning 2-13–2-14

after a run 3-48
previously used plates 2-14

 drying plates 2-13
 marking the outside to use the same 

side 2-14, 6-7
 mounting in cassette 2-15–2-17
 non-fluorescence importance of 2-9
 position in buffer chamber 3-13, 4-16
 preparing

for gels 2-22
for GeneScan mode 4-9–4-10
for loading the gel 3-6

 scanning the plates for 
fluorescence 3-27–3-38, 4-30–4-31

 temperature for gel formation 2-6
global

 parameters 5-14
 serial number, resetting 5-27

glossary 1–4
 base spacing 1
 beam stop 1
 channels 1
 Classic (Model 373 DNA Sequencer 

configuration) 1
 data point 1
 electropherogram 1
 exporting 1
 gel casting comb 1
 gel image 1
 grid 1
 hygroscopic 2
 INIT 2
 Instrument file 2
 IUB (International Union of 

Biochemistry) codes 2
 IUPAC (international Union of Pure and 

Applied Chemistry) 2

 LED 2
 length 2
 Leon (Model 373 DNA Sequencer 

configuration) 3
 matrix files 3
 modules 3
 multicomponent matrix defined 3
 PMT 3
 read region 3
 sample files 3
 separation distance 3
 sequence 3
 sequencing reactions 3
 settings 3
 Sharks-tooth comb 3
 square-tooth comb 3
 Stretch (Model 373 DNA Sequencer 

configuration) 3
 tared 3
 text files 4
 Translation Interface Processor 4
 WTR (well-to-read length 4

green graph 5-57
green LED 6-19
grid 1

H
hard disk

 backing up files 3-52, 4-65
 ensuring space for automatically created 

files 3-27, 3-42, 4-30, 4-45, 4-46
 maintenance 7-7–7-10

adding software 7-10
optimizing 7-9
programs 7-11
removing non-essential files 7-9

hardware 6-3–6-9
 components 6-4
 loading system 6-6–6-9
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 scanning and detection system 6-11–6-16
the read region 6-12–6-13

 system overview 6-4–6-5
 See Also troubleshooting

hazard. See safety warnings
heat transfer plate, installing

 GeneScan mode
24-cm and 34-cm runs 4-16
24-cm runs only 4-37

 Sequencing mode 3-13, 3-36
help 1-22–1-28

 See also troubleshooting
heterozygote

 screening using the Sequence Navigator 
Sequence Comparison software 1-18

HIV, screening of sequences 1-18
homozygote 4-61
Hot Start technique

 AmpliWax PCR gem mediated E-8
hygroscopic 2

I
icons

 Run window icons 5-40
 small document on Run 

window 3-23, 4-27, 5-40, 5-41
identifying samples 5-32

 See Also samples
image, copying software image to 

firmware 6-17
importing 5-7, 5-68

 files 5-68
 sample sheet information 5-33
 See Also input and output files

Inherit Sequence Analysis System 1-17–1-18
INIT 2
initiator concentration 2-7

 and polymerization 2-6, 2-7
input and output files 5-73–5-76

 See Also importing
installing

 software 7-4–7-5
rebuilding the desktop 7-5

 the beam-stop bar 4-13
instrument

 changing connection port on 
Macintosh 5-27

 control buttons 3-23, 4-27, 5-41
 controlling manually 5-59–5-60
 copying software image to firmware 6-17
 hardware 6-3–6-9

components 6-4
loading system 6-6–6-9
scanning and detection 

system 6-11–6-16
separation system 6-10
system overview 6-4–6-5

 log of conditions 5-74
 maintenance

backing up files 8-7
cleaning instrument accessories 8-3
replacing, electrophoresis cables 

and electrodes 8-3
troubleshooting 8-8–8-16

clearing the memory 8-9–8-12
gel troubleshooting 8-14–8-15
hardware/firmware 8-9–8-12
problems during a run 8-13
total reset of the instrument 8-8
troubleshooting software 8-16

 setting up 3-6–3-38, 4-9
 status and control 6-19–6-20

electrophoresis history 5-57
status indicators 6-19–6-20

 status lights 6-17
location and use on the 

instrument 6-19
instrument and matrix files 6-15–6-16
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Instrument file 2
 creating C-5
 lost file and no backup C-9
 making the first matrix C-8–C-9
 sequencing matrix file C-3
  See Also matrix files

Instrument menu 5-9
 starting a pre-run or run 5-48

instrument status, viewing 1-12
 data in real-time 5-52–5-58

filters and color guide 5-52–5-54
using the Electrophoresis History 

window 5-57–5-58
using the Gel window 5-56
using the Scan window 5-55

 Run file for the current run 5-58
 using the Status window 5-50–5-51

International Union of Biochemistry. See IUB 
codes

International Union of Pure and Applied 
Chemistry (IUPAC) 2

interpreting sequencing data 3-50–3-51
ion-exchange resin. See deionizing resin
Ionic contaminants, acrylamide 2-4
IPTG 

(Isopropyl-ß-D-thio-galactopyranoside)
B-10

IUB (International Union of Biochemistry) 
codes 2

IUPAC (International Union of Pure and 
Applied Chemistry) 2

K
kits

 Matrix Standard kits D-3
 primer extension 1-11

L
lane

 channel numbers in 3-29–3-31
 moving information to a different 

lane 5-39
 specifying sample 

in 3-21, 4-24, 4-26, 5-32
 tracking

affected by air bubbles 2-7
verifying D-10

 using the automatic lane tracker 3-41
laser

 general function during the 
electrophoretic process 2-9

 hazard warning 3-28, 4-31
 laser/scanner assembly, diagram of 6-11
 region scanned, defined 3
 using scan window to sweeps across the 

gel 5-55
LEDs 2

 status lights on the instrument 6-19
 table of status 6-20

length, of a sequence 2
Leon, Model 373 DNA Sequencer 

configuration 1-4, 3
 completing instrument 

setup 3-36–3-37, 4-37–4-39
 model-specific notation 3-8, 4-11
 preparing the electrophoresis 

chamber 3-10–3-11, 4-11–4-14
 replacing lower electrode 8-6–8-7
 replacing upper buffer chamber 8-4–8-5

level gauge, preparing to mix sequencing 
gel 2-12

light emitting diode. See LEDs
linear polyacrylamide, caused by catalytic 

contaminants 2-4
linkage analysis, for use with Genotyper 

data 1-18
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loading
 alternate wells with Shark’s-tooth 

comb 3-41
 description of loading system 6-6–6-9
 flushing wells 4-41
 samples

GeneScan mode 4-43–4-47
Sequencing mode 3-41–3-44

 skipping multiple lanes 4-44
 using formamide in empty 

wells 3-42, 4-44, 4-45
 using the lane tracker properly 3-42, 4-45

Log file
 command to view file 5-11
 log of computer conditions 5-74
 storing 3-52, 4-65
 using to view instrument status 5-51–5-52

long runs, tips for gel preparation 2-20
lower electrode replace. See individual 

instrument configuration

M
Macintosh

 basic vocabulary and operations 7-6
 clearing random access memory by 

restarting before each run 7-8
 Data Collection software described 6-18
 file locations 5-71
 instrument connection change 5-27
  See Also computer

magnesium ion
 concentration effects on PCR 

performance 4-62, E-5
 reactions with rTth DNA Polymerase E-7

magnetic tape drive, backing up 
data 3-53, 4-66, 5-66

main menu 5-5

maintenance
 computer system

backing up files 7-12
error messages 7-11
hard disk maintenance 7-7–7-10

programs for maintenance 7-11
removing non-essential file 7-9
using hard disk 7-9

 instrument
backing up files 8-7
cleaning instrument accessories 8-3
replacing

electrophoresis cables and 
electrodes 8-3

troubleshooting 8-8–8-16
clearing the memory 8-9–8-12
gel troubleshooting 8-14–8-15
hardware/firmware 8-9–8-12
problems during a run 8-13
total reset of the instrument 8-8
troubleshooting software 8-16

Make New Matrix dialog box example D-11
mAmp, in modules B-6
manual analysis with correct primer/dye 

set 5-35
manual control 5-59–5-60

 displaying window for manual control of 
functions during run 5-11

 pausing or cancelling 5-60
Manual Control window

 using to control the instrument 
manually 5-59

manuals. See user’s manual
marking the alignment brace

 on Classic configuration 4-36
 on Leon configuration 4-38
 on Stretch configuration 3-37, 4-40

Master Mix, reason to create 4-57
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matrix
 attaching new to Sample files D-13
 DataUtility software 1-16
 fluorescence spectra C-3

overlap corrected D-3
 formation in gel 2-3
 printing matrix values D-12
 See Also matrix files, matrix standards
 standards C-5
 storing in ABI folder D-3
 using standards C-5
 verifying quality of matrix D-13–D-15

matrix files 3
 choosing in sample sheet 5-35
 creating C-5, C-9

making the first matrix for a new In-
strument file C-8–C-9

matrix standards C-5
preparing, loading and electro-

phoresing matrix 
standards C-6–C-8

 GeneScan D-3–D-15
creating a matrix file D-6–D-15

creating the matrix 
file D-10–D-12

matrix standards D-6
preparing, loading and electro-

phoresing matrix 
standards D-6–D-9

filter wheel and data display D-4–D-5
 Matrix Standard kits D-3
 reasons to create a new matrix D-3
 sequencing matrix files C-3
 using DataUtility software to make and 

copy matrices 7-5
 See Also matrix; matrix standards

Matrix Standard kits provided by Applied 
Biosystems D-3

Matrix Values window D-12

memory, clearing corrupted memory
 symptoms of corrupted memory 8-9

menus
 Apple menu 5-5
 Edit 5-8
 File 5-6–5-7
 Instrument 5-9
 main menu bar 5-5
 Window 5-10–5-11

messages, errors 3-45, 4-48
metals, contaminating buffers 2-6
Mg++

 See magnesium ion
MicroAmp Reaction Tubes

 See reaction tubes
microgram B-10
Microsoft® Excel®

 exporting the sample sheet to 5-74
migration, affected by

 acrylamide contaminants 2-4
 age of gel 2-8

mitochondrial DNA 1-18
mobility

 choosing file in sample sheet 5-35
 inconsistent as a result of impurities in the 

agent 2-3
 inhibited by buffer impurity 2-6
 slow, gel troubleshooting 8-14

modem port 5-27
modifying, sample sheet 5-38

 See Also editing, sample sheet
Module settings dialog box 3-18
modules 3

 ABI PRISM 373 with XL upgrade module 
default values B-6

 creating user-specific 
files 3-17–3-19, 4-20–4-21

 importing and exporting 5-67
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 opening using small document 
icons 3-23, 4-27, 5-40, 5-41

 running manually 5-60
mounting gel plates in cassette 2-15–2-17
mRNA

 using GeneScan to perform quantitative 
gene analysis 1-17

multicomponent analysis, processing 
data 1-16

multicomponent matrix 3
 choosing 5-35

multiple alignment for DNA 1-18
multiplexing

 adding more than one pair of primers 
into the same reaction tube 4-6

 performing multiple PCRs in separate 
reaction tubes 4-7

mutation identification, using Sequence 
Navigator Sequence Comparison 
software 1-18

N
NaCl (Sodium Chloride) B-10
naming conventions for DyeSet/Primer 

files 5-34–5-35
NaOH (Sodium Hydroxide) B-10
New command 5-6
noise levels, using the DataUtility software to 

check 1-16, 7-5
noisy data (too many peaks), characteristic of 

poor data 4-56
non-buffer ions, contaminating buffers 2-6
Norton Utilities

 using to defragment your hard 
drive 7-7–7-10

 using to optimize the hard disk 7-9

O
old gels, affect on results 2-8

one-lane sequencing 1-16
Open command 5-6
opening

 Electrophoresis History window 5-57
 Run window 5-40–5-41
 sample sheet using small document 

icons 3-23, 4-27, 5-40, 5-41
optimizing, computer hard disk 7-9

 See Also maintenance
organic solvents and glass plates 2-13
output files 5-74
oxygen, affect on gel quality 2-7

P
p53, screening of sequences 1-18
page setup 5-6

 specifying parameters about the printout 
before printing 5-66

pairwise alignment of DNA 1-18
parameters

 setting default parameters
GeneScan mode 4-22–4-24
Sequencing mode 3-19–3-21

 setting temperature control parameters to 
optimize PCR E-10

 specifying for run 4-26
Paste command 5-8
Pause button 5-46, 5-60

 pausing to load additional samples 3-43
Pause command

 Instrument menu buttons 5-9
 resuming a pre-run or run 5-48

PCR
 multiplexing the polymerase chain 

reaction 4-6
 optimizing E-3–E-7

analyzing post-PCR products E-14
avoiding contamination E-12–E-13
performing Hot Start PCR E-8–E-9
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setting temperature control 
parameters E-10

 primers
concentration of E-5
storage of 4-63

 products
overlapping allele size ranges 4-6
sizing 1-17

 templates
concentration of E-6
insufficient concentration of 4-58

 troubleshooting 4-58–4-62
PCR Instrument System E-4

 See Also thermal cycler
peaks

 absence of peaks in results file 4-56
 artifacts 4-56
 evaluating the shape of peaks 4-54
 real time viewing 1-12
 removing peaks seen in the Scan 

window 3-28
 split into two peaks 4-62
 too many peaks (noisy data) 4-56

PEG (polyethylene glycol 8000) B-10
photomultipler tube. See PMT
pipetting, correcting errors 4-61
PlateCheck module

 template shipped with 
system 3-17–3-19, 4-20–4-21

plates. See glass plates
platinum wire 4-64
PMT 3

 checking and adjusting gain 5-61–5-64
 checking the setting before loading the 

sample
using GeneScan mode 4-32–4-34
using Sequencing mode 3-32–3-33

poly (A+) RNA
 PCR template concentration E-6

polyacrylamide gel. See gel
Polyethylene glycol 8000 B-10
Polymerase Chain Reaction (PCR)

 optimizing amplifications E-3–E-14
 temperature control parameters E-10
 See Also PCR; Hot Start technique

polymerases, with ABI PRISM 373 with XL 
upgradeL 1-11

polymerization
 affect on gel quality

APS 2-5
buffer impurity 2-6
rate of polymerization 2-6
TEMED 2-5

 mechanism of 2-3
 too slow (troubleshooting) 8-15

poor resolution
 caused by acrylamide impurity 2-4
 troubleshooting 8-14

post-PCR analysis E-14
pouring gels

 preparing the glass plates 2-22
 See Also gels

Power Macintosh computer. See computer
power switch, ABI PRISM 373 with XL 

upgradeL 6-17
preferences

 Preference file described 5-76
 saving 5-14
 setting 5-14–5-29

default
general 5-27–5-29
GeneScan 

preferences 4-22–4-24
GeneScan Run 

defaults 5-26–5-27
GeneScan Sample Sheet 

defaults 5-25
preferences 3-19–3-21
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Sequence Run 
defaults 5-23–5-24

Sequence Sample Sheet 
defaults 5-21–5-22

sequencing analysis 
applications 5-21–5-24

Dye Indicators defaults 5-29–5-31
file name preferences 5-18–5-20
folder location 

preferences 5-16–5-18
fragment analysis sample sheet 5-25

 switching preference windows 5-15
Preferences command 5-11
Preferences Dye Indicators window 5-30
Preferences File Names window 5-19
Preferences Folder Locations window 5-16
Preferences GeneScan Run Defaults 

window 5-26
Preferences GeneScan Sample Sheet 

Defaults window 5-25
Preferences Sequence Run Defaults 

window 5-23
preparing

 DNA for loading 3-40
 electrophoresis 

chamber 3-8–3-15, 4-11–4-18
for Classic configuration 3-9,

4-12–4-13
for Leon configuration 3-10–3-11,

4-11–4-14
for Stretch configuration 3-12–3-15,

4-15–4-18
 gel for loading 3-6–3-7
 gel solutions

4.0% acrylamide gels
for 48 cm gels 2-25

4.75% gel
24 cm BaseSprinter 2-19
34 cm Full Scan gel 2-19

acrylamide-urea gel 
solutions 2-18–2-19

 glass plates
for a 48 cm run 2-22
for gels 2-13–2-14
for GeneScan mode 4-9–4-10
for loading the gel 3-6

Tris Borate EDTA 3-6, 4-9
 samples for loading

for electrophoresis 4-42–4-43
GeneScan mode 4-41–4-43
pre-running the gel 4-41
Sequencing mode 3-39–3-44

 stock solutions
acrylamide stock solution 2-11
TBE stock solution 2-10–2-11

 the gel for loading
in GeneScan mode 4-9–4-10

  See Also reagents
PreRun button

 starting from the Run window 5-45
 to pre-electrophorese gel 3-39, 4-41

Pre-run module
 template shipped with 

system 3-17–3-19, 4-20–4-21
primer concentration

 optimizing PCR reaction E-5–E-6
Primer Express primer design program 1-18
primers

 concentration for PCR 
optimizing E-5–E-6

 extension with commonly used 
polymerases 1-11

 fluorescent dye-labeled 1-11
 kits with dye terminator/dye primer 

chemistries 1-11
 Primer Express primer design 

program 1-18
 See Also PCR, primers
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Print command 5-6
Print One command 5-7
printer port 5-27
printing

 automatic printing after 
analysis 4-53, 5-67

 files 5-66–5-67
 matrix values D-10–D-12
 page setup 5-66
 printing the data automatically using the 

analysis program 3-25
 sequence files 3-53
 using a color printer 1-13

program files. See Data Collection, program 
files

protein sequences
 alignment using Sequence Navigator 1-18
 analyzing with Inherit software 1-17

Public Utilities, using to maintain your hard 
disk 7-11

purity
 effect of reagent purity on gel 

quality 2-3–2-6, 2-9
 high purity reagents for gels 2-18

Q
q. s. (Quantity sufficient) B-10
quality

 factors affecting gel quality 2-6
 maximizing gel resolution 2-9
 polymerization rate and gel quality 2-6

quantity of DNA for sequencing 3-5
Quantity sufficient (q.s.) B-10
quick start information 1-8
quitting

 Data Collection program 5-68
 Quit command 5-6

R
radicals 2-3
radioactive labels 1-11
RAM

 clearing RAM 7-8
 system requirement 7-3

RAPD, using GeneScan to size PCR 
products 1-17

raw data
 analysis 1-16, 7-5
 automatic 

analysis 3-50–3-51, 4-53, 5-24, 5-27
 color guide for Data Collection program 

display of data B-9
 displayed 1-13
 electropherograms 3-51
 in gel files 5-74
 special software for data collection and 

analysis 7-5–7-6
  See also data

reaction mixtures
 deoxynucleoside triphosphate, reaction 

volume and tube types E-5
 enzyme concentration, reaction volume 

and tube types E-6–E-7
 magnesium ion, reaction volume and tube 

types E-5
 preparing E-3–E-7

reaction volume and tube 
types E-3–E-4

 primer concentration, reaction volume 
and tube types E-5–E-6

 template concentration, reaction volume 
and tube types E-6

reaction tubes
 correct seating of 4-59
 selection of type 4-59
 types of E-4

reaction volume E-3–E-4
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 table of reaction tube types E-4
read region 6-7, 6-12–6-13, 3

 Sequencing scan mode 6-12–6-13
readings under normal conditions 5-51
reagents

 affect of purity on gel 
quality 2-3–2-6, 2-9, 2-18

 diluting with distilled, deionized 
water 2-6

 preparing stock solutions 2-10–2-11
 supplies for preparing gels 2-11–2-12

real-time displays 5-52–5-58
 filters and color guide 5-52–5-54
 observing data 1-12, C-4, D-4
 using the Electrophoresis History 

window 5-57–5-58
 using the Gel window 3-45, 4-49, 5-56
 using the Scan window 3-45, 4-49, 5-55

rebuilding the desktop 7-5
recording sample information 3-21–3-22
red alerts 5-57
red LED 6-19
Redo command 5-8
registering software programs 1-8
removing

 beam-stop bar 4-13
 non-essential files from hard disk 7-9
 the gel from the instrument

in GeneScan mode 4-50–4-51
in Sequencing mode 3-47–3-48

renaturation, consequences of 4-61
reproducibility of the gel

 affect of temperature on gel 2-6
 affect of vacuum strength and time during 

degassing 2-7
 compromised by reagent 

impurity 2-4–2-6
resin, deionizing. See deionizing resin

resolution
 affected by acrylamide impurity 2-3
 maximizing 2-9
 poor 8-14

restriction sites E-6
results. See quality
Resume command 5-9, 5-48
resuspending DNA 3-40

 See Also DNA
reverse transcriptase

 MuLV E-6
 rTth DNA Polymerase E-6

Revert command 5-6
rRNA

 PCR template concentration E-6
rTth DNA Polymerase E-6
Run file

 choosing the length of the run 3-25
 creating

for GeneScan mode 4-26–4-29
for Sequencing mode 3-22–3-26

 defaults
for fragment analysis 5-25
for sequencing 5-21

 example of window 4-27
 storing 3-52, 4-65
 viewing associated sample sheet or 

module 3-23
Run folder

 icon for creating Run folder 5-40
 output files placed for a run by the 

instrument 5-74
Run Log file. See Log file
Run Setup command 5-11
Run window 5-40–5-48

 completing
GeneScan Run window for pre-run 

or run 5-43–5-45
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Sequence window for a pre-run or a 
run 5-41–5-43

 opening the window 5-40–5-41
 starting a pre-run or run 5-45–5-48

from the Instrument menu 5-48
from the Run window 5-45–5-47

runs
 choosing sample sheet 5-41
 cleaning up after 3-47, 4-50
 clearing random access memory by 

restarting the Macintosh 7-8
 conditions for starting 5-12
 example of run window 4-27
 importing and exporting 5-68
 preparing software 5-12
 problems that might occur during a 

run 8-13
 readings under normal conditions 5-51
 resetting global serial number (for file 

names) 5-27
 Run Log described 5-74
 run time in modules B-6
 setting

defaults for sequence runs 5-23
parameters 4-26

 starting, stopping, pausing 5-48
 status during run 3-45

S
.seq file 5-75
safety warnings 1-6

 acrylamide 2-9, 2-18
 acrylamide and bis-acrylamide 2-4
 bis-acrylamide 2-9, 2-18
 laser hazard 3-28, 4-31
 TEMED 2-5
 urea 2-6, 2-18

salt concentration
 effect on PCR 4-59

 preventing salt concentration in 
samples 4-6

sample files 3
 archiving 3-53, 4-66, 5-66
 attaching new matrix D-13
 evaluating the quality of the data 4-54

characteristics of good data 4-55
characteristics of poor 

data 4-56–4-57
 file format compatible with commercial 

programs 1-16
 output files described 5-75

sample sheet 5-32–5-39, 5-74
 adding default values 5-34
 applying the same parameter to all fields 

in a column 5-38
 choosing for run 5-41
 copying information 5-38
 creating

GeneScan sample sheet (using Data 
Collection 
software) 5-36–5-37

in GeneScan mode 4-24–4-26
in Sequence mode 3-21–3-22
Sequence sample sheet (using Data 

Collection 
software) 5-34–5-35

 defaults
for fragment analysis 5-25
for sequencing 5-21

 DyeSet/Primer file naming 
conventions 5-34–5-35

 exporting 5-67
 fixing truncated entries 3-24
 importing and exporting sample sheet 

information 5-33
 importing from text files 5-68
 information on electropherogram 3-51
 modifying an existing sample sheet 5-38
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 moving
around sample sheet 5-36
between fields in the sample 

sheet 5-38
information to a different lane 5-39

 separate for sequence and fragment 
analysis 3-21, 5-32

 viewing
from Run window 3-23, 5-40
information associated with the cur-

rent run 5-58
Sample Sheet command 5-11
samples

 automatic analysis by
GeneScan Analysis program 5-27
Sequencing Analysis program 5-24

 automatic analysis of 
sample 3-50–3-51, 4-53

 evaluating the contamination of unknown 
samples 4-54

 identifying the sample 5-32
 loading

GeneScan mode 4-43–4-47
Sequencing mode 3-41–3-44

 preparing
for electrophoresis 4-42–4-43
for GeneScan mode 4-41
samples before instrument setup 3-5
samples for GeneScan mode 4-5

 pre-running the gel 3-39
 preventing high salt concentration 4-6
 recording information for analysis 5-32
 resolution of samples decreased 4-63
 specifying lane for run 4-24, 4-26, 5-32
 See Also sample sheet, creating

saving 5-6
 automatically created files, ensuring disk 

space 3-27, 3-42, 4-30, 4-45, 4-46

 backup copy of the file you are working 
with 5-65

 files 5-65
created during a 

run 3-52–3-53, 4-65–4-66
other files 3-53

 matrix in ABI folder D-3
 module settings 3-18–3-19
 preferences 5-14
 sample files 5-66

scaling
 Electrophoresis History window 5-58
 processing data 1-16
 Scan window 5-55, 5-62

Scan command 5-11
scan numbers

 electrophoresis history window 5-57
scan point 1
Scan window

 checking the plates 4-31
 setting scale 5-55, 5-62
 viewing data 1-13

in real-time 3-45, 4-49, 5-55
scanning

 gels 4-30–4-31
 plates 3-27–3-38, 4-30–4-31

using the Scan window 4-31
scanning and detection system 6-11–6-16

 filter wheel and data display 6-13–6-15
 instrument and matrix files 6-15–6-16
 read region 6-12–6-13

SDS (Sodium dodecyl sulfate) B-11
searching biological databases using 

GeneAssist 1-18
secondary structure

 of RNA templates E-6
Select All command 5-8
separation distance 3
separation system 6-10
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sequence files, output files described 5-75
Sequence Navigator software 1-18
Sequence Run defaults 3-20
Sequence Sample Sheet

 creating the sample sheet 3-21–3-26
 defaults 3-19

Sequence window
 completing for pre-run or run 5-41–5-43

sequences 3
sequencing

 data interpretation 3-50–3-51
 detection described 2-9
 effect of reagent purity on gel 

quality 2-3–2-6
 GelDocII and DataUtility programs 1-16
 one-lane approach 1-16
 optimal quantities of DNA 3-5
 sample sheet

selecting sample sheet 5-32
setting defaults for sample sheets, 

runs 5-21
using separate sample sheet 3-21
See Also sample sheet

 set custom parameters before 
run 4-8, 4-19

 setting up for automatic analysis 3-15
 table of run times and filter sets B-7
 template shipped with 

system 3-17–3-19, 4-20–4-21
 using a setting other than default for 

automatic analysis 3-5
 using the ABI PRISM 373 with XL 

upgradeL 1-10
 using the ABI PRISM 373 with XL upgrade 

1-12
Sequencing Analysis applications

 setting defaults 5-21–5-24
Sequencing Analysis program 5-75

 GelDocII and Data Utility programs 1-16

 using after data collection 5-17
sequencing Instrument file

 chemistries and the Instrument file C-3
 See Also matrix files

sequencing reactions 3
serial number, reset for file naming 5-27
Set Scale command 5-8
setting

 defaults for fragment analysis 5-25
 general preferences 5-27
 temperature control parameters for 

optimizing PCR E-10
 the electrophoresis chamber for 

sequencing applications 3-12
setting up the instrument 3-6–3-38

 checking
the plates 3-27–3-38, 4-30–4-40
the PMT setting 3-32–3-33,

4-32–4-34
 completing the setup 3-35–3-38
 GeneScan mode 4-9–4-40

completing instrument 
setup 4-36–4-40

for Classic 
configuration 4-36–4-37

for Leon 
configuration 4-37–4-39

for Stretch 
configuration 4-39–4-40

preparing the electrophoresis 
chamber 4-11–4-18

for Classic 
configuration 4-12–4-13

for Leon 
configuration 4-13–4-14

for Stretch 
configuration 4-11–4-18

preparing the gel for 
loading 4-9–4-10
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 inserting the Sharks-tooth comb 3-34
 instrument connection to Macintosh 5-27
 preparing the electrophoresis 

chamber 3-8–3-15
for Classic configuration 3-9
for Leon configuration 3-10–3-11
for Stretch configuration 3-12–3-15

 preparing the gel for loading 3-6–3-7
setting up the software

 analysis software 3-16
 creating the Run file 3-22–3-26

choosing the length of the run 3-25
 GeneScan mode 4-19–4-29

creating a Run file 4-26–4-29
creating the sample sheet 4-24–4-26
creating user-specific module 

files 4-20–4-21
setting default parameters 4-22–4-24
starting the Data Collection 

software 4-20–4-29
the analysis software 4-19

 Sequencing mode 3-16–3-26
creating the sample sheet 3-21–3-26
creating user-specific module 

files 3-17–3-19
setting default parameters 3-19–3-21
starting the Data Collection 

software 3-17
settings 3

 changing the instrument settings in 
real-time 5-59–5-60

 for Sequencing Analysis, setting must be 
ABI folder 5-17

 page for printing 5-66
Sharks-tooth comb 6-8, 3

 casting the gel 2-20
 channel numbers at the center of each 

lane 3-29–3-31
 inserting the comb 3-34

GeneScan mode 4-34–4-35
 loading many samples 3-41

Show Clipboard command 5-8
signal

 intensity of 4-62
 strength for best results 3-40
 See Also peaks

Silating plates. See Bind-Silane
SilverLining

 using to maintain your hard disk 7-11
size standard

 setting default 5-25
sizing and quantitating DNA 

fragments 1-9, 7-5
skipping lanes

 in GeneScan mode 4-32
 in Sequencing mode 3-29–3-31
 skipping multiple lanes loading 

gel 3-42, 4-44, 4-45
slow mobility, troubleshooting 8-14
slow polymerization, troubleshooting 8-15
small document icons on the Run 

window 3-23, 4-27, 5-40, 5-41
Sodium dodecyl sulfate (SDS) B-11
software

 adding software programs 7-10
 AutoAssembler™ 1-17, 1-18
 backing up 7-8
 copying image file to firmware 6-17
 data collection program files 5-73–5-74
 DataUtility

bundled with Sequencing Analysis 
program 1-16

using to make and copy matrices 7-5
 Factura software 1-17
 for data analysis 1-16–1-18
 GelDocII 1-16
 Genotyper™ 1-18
 installing 7-4–7-5
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 performing raw data collection and data 
analysis 7-5–7-6

 preparing for run 5-12
 provided with instrument 7-5
 registering 1-8
 Sample file format compatibility 1-16
 Sequence Navigator 1-18
 troubleshooting 8-16
 See Also setting up the software

spacers
 compatibility with combs and casting 

comb 3-34
  See gel spacers

special text in the manual 1-5
spectral overlap

 corrected with matrix D-3
spills, cleaning up E-13
split peaks. See peaks
spreadsheets

 Excel, exporting the sample sheet 
to® 5-74

 exporting files for 5-67
 for use with Genotyper data 1-18

square-tooth comb 6-9, 3
 applying Bind-Silane compound 2-14
 casting the gel 2-20
 loading lanes consecutively 4-44
 using to load lanes 

consecutively 3-42, 4-45
 See Also combs

standards. See matrix files
Start Plate Check command 5-9
Start Run command 5-9, 5-48
starting

 conditions for starting runs 5-12
 pre-run or run from the Run 

window 5-45–5-48
from the Instrument menu 5-48
from the Run window 5-45–5-47

 quick start information 1-8
 Start commands 5-9

status
 lights on instrument 6-17, 6-19
 log file 4-48
 table of status light states 6-20
 viewing instrument status

in GeneScan mode 4-48–4-49
in Sequencing mode 3-45–3-46
using the Status window 5-50–5-51

  See also translation interface processor, 
status and control; viewing

Status command 5-11
Status window, using to view instrument 

status 5-50–5-51
stock solutions

 10X TBE buffer 2-10–2-11
 40% acrylamide 2-11
 preparing fresh acrylamide, bis 

acrylamide, urea 2-6
 purchasing powders and 

diluting 2-4, 2-10
stopping a pre-run or run 5-46
storing

 acrylamide 2-4
 APS 2-5
 bis-acrylamide 2-4
 software files 3-52, 4-65–4-66
 TEMED 2-5
  See Also saving

STR, using GeneScan to size PCR 
products 1-17

Stretch, Model 373 DNA Sequencer 
configuration 1-4, 3

 completing instrument 
setup 3-37–3-38, 4-39–4-40

 model specific notation 3-8, 4-11
 preparing the electrophoresis 

chamber 3-12–3-15, 4-15–4-18
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sulfate radical, yielded from polymerization 
mechanism 2-3

supplies for gels 2-11–2-12
swirls in gel, troubleshooting 8-15
system folder

 files located in 5-76
 temporary files created in 5-76

system requirements 7-3

T
T7 DNA polymerase

 primer extension 1-11
tab-delimited text

 format 5-67
 importing or exporting 5-33

tables
 abbreviations B-10–B-11
 channel numbers in lanes 3-29–3-31
 colors of bases in real-time 

displays 5-53, B-9, C-4
 DNA sequencing resuspension and 

loading volumes 3-40
 dye sets and filters sets by chemistry B-9
 dyes and filter set color displays D-5
 files in System folder 5-76
 GeneScan mode :sample, cocktail, and 

loading volumes 4-43
 how changing temperature control 

parameters affects the PCR E-11
 input files in the Data Collection 

program 5-73–5-74
 instrument menu commands 5-9
 IUB codes and their complements 2
 matrix standard dyes and part 

numbers D-6
 module file default 

parameters 3-17, 4-20
 module parameters B-6

 optimal quantity of template DNA for 
sequencing 3-5

 output files in the Data Collection 
program 5-74

 problems that might occur during a 
run 8-13

 reaction tube types for PCR instrument 
systems E-4

 relationships between filters, sequencing 
dyes, and data display 6-14

 run readings under normal 
conditions 5-51

 status light states 6-20
 troubleshooting gels 8-14–8-15

tared 3
TBE B-11

 buffer 4-38, 4-64
 preparing stock solution 2-10–2-11

TE, 10 mM Tris-Cl (pH 8.0), 1 m M EDTA 
(pH 8.0) B-11

technical support 1-22–1-28
 registering software for 1-8

technical updates to user’s manual 1-7
TEMED B-11

 adding to cast the gel 2-20
 affect of

changing concentration 2-7
impurity 2-5

 chemical hazard 2-11
 safety warning 2-5
 storage 2-5
 use in mechanism of polymerization 2-3

temperature
 affect on gel quality 2-6–2-7
 control parameters, effect on PCR 

performance E-10
 gel status 5-57
 status of gel 1-12
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template
 PCR concentration E-6
 using module file 

templates 3-17–3-19, 4-20–4-21
temporary files 5-76
tetramethylethylenediamine. See TEMED
text files 4

 exporting ABI PRISM 373 with XL 
upgradeL data to 5-67

thermal control plate. See heat transfer plate
thermal cycling

 cleaning sample block E-13
 setting parameters for 4-58

thermal equilibration E-11
total cellular RNA

 PCR template concentration E-6
total reset

 procedure for clearing memory 8-10
Translation Information Processor

 definition 4
 status and control 6-120

Translation Interface Processor
 ABI PRISM 373 with XL upgrade DNA 

Sequencer upgrade 1-9
 status and control 6-17–6-20
 when starting the Data Collection 

program 3-17, 4-20
Translation Processor

 diagram showing flow of data 5-72
Tri hydrochloride (Tris-CI) B-11
Tris Borate EDTA

 preparing the glass plates 3-6, 4-9
Tris contaminants 2-6
Tris-Cl (Tris hydrochloride) B-11
tRNA, PCR template concentration E-6
troubleshooting 8-8–8-16

 clearing the memory 8-9–8-12
 gel troubleshooting 8-14–8-15
 hardware/firmware 8-9–8-12

 PCR and electrophoresis conditions table 
for GeneScan mode 4-58

 problems during a run 8-13
 total reset of the instrument 8-8
 troubleshooting software 8-16

tube types E-3–E-4
two-dimensional array 5-32

U
Undo command 5-8
UNIX

 client-server option for the 
AutoAssembler Sequence Assembly 
Software 1-18

 using Inherit Sequence Analysis 
System 1-17

upper buffer chamber replacing. See 
individual instrument configuration

urea
 affect of impurity 2-6
 chemical hazard 2-11
 contaminants, found in 2-6
 safety warning 2-6, 2-18
 solution for gel 2-18–2-19

user attention words 1-5
User Bulletins, updated to the manual 1-7
user’s manual

 how to use this manual 1-3–1-5
 updates 1-7
 user attention words 1-5

V
verifying lane tracking D-10
viewing

 associated sample sheet or module 5-40
 data collection status windows 3-45, 4-48
 instrument status

data in real-time 5-52–5-58
during and after a run 5-50–5-58
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filters and color guide 5-52–5-54
using the Electrophoresis Histo-

ry window 5-57–5-58
using the Gel window 5-56
using the Scan window 5-55

Run file for the current run 5-58
sample sheet associated with the 

run 5-58
using

the Log file 5-51–5-52
the Status window 5-50–5-51

 real-time data windows 3-45, 4-49
  See Also Status window; Electrophoresis 

History window; The Log file; Scan 
window; Gel window

viral RNA, PCR template concentration E-6
virus protection, during installation 7-4
VNTR, sizing with GeneScan® software 1-17
voltage

 actual voltage and current readings 
during a run 5-50

 in modules B-6

W
warnings

 acrylamide 2-4, 2-9, 2-18
 bis-acrylamide 2-4, 2-9, 2-18
 TEMED 2-5
 urea 2-6, 2-18

warranty A-1–A-2
washing plates 2-13, 3-48

 See Also cleaning
watts, in modules B-6

 See Also voltage
wells

 depressions in the well surface 2-27
 flushing before loading 4-41
 loading alternate wells with Shark’s-tooth 

comb 3-41

 using Bind-Silane compound to eliminate 
deformed wells 2-14

 using formamide in empty 
wells 3-42, 4-44, 4-45

well-to-read length. See WTR
Window menu 5-10–5-11
windows

 changing size of 5-10, 5-49
 closing 5-10, 5-49, 5-68
 default settings 5-14
 moving on screen 5-10, 5-49
 switching preferences windows 5-15
  See Also individual window names

word processing
 exporting files for 5-67
 sequence files

exporting 5-75
using to open sequence files 3-53

WTR (well-to-read)
 definition 4
 setting default for run file

GeneScan Analysis program 5-27
Sequencing Analysis program 5-24

 table of abbreviations B-11

X
X-GAL (Microgram) B-10
XL Scan mode 6-12
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